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INTRODUCTION
What do Excel formulas mean?
An expression called FORMULAS IN EXCEL operates on values from a
variety of cell addresses and operators. Consider the formula =A1+A2+A3,
which calculates the sum of the values in cells A1 through A3. An
illustration of a formula with discrete values might be =6*3.

=A2 * D2 / 2

"=" tells Excel that this is a formula, and it should evaluate it.

"A2" * D2" makes reference to cell addresses A2 and D2 then multiplies
the values found in these cell addresses.

"/" is the division arithmetic operator

"2" is a discrete value

Exercise using formulas
To determine the subtotal, we will use the sample data from the household
budget.

Make a new Excel workbook.
Enter the information from the budget for household goods above.
The following should appear on your worksheet.

The formula for determining the subtotal will now be written.
Set cell E4 as the focus.

Enter the formula below.



=C4*D4

HERE,

The value of the cell addresses C4 and D4 are multiplied using the
arithmetic operator multiplication (*) in the formula "C4*D4".

Hit the Enter key.

The outcome will be as follows.

You can see how to automatically select a cell address and apply the same
formula to additional rows in the animated image below.

When using Excel's formulae, watch out for these mistakes.
1.The Division, Multiplication, Addition, and Subtraction Brackets rules
should be kept in mind (BODMAS). Since they are enclosed in brackets,
expressions are now evaluated first. Division is evaluated first for



arithmetic operators, followed by multiplication, addition, and finally
subtraction. The formula above can be rewritten as =(A2 * D2) / 2 by
applying this rule. By doing this, it will be made sure that D2 and A2 are
split by 2 after evaluation.

2.Data validation allows you to specify the type of data that should be
allowed by a cell, such as only numbers, as spreadsheet formulas in Excel
typically work with numeric data. You can hit F2 on the keyboard to
confirm that you are using the right cell references listed in the formulas.
The cell addresses used in the calculation will be highlighted, and you may
cross-check them to make sure they are the correct cell addresses.

3.When working with a large number of rows, you can assign serial
numbers to each row and keep track of the total count at the bottom of the
sheet. To make sure that your calculations took into account all the rows,
compare the serial number count with the number of records.

What in Excel is a function?
Using specified values in a given order, the predefined formula FUNCTION
IN EXCEL is applied. Using a function, you may quickly determine the
sum, count, average, maximum value, and minimum value for a set of cells.
The SUM function, for instance, calculates the sum of the values in the
range A1:A2 in cell A3 below.

SUM for adding up a number range

Use AVERAGE to determine the average of a specified range of integers.

Count to determine how many objects fall within a certain range.

How important functions are

When using Excel, functions boost user productivity. Let's imagine you
want to know the overall cost of the home supply budget mentioned above.
You can calculate the sum using a formula to make it easier. You would
have to make each reference to the cells E4 through E8 individually in a
formula. You would need to apply the subsequent formula.

= E4 + E5 + E6 + E7 + E8

With a function, you would write the above formula as



=SUM (E4:E8)

As you can see from the function used above to calculate the sum of a set of
cells, employing a function to calculate the sum is far more effective than
using a formula, which would require referencing a lot of cells.

The most significant Excel formulas and functions are shown here.

SUM function = =SUM(E4:E8)

MIN function = =MIN(E4:E8)

MAX function = =MAX(E4:E8)

AVERAGE function = =AVERAGE(E4:E8)

COUNT function = =COUNT(E4:E8)

DAYS function = =DAYS(D4,C4)

VLOOKUP function = =VLOOKUP (C12, A4:B8, 2, FALSE)

DATE function = =DATE(2020,2,4)



CHAPTER 1
FORMULAS AND FUNCTIONS

The formulae in spreadsheet programs are what make them so helpful.
Without formulas, a spreadsheet would just be a highly developed Word
document with outstanding tabular data management.

In Excel spreadsheets, formulas are used to compute outcomes from data in
the worksheet. When the data is modified, the equations automatically
update the outcomes, saving you time. In this section, formulas and
functions are laid out for you to become acquainted with.

The Basic Elements of Formulas

A cell can contain a formula, which is a small piece of code. It performs a
calculation of some kind and outputs the outcome in the cell. Formulas can
interact with data and text using a wide range of operators and worksheet
functions. Spreadsheets can be dynamic since other cells may contain
formula values and text, making data modifications simple. For instance, by
modifying the data on a spreadsheet and allowing your equations do the job,
you can quickly explore a variety of choices.

A formula containing an equal sign can contain any of the components
listed below:

• Addition and subtraction operations in mathematics, such as + and * (for
multiplication)

• Cell references (such as named cells and ranges)

• Words or values

• Worksheet attributes (like SUM and AVERAGE)

When you enter a formula, the result is displayed in the cell. However, the
formula appears in the Formula bar when you choose the cell.

It's important to note that every formula begins with the equal sign (=). The
first equal sign allows Excel to distinguish between a formula and plain



text.

formulae that use operators

Excel formulas can handle a variety of operators. Operators are symbols
that instruct a formula as to what logical or mathematical operation to
perform. Additionally, Excel has a large number of built-in functions that
let you perform additional calculations.

As many operators as you require could be used to finish the calculation.



Here are some formulas that make use of various operators:

Examining the relationship between the operators in formulas

When computing the value of a formula, Excel uses a set of rules to
determine how the various formula components are computed. You must
comprehend these ideas to guarantee the accuracy of the results produced
by your formulas.

Exponentiation has the highest priority in this table and is completed first,
whereas logical comparisons have the lowest priority (performed last).



The Excel default precedence order can be changed by using parentheses.
When surrounded by parentheses, expressions are always evaluated first.
For instance, the following formula employs parenthesis to regulate how the
computations are performed in order.

In this case, cell B3 is subtracted from cell B2 and the result is multiplied
by cell B4: =(B2-B3) *B4.

The result varies if you enter the calculation in Excel without the
parenthesis. Cell B3 is multiplied by cell B4 since multiplication happens
first. This unexpected result is then deducted from Cell B2, which was not
the desired consequence.

The formula is as follows when the parenthesis is removed:

=B2-B3*B4

Though technically not necessary, using parentheses is nonetheless a good
habit to get into. This makes it clearer what the formula is meant to do. For
instance, the formula below makes it apparent that cell B3 should be
multiplied by cell B4 and the result should be subtracted from cell B2. If
you didn't utilize the parentheses, you'd have to know Excel's order of
precedence.

=B2-(B3*B4)

Additionally, parentheses may be nested within formulas, that is, placed
inside of other parenthesis. If you do this, Excel starts with the expressions
that are the deepest nested and works its way out.

Here's an example of nested parentheses in a formula:

=((B2*C2) +(B3*C3) +(B4*C4)) *B6



This formula contains four sets of brackets, three of which are nested inside
the fourth. Excel evaluates each stacked pair of parentheses before
combining the three results. The outcome is then multiplied by the value in
cell B6.

Even though there are four sets of parenthesis in the formula above, only
the outer set is necessary. It should be clear that you can rewrite this
formula as follows if you understand operator precedence:

B6 = (B2*C2 + B3*C3 + B4*C4)

Most people would agree that the computation is significantly clearer with
the added parenthesis.

It's important to note that operators with the same amount of precedence,
like division and multiplication, are evaluated in the same order.

Of course, there must be a right parenthesis for every left parenthesis. When
there are several layers, it could be difficult to keep track of nested
parentheses. If the parenthesis do not line up, Excel displays an error
message and won't let you enter the computation.

In some cases, Excel will also advise a change to your computation if your
parenthesis are not aligned correctly.



Formulas that use functions

A large number of equations make use of worksheet functions. By using
these functions, you can greatly strengthen your formulas and carry out
computations that would be challenging (or possibly impossible) to perform
if you only employed the operators previously discussed. For instance, the
TAN function can be used to determine the tangent of an angle.
Mathematical operators alone are unable to complete this challenging
computation.

Examples of function-based formulas

A formula is substantially streamlined by a spreadsheet function. Here is
one example. Without using a function, you would need to write a formula
like this to calculate the average of the values in the ten cells (A1:A10):

=(A1+A2+A3+A4+A5+A6+A7+A8+A9+A10)/10

It's a little unappealing, isn't it? Even worse, you would need to modify this
formula if you added a new cell to the range. Fortunately, you can use
Excel's built-in worksheet function AVERAGE to replace this calculation.

=AVERAGE(A1:A10)

The formula that follows demonstrates how to use a function to perform
calculations that would be otherwise impossible. Consider the situation
where you must determine the highest integer in a range. A formula cannot



provide you with the answer without the assistance of a function. This
formula uses the MAX function to return the highest value from the range
A1:D100:

=MAX (A1:D100) (A1:D100)

Additionally, functions assist in obviating the requirement for manual
editing. In cells A1 to A1000 of a spreadsheet, there are 1,000 names that
are all written in capital letters. Your boss looks over the list and informs
you that the recipients' names will be merged into a form letter and
distributed. It is now necessary to write JOHN F. SMITH as John F. Smith
instead of using all capital letters as before. You could either re-enter the list
for the next few hours (ugh),

 Alternatively, you might use a formula similar to the one below, which uses
the Correct function to convert the text in cell A1 to the appropriate case:

=PROPER(A1)

The first cell B1 should contain this formula, which should then be copied
down to the next 999 rows. Select the range B1:B1000, then choose Home
> Clipboard > Copy to copy it. In order to convert the formulas to values
while keeping B1:B1000 selected, click Home > Clipboard > Paste Values
(V). By eliminating the original column, you have just finished several
hours of work in under a minute.

Note: The Excel Flash Fill tool can also be used to do this kind of change
without the use of formulas.

You should be convinced of the use of functions by one more example.
Take into account a spreadsheet that determines sales commissions.

If the salesperson sold $100,000 or more in goods, the commission rate is
7.5 percent; otherwise, it is 5.0 percent. If you didn't use a function, you
would have to create two new formulas and make sure you used the correct
formula for each sales amount. The IF function can be used to create a
formula that ensures the correct commission is calculated regardless of the
volume of sales:

If (A1100000, A1*5%, and A1*7.5) is true, then



Using this formula, simple decisions can be made. The formula looks up the
sales amount in Cell A1, which is checked. If the amount is less than
100,000, the algorithm returns the value in cell A1 multiplied by 5%.

If not, it returns the data from cell A1 multiplied by 7.5%. In this example,
there are three parameters that are separated by commas. This is covered in
the "Function Parameters" section that follows.

Function arguments

You may have noticed that all of the functions in the earlier examples
utilized parentheses. The list of parameters is contained inside the
parenthesis.

The way functions utilize parameters varies. A function may use one of
the following methods, depending on the task at hand:

No arguments at all
There is a limit to the number of arguments that may be used.
A single argument
There are an undetermined number of arguments
Arguments with choices

The NOW function, which returns the current date and time, is an example
of a function that doesn't take an argument.

Even if a function doesn't take an argument, you must give a set of empty
parentheses, as seen below:

=NOW ()

If a function has more than one parameter, use a comma to separate them.
Cell references were used as arguments in the examples at the start of the
chapter. However, when it comes to function parameters, Excel is fairly
accommodating. A cell reference, literal values, literal text strings,
expressions, and even other functions may all be used as arguments.

Here are a few functions that utilize different sorts of arguments:

=SUM is a cell reference (A1:A24)
=SQRT is the literal value (121)



=PROPER ("john f. smith") is a literal text string.
Formula: =SQRT (183+12)
Other functions: =SQRT (SUM (A1:A24)); =SQRT (SUM
(A1:A24)); =SQRT (SUM (A1:

For the US version of Excel, the list separator character is a comma. A
semicolon may be used in certain other language variants. The list separator
is a Windows preference that may be changed in the Control Panel.

More information about functions
Over 450 built-in functions are available in all in Excel. In addition, if you desire, you can create
your own unique functions (using VBA) or get additional specialized functions from independent
suppliers if that isn't enough.

You'll probably only use a dozen or so of the available features on a regular basis, despite the fact
that some users may find the sheer quantity of options overwhelming. Moreover, even if you don't
use functions frequently, finding and inserting them is simple thanks to the Excel Insert Function
dialog box, which is discussed in more detail later in this chapter.

Enter Formulas for Your Worksheets

For Excel to recognize that a formula rather than text is present in the cell, every formula must start
with an equal sign. Excel gives you the choice of manually inserting a formula into a cell or using
cell references. Each tactic is fully explained in the sections that follow.

Excel provides you with a drop-down list of function names and range
names while you are constructing formulas. Which items are on the list
depend on what you've already written. If you type the letters SU while
inputting a formula, the drop-down list will appear.



The list gets narrowed down to the functions that match if you send another
letter. Select an item in the list using the arrow keys, then click Tab to have
Excel autocomplete it. A brief description of the function appears when you
select a function from the list.

Formula AutoComplete Use

Thanks to the Formula AutoComplete feature, entering formulas has never
been easier. Enter your formula as you normally would, and Excel will
guide you by presenting a list of possible options and parameters. In this
illustration, Excel is displaying the SUBTOTAL function options.

Formula AutoComplete includes the following items (and each category is
denoted by an icon):

• The features that come with Excel.

• Modular functionality (functions explained by the person via VBA or
other methods).

• Defined names, which are names that are allocated to cells or ranges using
the Formulas > Defined Names > Define Name command.

• In enumerated arguments, values are utilized to indicate options. Only a
few functions, like SUBTOTAL, demand such parameters.

• Table structures are mentioned (used to identify portions of a table).

Manual entry of formulas



It is necessary to manually enter a formula while doing so. You enter the
formula in a particular cell after the equal symbol (=). As you type, the
characters show up in both the formula bar and the cell. Naturally, all of the
regular editing keys are available when entering a formula.

Formulae entered by pointing

Even if you can type the entire formula into Excel, there is another method
that is often easier, quicker, and less prone to errors. However, you can just
direct to the cell references rather than manually entering the values, even if
this method still requires some manual input.

For instance, use the following steps to enter the formula =A1+A2 into
cell A3:

1. Select cell A3.

2. Use the equal sign (=) to start the formula. You may see Enter in the
status bar of Excel.

3. Press the up arrow twice. When you press this key, Excel displays a
dashed border around cell A1, and cell reference appears in cell A3 and the
Formula bar. Additionally, Excel's status bar displays Point.

4. Finish your phrase with a plus sign (+). Enter is back in the status bar,
and A1's dashed border has been changed to a solid color border.

5. Press the up arrow a last time. The dashed border surrounds Cell A2,
adding that cell address to the formula.

6. Press Enter to complete the formula.

As you type the formula by pointing, you can also use your mouse to point
at the data cells.

Pasted formulas with range names
You have two choices if your formula requires named cells or ranges: enter
the name rather than the address, or choose a name from a list, and Excel
will insert it for you.

There are three approaches to formula naming:



The drop-down menu allows for the selection of a name.

You must at least be familiar with the initial letter of the name in order to
employ this technique. When entering the formula, type the first character
and then choose the name from the drop-down option.

• Depress F3 to start. A dialog box for pasting names displays.

Click OK after selecting a name from the list (or just double-click the
name). Excel automatically includes the name in your formula.

F3 has no impact if no names are given.

• On the Formulas tab, choose Use in Formula from the drop-down menu
(Defined Names group). When in edit mode, you can use this command to
select a probable range name from a list.

Adding functions to formulas

Formula The simplest way to add a function to a formula is via
AutoComplete. Another choice is to introduce a function using the tools in
the Function Library group on the Formulas tab of the Ribbon.

Another choice for adding a function to a calculation is the Insert Function
dialog box.

There are several ways to access this dialog box:

• From the Formulas menu, choose Insert Function > Formulas > Function
Library.

• Use the Insert Function command, which can be found at the bottom of
each drop-down list in the Formulas > Function Library group.



• Toggle the Formula bar to the left, then select the Insert Function button.
When you press this button, fx is shown.

Shift and F3 should both be pressed simultaneously.

Use the Search for a Function area at the top of the dialog box to hunt for
the function you require if you are unsure of the one you require.

1. Enter your search terms and press Enter. A list of helpful functions will
be provided to you. When you select a function from the Select a Function
list, Excel displays the function (and the names of its parameters) in the
dialog box along with a brief description of what the function does.

2. After finding the function you wish to use, click OK after selecting it.

3. Specify the parameters for the function. The Function Parameters dialog
box has a text field for each of the function's arguments, depending on the
function you're creating. You have two options for entering the address:
manually or by clicking inside the argument box and selecting a cell or
range from the sheet as an argument.

4. After you've entered each function argument, click OK.

The Name field typically displays a number of the most recent functions
you've used when you enter or modify a formula.

Function entry guidance



When utilizing the Insert Function dialog box to enter functions, keep the
following in mind:

• To add a function to an existing formula, utilize the Insert Function dialog
box. Simply alter the formula and move the insertion point to the desired
location to insert the function. Open the Insert Function dialog box and
select the function using one of the methods previously described.

• The arguments for a function in an existing formula can also be changed
using the Function Parameters dialog box. After choosing the function in
the Formula bar, click the Insert Function button.

• If a variable number of parameters are required for the function.

For each optional argument you offer, Excel adds a new box. Optional
arguments are not bolded, but required arguments are.

• Some functions have multiple iterations, such as INDEX. After selecting
one of these options, Excel displays a new dialog box where you may
choose the form you want to use.

Editing Formulas

You can  alter a formula after you've entered it. If you implement
adjustments to your worksheet and then need to update the formula to suit
the changes, you may need to edit a formula. Alternatively,, the formula
might return an incorrect value, in which case you'll need to change it to fix
the problem.



When you input or amend a formula in Excel, you'll see that the range
addresses and ranges are color-coded.

NB: This makes it easier to identify the cells that are utilized in a formula.

Here are a few options for entering cell edit mode:

Double-click the cell to alter the contents of the cell directly in the
cell.
Press F2 to alter the contents of the cell immediately inside the cell.
Click on the Formula bar after selecting the cell you wish to alter.
This allows you to change the contents of the cells in the Formula
bar.
Excel will show a little triangle in the upper-left corner of the cell if
the cell includes a formula that returns an error. When you activate
the cell, an error signal appears. You may repair the problem by
clicking the error indication and selecting one of the choices.

In the Formulas section of the Excel Options dialog box, you can choose
whether or not to show these formula error indications. Choose File >
Options to bring up this dialog box. Excel no longer shows these problem
flags if you uncheck the Enable Background Error Checking box.

Note: You can select several characters when altering a formula by
dragging the mouse pointer over them or hitting Shift while using the
navigation keys.

If you have a formula that you can't seem to get right, you may convert it to
text and come back to it later. Simply delete the first equal sign (=) to
convert a formula to text. To convert the contents of the cell back to a
formula, enter the original equal sign when you're ready to attempt again.

Using Cell References in Formulas

The majority of formulae you write include references to cells or ranges.
These references allow your calculations to interact with the data in specific
cells or ranges in real-time. If your formula refers to cell A1 and the value
in A1 is changed, the formula result will alter to reflect the new value.



If you didn't utilize references in your formulae, you'd have to update the
values in the formulas themselves if you wanted to change them.             

Referencing with mixed, relative, and absolute terms
In a formula, you can refer to a cell (or range) using one of three types of references:

• Relative: Since the references are offsets from the current row and column, the row and column
references may change if you copy the formula to a different cell. In equations, Excel automatically
generates relative cell references.

Row and column references remain the same when you duplicate the formula since the reference is
absolute and points to a genuine cell location. The address of an absolute reference includes two-
dollar signs: one for the column letter and the other for the row number (for instance, $A$5 in the
example above).

• Mixed: One reference is relative and one is absolute to the row or column.

There is only one absolute address component (like $A4 or A$4).

The type of cell reference is only necessary if you want to copy the formula
into more cells. The examples that follow show how this works.

Relative cell references are used in this calculation. As a result, the
references adapt in a relative way when the formula is copied to the cells
below it. For instance, in cell D3, the formula is:

=B3*C3

But what if, like this, the cell references in D2 were absolute references?



=$B$2*$C$2

Copying the formula to the cells below would generate inaccurate results in
this scenario. Cell D3's formula would be the same as cell D2's formula.

We'll now update the example to include the calculation of sales tax, which
will be recorded in cell B7. The formula in cell D2 in this case is:

=(B2*C2) *$B$7

After multiplying the amount by the price, the result is multiplied by the
sales tax rate contained in cell B7. It's worth noting that the reference to B7
is an absolute one. Cell D3 will have the following formula when the
formula in D2 is transferred to the cells below it:

=(B3*C3) *$B$7

The references to cells B2 and C2 were changed, but not the reference to
cell B7, which is precisely what you want since the address of the sales tax
cell never changes.

The C3:F7 set of formulae calculates the area of different lengths and
widths. The formula for cell C3 is as follows:

=$B3*C$2

Both cell references are intermingled. The column ($B) is referenced by an
absolute reference in cell B3, while the row ($2) is referenced by an
absolute reference in cell C2. As a consequence,, this formula may be



duplicated down and across with no errors in the computations. For
instance, in cell F7, the formula is

=$B7*F$2

Copying the formula would generate inaccurate results whether C3
employed absolute or relative references.

The cell references in a formula aren't altered when you cut and paste it
(transfer it to another spot). This is, in most cases, what you want to
happen. When you relocate a formula, you usually want it to keep referring
to the same cells as before.

Altering the references you use

You can manually input non-relative references by manually inserting dollar
signs in the appropriate places of the cell address (absolute or mixed). The
F4 key can also be used as a shortcut. After you've entered a cell reference
(by typing it in or pointing to it), you can continually press F4 to have Excel
cycle through all four reference kinds.

For instance, pressing F4 changes the cell reference in a formula that begins
with =A1 to =$A$A1. F4 again transforms it into =A$1. When you press it
once more, =$A1 appears. It returns to the initial =A1 after the third press.
Press F4 again until Excel displays the reference type you desire.

Excel uses an absolute reference (by default) when referring to the name of
a column or range. For instance, the Refers To box in the New Name dialog
box displays the reference as $B$1: $B$12 when you give B1:B12 the
name Sales Forecast. This is typically what you want. The duplicated



formula has a reference when you copy a cell whose formula contains a
named reference.

Using cells outside the worksheet as references
The worksheets that the formula refers to need not be in the same
workbook. It also refers to cells in other worksheets. Excel has a distinct
syntax for dealing with these kinds of references.

Referencing cells from different workbooks
Use the format shown below to refer to a cell on another worksheet inside
the same workbook:

Name of Sheet = Cell Number

Or, to put it another way, the cell address should come before the
exclamation point and come after the worksheet name. Here is an example
of a cell-based formula from the Sheet2 worksheet:

=A1*Sheet2! A1

Multiplying the value in cell A1 of Sheet2 by the value in cell A1 of the
current worksheet produces the answer.

NB: You must enclose the worksheet name in single quote marks if it has
one or more spaces in it.

If you generate the computation using the point-and-click method, Excel
might perhaps do it for you.) Consider the following formula, which refers
to a cell on a sheet labeled "All Depts" as an example: "All Depts" equals
A1
Referencing cells in other workbooks

Use this format to refer to a cell in a separate workbook:

=[WorkbookName]SheetName!

Cell Address
An example of a formula using a cell reference is shown below and is found
in the Sheet1 worksheet of the Budget workbook:

Budget. xlsx sheet one!



You must surround the workbook name in single quotation marks if it
contains one or more spaces in the reference (together with the sheet name
and square brackets). For illustration, the following formula refers to a cell
on Sheet 1 of the workbook titled Budget for 2019:

2019 Budget =A1*' .xlsx] A1 Sheet 1

When a calculation makes reference to cells in another worksheet, the
second workbook does not need to be open. In order for Excel to find the
workbook if it is closed, you must specify the entire path in the reference.
Here is an example:

My Documents =A1*'A1*'A1*'A1*'A

[Budget for the 2019 Calendar Year]

xlsx] Sheet1'!A1

There's a chance that a connected file could be on a different machine on
your company's network. Excel automatically inserts absolute cell
references when you build a calculation and reference a different worksheet
or file. Make sure to change the cell references to a relative one before
copying if you wish to duplicate the formula to multiple cells.

Making Use of Formulas in Tables
A table is a collection of cells with well-defined column titles. How formulas and tables work
together is described in this section.

Data in a table being compiled
After entering the data, we created a table by using Insert > Tables > Table. Despite the fact that we
didn't give the table a name, it has the default name of Table1.



To add a row of summary formulae to the table, just click a button:

1. Select any cell in the table and activate it.
2. Select Table Tools Design > Table Style Options > Total Row and

verify it. In Excel, a total row is added to the table, and the sum of
each numeric column is shown.

3. To alter the kind of summary formula, select a cell in the total row
and change the type of summary formula from the drop-down box.

NB: Table Tools Design > Table Style Options > Total Row allows you to
adjust the total row display. When you switch it back on after turning it off,
the summary choices you chose will be presented again.



Using formulas within a table

You will want to employ formulae inside a table to do calculations that
involve other columns in the database in many circumstances.

 

 

To add this formula, take these actions:

1. Open cell E2 and enter Difference as the column header. As soon as you
press Enter, Excel expands the table to include the new column.



2. To begin a formula, enter an equal sign in cell E3 by itself.

3. Depress the left arrow key. Excel displays [@Actual], the column
heading, in the Formula bar.

4. After inputting a minus sign, press the left arrow key twice. Excel
displays [@Projected] in your calculation.

5. Hit Enter to finish the formula. Excel applies the method to every row in
the table.

The formula for all cells in the Difference column of the table is as
follows:

=[@Actual]-[@Projected]

The formula was in the first row of the table, although it wasn't necessary.
A formula automatically fills all of the cells in a column when it is entered
into an empty table column. Excel will duplicate any formula modifications
you make to the other cells in the column if you need to.

The at sign (@) that comes before the column heading denotes "this row."
Therefore, [@Actual] denotes "the value in the Actual column of this row."

In these steps, the formula is constructed using the pointing approach.
Instead of using column headings, you may have manually entered the
calculation by using standard cell references.

 

For instance, you might have entered the following formula in cell E3:
=D3-C3.

One thing to keep in mind about equations that use column headings instead
of cell references is that they are much easier to understand.

Using a table's data as a reference

Two other ways to refer to the data in an Excel table are the table name and
the column titles.

You don't have to give your tables or columns names, it's crucial to keep in
mind. The column headers, which are not range names, can be used to refer



to data inside the database. The data in the table has a range name that is
automatically generated when the table (for example, Table1) is
constructed.

You can refer to data in a table by using conventional cell references, but
using the table name and column headings has a key advantage: the names
adjust automatically when the table size changes as a result of the addition
or deletion of rows. Additionally, if you change a table's name or a column's
name, formulas that use those names will automatically adapt.

This table is called Table1. To calculate the total of all the values in the
table, enter the following formula into a cell outside the table:

=SUM(AnnualData)

The majority of the time, a formula will relate to a particular table column.

The total of the data in the Actual column is returned using the formula
below:

=SUM

Even better, when you build a formula that relates to data in a table, Excel
offers some aid. Excel specifies various table components that you may
reference in addition to the column headings in the table.

Correcting Common Formula Errors

Excel occasionally shows a value that starts with a hash (#) when you enter
a formula. This indicates that an incorrect value was returned by the
formula. You must modify the formula (or a cell that the formula refers to)
to get rid of the error message (or a cell that the formula refers to).



The column is too tiny to display the value if a cell contains only hash-mark
characters. Either make the column wider or alter the way the cell's
numbers are formatted.

Excel won't allow you to insert an incorrect formula in certain instances.

The following formula, for example, is lacking the concluding parenthesis:



=A1*(B1+C2

If you try to input this formula, Excel warns you that your parenthesis is
mismatched and suggests a solution. The recommended fix is usually right,
but you can't rely on it.

If a cell to which a formula refers contains an erroneous value, the formula
may return an error value. The ripple effect describes how a single
erroneous value may spread to many more cells containing formulae that
rely on that one cell.

Circular references management
When the circular reference notice appears after inputting a formula, Excel
gives you two options:

Choose OK to input the formula exactly as it is.
To access a help screen with circular references, select Help.

No matter which option you select, Excel alerts you to the existence of a
circular reference by displaying a message on the left side of the status bar.

A circular reference may be used on purpose in a few circumstances. In
certain cases, the parameter Enable Iterative Calculation must be enabled.
In order to avoid being warned about circular references, it is advised to
turn off this option. An issue that has to be resolved is typically indicated by
a circular reference.

indicating the time when formulas are calculated

You've probably seen that Excel immediately performs the formula
calculations on your worksheet. Excel displays the updated formula result
when you change any of the formula's input cells.

Obey these guidelines:

Excel performs calculations that are dependent on new or updated data
immediately after you make a change, such as entering or editing data or
formulae. If Excel is performing a lengthy calculation, it will temporarily
pause it while you perform other worksheet tasks; it will resume calculating
after you have finished your other worksheet tasks. Formulas are evaluated
in a logical order.



In other words, Excel calculates cell D24 before cell D12 if the result of the
calculation in cell D12 is reliant on the formula's result in cell D24.

However, you might like to have some control over how Excel performs
formula calculations. For instance, if you create a spreadsheet with
hundreds of complex calculations, you could notice that processing bogs
down while Excel works its magic. In this case, change Excel's calculation
mode to Manual by selecting Formulas > Calculation > Calculation Options
> Manual.

If your worksheet includes any large data tables, use the Automatic Except
for Data Tables option. Large data tables are notorious for being
computationally expensive.

The table created by choosing Insert > Tables > Table is different from a
data table.

Use the following shortcut keys to recalculate the formulae:

• F9: Calculates the formulas in all open spreadsheets.

Shift+F9 only calculates the formulae in the active worksheet. Other
spreadsheets in the same workbook are not computed.

• Ctrl+Alt+F9: Recalculates all formulae by default.

• Ctrl+Alt+Shift+F9: Rebuilds the calculation dependency tree to perform a
thorough recalculation.

Utilizing Advanced Naming Methods

Your computations may be easier to understand, modify, and avoid errors if
you include range names in them. Working with a meaningful phrase like
AnnualSales is much easier than working with a reference range like
AB12:AB68.

Excel includes a ton of extra tools that improve the effectiveness of using
names. We'll go through these tactics in further detail in the sections that
follow. This information is for those who are interested in learning about
some Excel capabilities that aren't widely known.

Constant names are used



Many Excel users are not aware that a name could be assigned to an object
that doesn't actually exist in a cell. For instance, you would probably enter
the value of the sales tax rate in a cell and use it as a reference in your
formulas if your worksheet's computations need it. You may label this cell
Sales Tax or something similar to make things easier.

Here's how to give a value that doesn't show in a cell name:

1. Select Formulas > Defined Names > Define Name from the drop-
down menu. The dialog window for a new name appears.

2. In the Name box, type the name (in this instance, SalesTax).
3. Choose a scope for the name to be valid in (Might be some

workbooks or just a few).
4. Delete the existing contents of the Refers To text box and replace

them with a value (such as .075).
5. Add a note about the name in the Comment box.

You've just made a name for a constant rather than a cell or range. If you
enter =SalesTax into a cell inside the scope of the name, you'll get the value



0.075, which is the constant you specified. This constant may also be used
in a formula, such as =A1*SalesTax.

The Name box and the Go To dialog box do not display named constants.
This makes it reasonable since these constants have no physical location.
They do show up in the drop-down menu that appears when you type in a
formula. This is useful since these names are used in formulae.

Using names for formulas

You can build named formulae in addition to named constants. A named
formula, like a named constant, is not stored in a cell.

The New Name dialog box is used to generate named formulae in the same
manner as it is used to create named constants. Create a named formula that
calculates the monthly interest rate from a yearly rate, for example.

The monthly rate refers to the following formula in this case:

=Sheet3!$B$1/12

When you use relative references instead of absolute references, naming
formulae becomes more interesting. Excel always utilizes absolute cell
references when you use the pointing approach to construct a formula in the
Refers to field of the New Name dialog box, unlike when you write a
formula in a cell.

For example, for the following formula, activate cell B1 on Sheet1 and
name it Cubed:

=Sheet1!A1^3



Using range intersections

To find the overlapping references in two ranges, Excel employs the
intersection operator.

In cell B9, the formula is:

A3:D3 =C1:C6

The value in cell C3—that is, the value at the intersection of the two ranges
—is returned by this formula. The intersection operator is one of three
range-related reference operators.

When you utilize names, the true usefulness of understanding range
intersections becomes obvious. We picked the full table and then used
Formulas Defined Names Create from Selection to generate names for the
top row and left column automatically.



Applying names to existing references

Excel does not automatically utilize the name you give a cell or a range
instead of existing references in your formulae when you name it. For
example, assume cell F10 has the following formula:

=A1–A2

Excel will not automatically modify your formula to =Income–Expenses if
you subsequently create a name for A1 and Expenses for A2. It is, however,
rather simple to replace cell or range references with their respective names.



After formulas have been created, you can add names to cell references by
first selecting the range that needs to be modified. Next, select Formulas.
Specific Names Identify Names From the drop-down option, select Apply
Names. Apply Names dialog box appears. You can select the names you
want to apply by clicking on them, after which you can click OK. In Excel,
the names in the selected cells take the place of the range references.

Utilizing Formulas

In this part, we offer a few more formula-related advice and suggestions.

not using hard-coded values

When writing a formula, think again before including a particular value.

You might be tempted to apply the following formula if your formula
calculates sales tax, which is now 6.5 percent: =A1*.065

It is preferable to enter the sales tax rate in a cell and then use the cell
reference.

This makes managing and changing your worksheet simple. Every
calculation that relied on the prior figure would need to be revised, for
instance, if the sales tax rate increased to 6.75 percent. However, if you save



the tax rate in a cell, any changes you make to that cell update all of Excel's
calculations.

Calculating with the Formula bar
To quickly calculate something, you can use the Formula bar as a calculator.
Enter the following formula, for instance, instead of pressing Enter:

= (145*1.05)/12

When you press Enter in Excel, the formula is entered into the cell. You
might wish to keep the result rather than the formula itself because this
formula always produces the same outcome. To do this, hit F9, and then
check the Formula bar to see the outcome. Enter the value to save it in the
currently selected cell. This method also works whether the formula
contains cell references or worksheet functions.

precise replication of a formula
When you put a formula somewhere else after copying it, Excel
automatically updates the cell references. On sometimes, you might want to
create an exact duplicate of the formula. One method to accomplish this is
to convert cell references to absolute values, albeit this isn't always
preferred. It is advisable to select the formula in Edit mode and then copy it
as text to the Clipboard. There are several ways to go about doing this.

To duplicate the formula in A1 and paste it in A2, follow these steps:

1.Double-click A1 to access Edit mode (or press F2).

2. Use the mouse to drag to select the entire formula. Drag from left to right
or from right to left. End, Shift+Home, End, Shift+Home, End, End.

3. From the drop-down menu, select Home > Clipboard > Copy (or press
Ctrl+C). This moves the selected text to the Clipboard (which will become
the copied formula).

4. Press Esc to leave Edit mode.

5. Opt for cell A2.

6. From the drop-down menu, select Home > Clipboard. Use Ctrl+V (or
press Ctrl+V) to paste the content into column A2.



When formulae (or portions of formulae) are copied in this fashion, their
cell references are preserved when pasted into a new cell. This is due to the
fact that text copies of the formulae rather than actual formulas are being
used.

To convert a formula into text, place an apostrophe (') in front of the equal
sign. Copy the cell and paste it in its new location as usual after that. If the
apostrophe is deleted, the reproduced formula will be the same as the
original. Keep in mind to remove the apostrophe from the initial formula.

Converting formulas to values

In certain cases, you may wish to employ formulae to arrive at a solution
and then translate the formulas to real-world numbers.

Simply follow the instructions below:

1. Choose A1:A20.
2. Select Home > Clipboard > Copy (or press Ctrl+C) from the Home

menu.
3. Select Home > Clipboard > Paste Values from the drop-down

menu (V).
4. To exit Copy mode, hit Esc.



 

 



CHAPTER 2
APPLICATION OF FORMULAS TO REGULAR

MATHEMATICAL ACTIVITIES
Most Excel analysts working for corporations will be asked to perform mathematical calculations
that provide insight into crucial operational data. In this chapter, a few mathematical procedures that
are often used in business analytics will be covered.

Percentage Calculations
Running totals, deviation from the budget, and percentages of totals are all crucial considerations in
any basic business analysis. This section will teach you about certain equations that can help you
with these kinds of analysis.

determining the percentage of the target
Simply comparing your actual performance to a predetermined target is all that is required when
someone asks you to compute a percentage of an objective. Dividing the actual by the target is the
simple mathematical formula for this calculation. This will provide you with a percentage that
represents how close you are to achieving your goal. If your goal is to sell 100 widgets but you only
sell 80, you fell short by 80% (80/100).

It's worth noting that the formula in cell E5 simply divides the Actual
column value by the Goal column value.

=D5/C5

This formula isn't complicated. You're merely dividing one number by
another by utilizing cell references. You can input the formula once in the
first row (in this example, cell E5) and then duplicate it down to each
subsequent row in your table.



If you need to compare actuals to a shared aim, you could use a model like
the one below. Each zone does not have its purpose under this approach.
Instead, you're comparing the Actual column's values against a single target
in cell B3.

=C6/$B$3

The cell reference to the common objective ($B$3) has been inserted as an
absolute reference. The dollar symbols fix the goal reference, guaranteeing
that the cell reference relating to the common objective does not change as
you duplicate the formula down.

Percentage variance calculation

The difference between two numbers is quantified by the term "variance."
Think about the consequences if you sold 120 widgets one day and 150 the
next. You sold 30 more widgets on the second day, which is a definite
difference in terms of sales. By taking 150 widgets away from 120 widgets,
a unit variance of +30 is produced.

How much of a difference is a percent, then? This is all about the %
difference between the new value and the benchmark value (120). (150). To
determine the percent variance, subtract the benchmark number from the
new one and then divide the result by the benchmark number. 25% is equal
to (150-120)/120 in this instance. Your sales were 25% more than the
previous day, according to the percent variance.



The percent deviation between current and prior year sales is calculated
using the method in E4.

=(D4-C4)/C4

The usage of parenthesis is one thing to observe about this formula. By
default, the sequence of operations in Excel requires division before
subtraction. However, if we allow this to happen, we will end up with an
incorrect outcome. Excel applies subtraction before division when the
initial portion of the calculation is wrapped in parentheses.

Simply input the formula once in the first row (in this example, cell E4),
and then duplicate it down to each subsequent row in your table.

Another method for estimating percent variation is to divide current year
sales by prior year sales and then remove one. You don't need to use
parenthesis with this alternate formula since Excel does division operations
before subtracting.

=D4/C4-1

% Variance calculation with negative values

But the formula fails if the benchmark value is zero or lower. Think about
the following situation: you're starting a business and expect to lose money
the first year. You therefore allocate yourself a negative $10,000 budget.
Let's say you were able to turn a profit of $12,000 after the first year.

Your real revenue is -220 percent lower than what you anticipated. To test
it, use a calculator. – 12,000 less -10,000 divided by -10,000 equals 220



percent.

How can you claim a variance of -220 percent when you made money? The
problem is that the math inverts the results when your benchmark value is
negative, rendering the numbers absurd. In the business world, where
budgets are frequently negative, this is a severe problem.

The remedy is to neutralize the negative benchmark value using the ABS
function.

=(C4-B4)/ABS(B4)

Excel's ABS function returns the absolute value of any given integer. If
=ABS were input, Cell A1 would return 100. (-100). Any integer can be
changed into a non-negative number with the ABS function. The correct %
variance is obtained by using ABS in this computation, which eliminates
the negative benchmark (in our example, a negative $10,000 budget).

Since it works with any pairing of positive and negative values, you can use
this formula for all of your percent variance requirements.

How to compute a percent distribution

The percent distribution of a statistic, such as total income, indicates how
evenly it is distributed across the component parts that make up the total.
You divide the total by the sum of each component part. In this example, we
have a field that includes all of the revenue (cell C9). We divide the income
of each region by the total to get a percent distribution for each area.

It's easy to understand this formula. Using cell references, you are merely
dividing the value of each component by the sum. The total cell reference
($C$9) is entered as an absolute reference, which is something to bear in
mind. By locking in the reference when you employ the dollar signs, you



can ensure that as you replicate the formula down, the cell reference for the
total amount won't change.

There is no need to enter a specific total amount in a different cell. You can
rapidly determine the total using the% distribution formula. The SUM
function adds up each and every integer you supply.

Pay attention to the absolute references used by the SUM function once
more. The SUM range will stay locked as you continue to multiply the
formula downward.

=C3/SUM($C$3:$C$6)

Running total calculation

When examining changes in a measure over time, some companies opt to
utilize a running total as a tool. From cell D3, the formula for every month
is copied down.

=SUM($C$3:C3)



The SUM function is used in this formula to add all of the units from cell
C3 to the current row. The absolute reference ($C$3) is the key to this
formula. The initial value of the year is locked down by using an absolute
reference in the reference. This guarantee that the SUM function will
always collect and add the units from the initial value to the value on the
current row as the formula is copied down.

Adding or subtracting items by a percentage

For an Excel analyst, applying a percentage increase or decrease to a given
value is a routine task. For instance, when adding a price increase to a
product, you typically raise the starting price by a specific %. By giving a
customer a discount, you lower their rate by a certain amount.

We're raising the cost of Product A by 10% in cell E5. In cell E9, customer
A gets a 20% discount.

To increase a number by a percentage, multiply the original value by 1 plus
the percent increase. In this case, Product A is getting a 10% bump. We
start by adding 1 to the 10% as a consequence. Our final result is 110
percent. Then, a 110 percent increase is applied to the original price of 100.
This results in a new cost of 110.



Also, multiply the original value by 1, which is the percent discount, to
reduce a figure by a percentage amount. Customer A is receiving a 20%
discount in this scenario. So, we start by subtracting 20% from 1. This gives
us a score of 80%. The initial 1000 cost per service is then multiplied by
80%. This adds up to a new rate of 800.

The usage of parenthesis in the formulations should be noted.
Multiplication must be done before addition or subtraction, according to
Excel's default sequence of operations. However, if we allow this to happen,
we will end up with an incorrect outcome. By enclosing the second portion
of the calculation in parenthesis, Excel guarantees that the multiplication is
done last.

Dealing with divide-by-zero errors

Division by zero is impossible in mathematics. Consider what occurs when
you divide one number by another to see why it's impossible.

The division is just a sophisticated version of subtraction. For example,
dividing 10 by 2 is equivalent to beginning with 10 and subtracting 2 as
many times as necessary until you reach zero. In this situation, you'd have
to remove 2 five times in a row.

10 plus two equals eight
6 + 8 Equals 8
6 + 2 equals 4
2 + 4 Equals 2



As a result, 10/2 Equals 5.

If you attempted to do this with 10 divided by 0 instead, you'd never get far
since 10 0 is always 10. You'd be sat there till your calculator died,
subtracting 0's.

10 - 0 = 10
10 - 0 = 10
10 - 0 = 10

And so on.

When you divide any integer by zero, the result is called undefined by
mathematicians. When you attempt to divide by zero in software like Excel,
you get an error. When you divide a number by zero in Excel, you'll receive
the #DIV/0! error.

If your denominator is a zero, you can prevent this by instructing Excel to
skip the computation.

=IF(C4=0, 0, D4/C4)

The condition, what to do if the condition is true, and what to do if the
condition is false are the three inputs to the IF function.

In this case, the condition argument is that the budget in C4 is zero (C4=0).
Condition parameters must be designed to return TRUE or FALSE, which
typically implies a comparison operation or the other worksheet function
that returns TRUE or FALSE (like ISERR or ISBLANK).

The second parameter of the IF function is returned to the cell if our
condition argument returns TRUE. Our second parameter is 0, which
simply means that if the budget number in column C4 is zero, we want a
zero shown.



The third argument takes effect if the condition argument is not zero. We
instruct Excel to conduct the division computation (D4/C4) in our third
parameter.

So, if C4 equals 0, this formula states to return a 0; otherwise, return the
value of D4/C4.

Rounding Numbers

Your clients would often prefer to look at numbers that are neat and
circular. For the sake of accuracy, inundating a user with decimal numbers
and extraneous digits might make your reports more difficult to
comprehend. As a result, you will need to explore utilizing Excel's rounding
tools.

In this part, you'll learn about some of the methods for applying rounding to
your computations.

Rounding numbers using formulas

The ROUND function in Excel is used to round a value to a certain
number of digits. The original value and the number of digits to round to
are sent to the ROUND function.

By using 0 as the second option, Excel will remove all decimal places from
the number and round the integer component to the first decimal place. This
formula, for example, rounds to 94:

=ROUND(94.45,0)

The second parameter of 1 instructs Excel to round to one decimal place
depending on the value of the second decimal place. This formula, for
example, yields 94.5:

=ROUND(94.45,1)

You may also supply a negative integer to the second option, which
instructs Excel to round to the nearest decimal point.

For instance, the following formula yields 90:

=ROUND(94.45,-1)



Using the ROUNDUP or ROUNDDOWN functions, you may force
rounding in a certain direction.

94.45 is rounded down to 94 using the ROUNDDOWN formula:

=ROUNDDOWN(94.45,0)

94.45 is rounded up to 95 using the ROUNDUP formula:

=ROUNDUP(94.45,0)

Rounding to the nearest penny

It is customary practice in various businesses to round currency amounts to
the closest penny. Using the CEILING or FLOOR functions, you may
round to the closest penny.

When you send a number to the CEILING function, it will round it up to
the closest multiple of significance. When you need to alter the normal
rounding procedure with your business criteria, this comes in useful. For
example, you may use the CEILING function with a significance of 1 to
compel Excel to round 123.222 to 124.

=CEILING(123.222,1)

Assigning a significance of.01 instructs the CEILING function to round up
to the closest penny.

You might use.05 as the significance if you wish to round up to the nearest
nickel. For example, the calculation below yields 123.15:

=CEILING(123.11,.05)



The FLOOR function is similar, except it forces a rounding down to the
next significant figure.

The following example function takes 123.19 and rounds it down to the
nearest nickel, yielding 123.15:

=FLOOR(123.19,.05)

Rounding up to significant digits

In some financial reports, figures are given in large numbers. The idea
behind this is that when dealing with millions of dollars, there's no need to
fill up a report with more data just to show accuracy down to the tens,
hundreds, and thousands of dollars.

You may round the figure to one significant digit rather than showing it as
883,788, for instance. According to this, the number 900,000 would be
displayed. 880,000 is what you get if you round 883,788 to two significant
figures.

In other words, you're choosing whether or not to display a particular
number's location. Zeroes could make up the number's remaining fraction.
This would appear to be a problem, but when dealing with large enough
quantities, any number below a certain significance is irrelevant.

Let's examine how this operates:

The ROUND function in Excel is used to round a value to a certain
number of digits. The original value and the number of digits to round to
are sent to the ROUND function.

When the second input is a negative value, Excel rounds the result using
significant digits to the left of the decimal point. For example, the following
formula yields 9500:

=ROUND(9489,-2)

When the significant digits parameter is set to –3, the result is 9000.

=ROUND(9489,-3)



This is excellent, but what if our numbers are on different scales? What if
some of our numbers are in the millions, while others are in the hundreds of
thousands? If we wanted to show all of our numbers with one significant
digit, we'd have to create a separate ROUND function for each number to
account for the varied significant digits arguments that each kind of number
would need.

To deal with this, we may use a formula to generate the number that should
be used instead of our hard-coded significant digits input.

Assume our phone number is –2330.45. In our ROUND function, we can
utilize this formula as the important digits argument:

LEN(INT(ABS(-2330.45)))

*-1+2

This formula first wraps our integer in the ABS function, thereby
eliminating any potential negative symbols. The result is then wrapped in
the INT function, which strips away any decimals. Finally, it uses the LEN
function to calculate the number of digits in the number without using
decimals or negation symbols.

This component of the formula yields 4 in the example. When you remove
the decimals and the negative sign from the number –2330.45, you're left
with four digits.

This number is then multiplied by –1 to make it a negative number, which
is then added to the desired number of significant digits. 4*-1+2 Equals –2
in this case.

We'll utilize this formula as the second input for our ROUND function once
again. If you plug this calculation into Excel, you'll get a result of –2300.
(Two significant digits).

=ROUND (-2330.45, LEN (INT (ABS (-2330.45))) *-1+2)

The formula can be replaced by cell references to the source number and a
cell with the required number of significant digits.

=ROUND (B5, LEN(INT(ABS(B5))) *-1+$E$3)



A Range of Values Can Be Counted

Some of the Excel functions that can be used to count the numbers in a
range include COUNT, COUNTA, and COUNTBLANK. Each of these
routines use a unique method of counting depending on whether the values
are numbers, numbers and text, or blank.

In row 12, we utilize the COUNT function to only count the exams that
students have passed. We are counting all of a student's tests using the
COUNTA function in column H. In column I, we are exclusively using the
COUNTBLANK function to count untaken exams.

When utilizing the COUNT function, only numerical values within a
particular range will be counted. A range of cells serving as a single
parameter is all that is required.

This formula, for example, will only count cells in the range C4:C8 that
have a numeric value:

=COUNT (C4:C8)

The COUNTA function will count every cell that isn't empty. This function
can be applied to cells that contain any combination of numbers and text to
count them. A range of cells serving as a single parameter is all that is
required. For instance, this formula counts every non-blank cell in the range
C4:F4: =COUNTA (C4:F4)



The COUNTBLANK function only counts the empty cells in a range. A
range of cells serving as a single parameter is all that is required.

This formula, for example, will count all of the blank cells in the range
C4:F4:

=COUNTBLANK(C4:F4)

Using the conversion functions in Excel

You might work for a company that requires you to understand how many
cups it takes to fill an Imperial gallon or how many cubic yards a gallon of
material can cover.

You can make a conversion table in Excel using the CONVERT function
that has all the conversions you might possibly need for a group of
measurements.

Using this table, you may easily see how one unit of measure converts to
another. As you can see, a cup contains 48 teaspoons, an English pint
contains 2.4 cups, and so on.

The CONVERT function requires three parameters: a numeric value, the
unit you're converting from, and the unit you're converting to.

Using this method, you might, for instance, convert 100 miles to kilometers
and get the value 160.93:

TRANSFORM = (100,"mi", "km")



Utilize the following formula to change 100 gallons into liters. You will
receive 378.54 as a result of this.

TRANSFORM = (100,"gal", "l")

You'll see that there is a conversion code for each unit of measurement.
These codes are special, and they must be entered exactly how Excel
expects. You will receive an error if you substitute gallon or GAL for the
gal in a CONVERT computation. Thankfully, Excel provides you with a
tooltip when you type the CONVERT function, allowing you to select the
right unit codes from a list.

Look up the CONVERT function in the Excel help files to get a list of
acceptable units of measure conversion codes.

When you have the desired codes, you may add them to a matrix-style
table. Your matrix's top-left cell should contain a formula that makes a
reference to the correct conversion code for the row and column of the
matrix.

Keep in mind that you must provide the absolute references necessary to
protect the conversion code references. A matrix row's row of codes should
be locked to that column's reference. Lock the matrix column's row
reference for the codes.

(1, $E4, F$3) =CONVERT

At this point, just duplicate your formula throughout the entire matrix.

 

 

 

 

 

 



CHAPTER 3
MANIPULATING TEXT WITH FORMULAS

Working with Excel typically involves modifying and organizing data to fit
your data models, rather than just adding and subtracting numbers. A
significant portion of many of these operations involves text string
manipulation. In addition to giving, you an overview of several of Excel's
text-based features, this section will highlight some of the text
transformation tasks that an Excel analyst performs most frequently.

Excel instantly detects when you enter data into a column whether you are
entering a formula, a number, or anything else when you are working with
text. Text is considered to be "anything else."

The phrase string could be heard rather than read. These two terms are
interchangeable. Even better, they might show up together, like in a text
string.

Up to 32,000 characters can fit into a single cell, which is more than the
entire number of characters in this chapter.

Contrarily, Excel is not a word processor, hence there is no justification for
needing that many characters in a cell.

If you need to display a lot of text, think about using a text box in a
worksheet. To create a text box and start typing, choose Insert > Text > Text
Box, then choose the worksheet. Working with large amounts of text in a
text box is easier than editing cells. Additionally, a text box's dimensions
can be easily moved, resized, or modified. Text must be stored in cells if
formulas and functions are required to handle it.
 

 

A Number That Isn't Handled Like a Number
If you import data into Excel, you may have encountered a common
problem: the imported values are sometimes treated as text.



Based on your error-checking settings, Excel displays errors to identify
numbers saved as text. An error signal is displayed as a green triangle in the
upper-left corner of cells. The cell is also accompanied by a symbol.
Clicking the icon will expand to reveal a menu of options, which you can
use to activate the cell. Select Convert to Number from the available
options to make the number into a real number.

To select the error-checking rules that are in use, go to File > Options, then
the Formulas tab. You can select one or more of the nine error types under
Error Checking Rules.

Here is another way to translate these non-numbers into real values: From
any empty cell, select Home > Clipboard > Copy (or press Ctrl+C). Next,
pick the range that contains the values you want to modify. Choose Paste
Special from the drop-down menu under Home > Clipboard. Click OK after
selecting the Add action in the Paste Special dialog box. With this method,
each cell is simply added with zero, which forces Excel to treat non-
numbers as real values.

Text-Based Functions

The text handling worksheet features in Excel are very diverse. Like you
might anticipate, you can access these functions by using the Text control
on the Formulas tab's Function Library group.

Many of the text-based approaches can function with cell numeric values as
well as text, making them useful for both. Excel is surprisingly adaptable
when it comes to treating numbers as text.

This section's examples demonstrate a number of well-liked (and useful)
text-manipulation strategies. Depending on your requirements, some of
these examples might need to be modified.

connecting text strings

One of the most basic text manipulation techniques is joining strings of text.
In this instance, combining the first and last names creates a complete name
column.



In this illustration, the ampersand (&) operator is used. The ampersand
operator in Excel is used to concatenate elements. Cell value combinations
are possible with content. In this example, we are linking the values in cells
B3 and C3, which are spaced apart (created by entering a space in quotes).

Dealing with more intricate situations is made easier by Excel's new
TEXTJOIN feature.

For this new function, only a few parameters are needed:

TEXTJOIN (delimiter, ignore empty values, text) (delimiter, ignore empty
values, text)

The initial input tells the computer what character should go between the
two cells being linked. The function will divide the combined numbers with
a comma if you specify a comma as the "delimiter."

The second option dictates what happens if Excel detects an empty cell.
Excel will disregard empty cells if you set this value to TRUE. Excel will
disregard empty cells if it is set to FALSE. Considering where you want
Excel to place your delimiter is the simplest way to tackle this argument. In
the event that the selected region contains blank cells, Excel will not insert
further commas between your connected text if this option is set to TRUE.

The third argument is the text that must be linked. A single text string or an
array of strings, like a collection of cells, could be used here. To use the
TEXTJOIN function, this parameter must include at least one value or cell
reference.



Setting the text case for sentences
The upper, lower, and appropriate functions in Excel are three useful
options for changing text case. Rows 6, 7, and 8's examples demonstrate
how these techniques only require a reference to the text you intend to
modify. The text is changed to all uppercase with the UPPER function, all
lowercase with the LOWER function, and all title case with the PROPER
function, as would be expected.

Excel lacks a sentence case conversion function that capitalizes only the
first letter of each word.

If you look attentively at this formula, you'll see that it's made up of two
sections connected by an ampersand.

NOTE: The LEFT function in Excel is used in the first portion.

UPPER(LEFT(C4,1)

The LEFT function can be used to remove a predetermined number of
characters from a text string's left side. The text string to be evaluated and
how many characters to be taken from the left of the text string are the two
inputs for the LEFT function. In this example, the leftmost letter is being
taken out of the text in cell C4. The UPPER function is then used to convert
it uppercase.

The second part is a little more challenging. Excel's RIGHT function will be
used in this case:

SHORT (RIGHT (C4, LEN(C4)-1)

Similar to the LEFT function, the RIGHT function also takes two
arguments: the text to be evaluated and the number of characters to be taken



off the right side of the text string. In this case, we can't just pass a hard-
coded integer as the second parameter to the RIGHT function. To get to that
number, we must subtract 1 from the total length of the text string. We take
away 1 to account for the first letter, which is already capitalized because of
the first part of the calculation.

Use the LEN method to get a text string's complete length. To find the
number of characters we'll need for our RIGHT function, we subtract 1
from that.

All of the information may then be fed into the LOWER function, which
lowercases all letters save the first one.

A text string's spaces are removed

You'll almost likely find the text has extra spaces if you're importing data
from external databases or out-of-date systems. The text may contain these
extra spaces at the beginning, end, or even in the middle of text strings.

Extra spaces are generally undesirable as they may cause problems with
lookup computations, graphing, column scaling, and printing.

The TRIM feature is rather simple to use. Simply type some text into it,
and it will eliminate all spaces except single spaces between words.

You can nest the TRIM function in other functions, much like other
functions, to tidy up your text while doing anything else.



This function, for example, cuts the text in cell A1 and transforms it to
uppercase in a single step:

=UPPER(TRIM(A1)

It's worth noting that the TRIM function was created to just remove the
ASCII space character from the text. The ASCII code for the space
character is 32. However, there is an extra space character in the Unicode
character set known as the nonbreaking space character. This character has
the Unicode value of 160 and is often used on websites.

Only CHAR (32) space characters are supported by the TRIM function. It is
unable to handle CHAR(160) space characters on its own. To deal with this
kind of space, use the SUBSTITUTE function to locate CHAR(160) space
characters and replace them with CHAR(32) space characters so that the
TRIM function can correct them.

Taking out specific text from a string

One of the most crucial methods for modifying text in Excel is the capacity
to extract certain text segments.

With the help of Excel's LEFT, RIGHT, and MID functions, you can do
something like this:

• Reducing postal codes from nine to five digits.

• Have phone numbers without the area code.

• Repurpose pieces of employee or job codes in other contexts.

The LEFT method allows you to take a specific amount of characters out of
a text string's left side. The text being evaluated and the number of
characters to be extracted from the left side of the text string are the two
arguments for the LEFT function. In this example, we are removing the first
five characters from the value in column A4:

=LEFT(A4,5)

The RIGHT function removes a predetermined number of characters from a
text string's right side. The text string to be evaluated and the number of



characters to be extracted from the text string's right side are the two inputs
that the RIGHT function requires.

In this example, we are removing the appropriate eight characters from the
value in column A9:

=RIGHT(A9,8)

You could use the MID function to extract a specified number of characters
from the center of a text string. The MID function takes three arguments:
the text string to be evaluated, the character position in the text string to
begin extraction from, and the number of characters to be extracted.

In this example, we'll extract one character from our text string
beginning at the fourth character:

=MID(A14,4,1)

Finding a particular character in a text string

The LEFT, RIGHT, and MID functions in Excel are wonderful for
extracting text, but only if you know where the letters, you're looking for
are located. What can you do if you're not sure where to begin the
extraction?



For example, how would you remove all of the content after the hyphens
from the following list of product codes?

PRT-432
COPR-6758
SVCCALL-58574

Because you'll require the correct few characters, the LEFT function won't
work. Because you need to tell it precisely how many characters to extract
from the right of the text string, the RIGHT function by itself won't work.
Any value you provide will extract either too many or too few characters
from the text. Because you must tell it precisely where in the text to start
extracting, the MID function alone will not work. Any number you provide
will either retrieve too many or too few characters from the text.

In actuality, you'll often need to locate certain characters to get the proper
extraction starting point. The FIND tool in Excel comes in helpful here.
You may acquire the position number of a specific character using the
FIND function and utilize that character position in subsequent operations.

We utilize the location of the hyphen to input the MID function, as you can
see from the calculation.

=MID(B3,FIND("-",B3)+1,2)

Two parameters are needed for the FIND function. The first parameter is
the text that you're looking for. The text you wish to search is the second
parameter. The FIND function returns the position number of the character
you're looking for by default. The FIND function will provide the position
number of the first encounters if the text you're seeking includes more than
one of your search characters.

For example, in the text string PWR-16-Small, the following algorithm will
look for a hyphen. Because the first hyphen it sees is the fourth letter in the
text string, the outcome will be a number four.

=FIND("-","PWR-16-Small")



The FIND function can be used as an input in a MID function to extract a
predetermined number of characters after the FIND function returns a
position number.

When you type this formula into a cell, you'll get the two integers that come
after the first hyphen in the text. The +1 in the formula should be noted.
This guarantee that you shift one-character forward after the hyphen to
reach the content.

=MID ("PWR-16-Small”, FIND("-","PWR-16-Small”) +1

Tracking down a character's second appearance

The position number of the first instance of the character you're searching
for is what the FIND function default returns. Get the position number of
the second instance using the optional Start Num parameter. With this
choice, you can set the search to begin at a specific text-string character.

This calculation will produce the position number of the second hyphen
since we are instructing the FIND function to begin scanning at position 5
(from the first hyphen):

=FIND("-","PWR-16-Small",5)

In order to accomplish this dynamically, you can nest a FIND function and
use it as the Start Num parameter in another FIND function.

Use the Excel formula below to determine where the second hyphen should
be located:



We can extract the size property from the product code by using the formula
=FIND ("-","PWR-16-Small", FIND("-","PWR-16-Small") +1). To do this,
we need to find the second instance of the hyphen and use that position
number as the starting point in the MID function. Cell C3's equation is as
follows:

B3, FIND ("-", B3, FIND ("-", B3)+1)+1,10000)

This formula instructs Excel to locate the second hyphen's position number,
shift one-character forward, and then retrieve the following 10,000
characters. Although there aren't 10,000 characters, this guarantees that
everything after the second hyphen gets retrieved.

Changing text strings
Sometimes it's advantageous to substitute one text with another. An
example of this is when using the PROPER function and running into the
annoying apostrophe S ('S) quirk. To see what we mean, type the following
formula into Excel:

=APPROPRIATE ("STARBUCK'S COFFEE")

The provided text will be changed to title case using this algorithm.

What the formula actually produces is as follows:

Coffee Startbuck's

It's important to note that the PROPER function capitalizes the S following
the apostrophe, which is unattractive.

With a little help from Excel's SUBSTITUTE function, you can get out of
this jam. The SUBSTITUTE function, which is used in our formula, accepts



three arguments: the target text, the existing text that needs to be replaced,
and the new text that should be used in its stead.

You'll see that there are two SUBSTITUTE functions used in the entire
formula. There are two formulas in this formula. The phrase "The first
formula is the part that reads, " in the section. The phrase "The first
PROPER(SUBSTITUTE(B4,"'","qzx")")" appears in the first formula.

In this section, replace the apostrophe (') with qzx using the SUBSTITUTE
function. Although it can appear like an odd idea, there is a strategy behind
it. The PROPER function will capitalize all letters that follow a symbol. In
order to trick the PROPER function, the apostrophe is replaced with a
benign string of letters that are unlikely to be connected in the original text.

The second formulation serves as a container for the first.

In this formula, an apostrophe is used in place of the harmless qzx:

=SUBSTITUTE(PROPER(SUBSTITUTE(B4,"'","qzx"),"qzx","'")

The consequence is that the entire formula replaces the apostrophe with the
character qzx, then executes the PROPER function before changing the qzx
back to an apostrophe.

A cell's characters can be counted individually

It's useful to be able to determine how many times a particular character
appears in a text string. Excel does this in a pretty amazing way.

For instance, you could count by hand the instances of the letter s in the
word Mississippi, but you could also count them methodically by doing the
following:

1. Calculate the character count for the word "Mississippi" (11 characters).

2. Determine the character's length after removing every letter s. (7
characters).

3. Subtract the modified length from the original length.

By following these steps, you'll be able to recognize that the word
Mississippi contains the letter s four times. This method of counting



specific characters can be applied in Excel to calculate the word count. The
number of words entered in cell B4 (in this case, nine words) is calculated
using the formula below:

=LEN(B4)-LEN(SUBSTITUTE(B4," ","") (B4," ","") +1

This formula substantially adheres to the setup steps described in the
preceding section.

 

The LEN function is initially used to determine the length of the text in
cell B4:

LEN(B4)

The SUBSTITUTE function is then used to eliminate the spaces from
the text:

AS A REPLACEMENT (B4," ","")

We can get the length of the text without the spaces by wrapping the
SUBSTITUTE function in a LEN function. To account for the fact that the
final word will not have an accompanying space, we must add one (+1) to
that answer:

LEN(SUBSTITUTE(B4," ",""(+1

We get our word count by subtracting the modified length from the initial
length:

=LEN(B4)-LEN(SUBSTITUTE(B4," ","")- +1

A formula's line break can be added.

Sometimes it helps to force line breaks when creating charts in Excel to
produce better representations. Consider the graph as an example. The data
value for each sales rep is represented by the x-axis labels in this graph.
This is useful when you don't want your chart to be cluttered with data
labels.



The key to this method is using the CHAR() function inside a formula to
create your chart labels.

Each Excel character is given a code by the American National Standards
Institute (ANSI). The characters that appear on your screen are defined by a
group of Windows system codes known as the ANSI character set. The
ANSI character set has 255 characters that are numbered from 1 to 255. The
capital letter A is character number 65. The number 9 appears in character
57.

Codes exist for even non-printing characters. Space is represented by the
number 32. A line break is represented by the number 10.

The CHAR() method may be used to get any character from a formula.

=A3&CHAR(10)&C3

Unless you apply wrap text to the cell, the line break will not be seen.
However, even if you haven't, any chart that uses this kind of formula will
show the data supplied by the formula with line breaks.



 

 

The removal of unusual characters from text fields

When you import data from outside sources like text files or online feeds,
strange characters could show up in your data. Instead of cleaning them up
by hand, you might utilize Excel's CLEAN tool.

Nonprintable characters are removed from any text you give to the CLEAN
function. Wrapping the CLEAN function within the TRIM function will
remove both unnecessary spaces and unprintable characters at once.
=TRIM(CLEAN(B3))

Using zeros to pad integers

Your work in Excel frequently finds its way into other database systems
used by the business. A particular minimum number of characters are
frequently required due to field length limits in some database systems. A
common method for ensuring that a field contains a predefined number of
characters is to pad data with zeros.

The idea of padding data using zeros is straightforward. You must include
enough zeros to satisfy the requirement if the Customer ID field has to be
10 characters long. The output would be Customer ID 2345000000, which
would require padding with six zeros. By doing this, a brand-new text string
is created with a Customer ID value of 10.



The LEFT function is then used to extract the first 10 characters of the new
text string.

Formatting a text string's numbers

Combining text and numbers in reporting is somewhat uncommon.

For instance, you could need to add a sentence to your report that highlights
a salesperson's accomplishments, like this:

To John Hutchison, $5,000

The problem is that the formatting for numbers is lost when they are
merged in a text string. It's important to note that the format of the integers
in the combined string differs from that of the source cells.

To address this issue, use the TEXT function to encapsulate the cell
reference for your numeric value. You may apply the necessary formatting
on the fly using the TEXT function.

The TEXT function takes two arguments: a value and an Excel format that
is valid. You may format a number in any way you like as long as it's a
format that Excel understands.

You may use this formula in Excel to show $99, for example:

=TEXT (99.21,"$#, ###")

To show 9921 percent, put the following formula into Excel:



TEXT = (99.21,"0 percent ")

This formula may be entered into Excel to show 99.2:

=TEXT (99.21,"0.0")

A quick way to understand the syntax for a particular number format you're
interested in is to look at the Number Format screen.

Follow these instructions:

1. By right-clicking any cell, choose Format Cell from the context menu.

2. On the Number Format tab, choose the desired formatting.

3. Select Custom from the Category list on the left side of the Number
Format dialog box.

4. Copy the syntax and paste it into your page.

By means of the DOLLAR function

If you want to connect a numeric value with text that is a dollar amount, use
the DOLLAR function. The provided text is formatted into a local currency
using this technique. Two parameters are passed to the DOLLAR function:
an integer value and the number of displayed decimals.

"&DOLLAR" =B3&" (C3,0)



CHAPTER 4
Utilizing Formulas with Dates and Times

Many spreadsheets contain cells with dates and times. For instance, you
may create a timetable or organize information by date. For beginners,
using dates and timings in Excel may be challenging. An in-depth
understanding of Excel's handling of time-based data is necessary when
working with dates and timings.

You may get all the information you need to create reliable date and time
formulas in this area.

The dates listed below are in the month/day/year format common in the US.
For instance, the number 3/1/1952 refers to March 1 rather than January 3.
Despite the fact that we understand this arrangement to be absurd, that is
the way Americans have been trained. We have no doubt that readers from
other countries will be able to make the required modifications.

Excel Date and Time Handling: An Understanding
You may get a quick overview of Excel's date and time handling in this
section. This section covers Excel's date and time serial number system.
Some instructions on how to input and format dates and timings are also
included.

Acquiring knowledge about date serial numbers
Excel only treats dates as numbers. A date is a serial number that represents
the duration of time since the fictitious date of January 0, 1900. A serial
number of 1 corresponds to the first day of the year 1900; a serial number
of 2 to the second day; and so on. You can create formulas that do
calculations depending on dates using this approach. You may create a
formula to determine how many days there are between two dates, for
instance (just subtract one from the other).

Regarding January 1, 1900, you might be interested. The term "nondate" is
used to describe times that are not associated with a particular day.



To display a date serial number as a date, format the cell as a date. Choose
the option Home > Number > Number Format. This drop-down menu offers
two different date formats.

Select a Date System: 1900 Or 1904
Excel is compatible with both the 1900 and the 1904 date systems.
Depending on the method you use, you can choose which date is used as the
starting point for dates in a worksheet. January 1, 1900, is the date assigned
to date serial number 1 in the 1900 date system. The 1904 date system was
established on January 1st of that year. Before 2011, Excel for Mac used the
1904 date system, whereas Excel for Windows defaults to the 1900 date
system.

Excel for Windows supports the 1904 date format to be compatible with
older Mac files. You can choose the date system for the current worksheet
in the Advanced section of the Excel Options dialog box. When calculating
This Workbook, it is found in the section titled  general, you should use the
1900 year default date system. Using two different date systems in linked
workbooks requires caution as well. Assume that cell A1 has the date
1/15/1999 and that Book 1 use the 1904 calendar. Assume that Book2
connects to Cell A1 in Book1 and uses the 1900 calendar. Book 2 takes
place on January 14, 1995. Both workbooks utilize the same date serial
number (34713) but are read in distinct ways.

The 1904 date system has the advantage of enabling the display of negative
time values. A calculation that yields a negative time cannot be presented
using the 1900 date system. When using the 1904 date system, the negative
time is displayed as -1:30. (that is, a difference of 1 hour and 30 minutes).

Dates Entry

If you know the serial number, you can input the date as a serial number
and then format it as a date. A date is often entered using one of the several
common date formats. Excel converts your data into the corresponding date
serial number (used for calculations) and forms the cell with the standard
date format, showing it as an actual date rather than a mysterious serial
number.



You could input June 18, 2018, for instance, into a cell if you wanted to
enter that date. Excel examines your data and gives the serial number for
that date the value 43269. Additionally, the default date format is used, so
the contents of the fields might not display exactly as you entered them.

Depending on your locale settings, entering a date in the format June 18,
2018, can appear as a text string. In this case, you must supply the date in
the format required by your regional settings, such as June 18, 2018. When
a cell containing a date is activated, the Formula bar shows the contents of
the cell formatted according to the system's short date format, which
corresponds to the default date format. The Formula bar does not display
the date's serial number. In order to retrieve the serial number for a
particular date, format the cell using the General format.

To change the default date format, you must modify a system-wide setting.
The Region dialog box will open after you choose Clock and Region in the
Windows Control Panel. The actual procedure varies depending on the
Windows version you're using. Locate the drop-down menu so you can
change the Short Date's format. The choice you select determines the
default date format Excel uses to display dates in the Formula bar.

When it comes to recognizing dates placed into a cell, Excel is rather
forgiving. It isn't ideal, however. When you input a date that is outside of
the supported date range, Excel treats it as text. When you try to format a



serial number as a date that is beyond the permitted range, the result
appears as a sequence of hash marks (#########).

Browsing for Dates

To find a specific date in a worksheet with many dates, use the Find and
Replace dialog box (Home > Editing > Find & Select > Find, or Ctrl+F).
Excel can be a little picky when it comes to dates. The date needs to be
entered precisely as it appears in the Formula bar. The date is shown in the
Formula bar using your system's short date format, such as 6/19/2016, if a
cell contains a date that is set to display as of June 19, 2016. If you search
for the date in the cell as it appears, Excel won't find it. However, if you use
the formula bar to search for the date, it will find the cell.

knowledge of time serial numbers

Decimals can be added to the Excel date serial number system when
working with time data. In other words, when it comes to time, Excel works
with fractional days. For instance, the date serial number for June 1, 2016,
is 42522. The internal time code for noon is 42522.5.



 

One minute has a serial number equal to roughly 0.00069444. This figure is
calculated by multiplying 24 hours by 60 minutes and then dividing the
result by 1. The numerator is the total number of minutes in a day (1,440).

=1/(24*60)

Likewise, the serial number equivalent to one second is around
0.00001157, which may be calculated using the formula:

=1/(24*60*60)

The denominator in this situation is the number of seconds in a day
(86,400).

The lowest unit of time in Excel is one-thousandth of a second. The
following time serial number corresponds to 23:59:59.999 (one-thousandth
of a second before midnight):

0.99999999

Entering times

You usually don't have to care about the exact time serial numbers, just as
you don't have to worry about dates. Simply type the time into a field in the
appropriate format.



Excel assigns a date serial number of 0 to the previous samples since they
don't have a particular day associated with them. This corresponds to
nonday January 0, 1900. You'll often need to mix the date and time. Use a
recognized date input format, a space, and then a recognized time entry
format to do this. If you type 6/18/2016 11:30 in a cell, Excel will read it as
11:30 a.m. on June 18, 2016. 42539.47917 is the date/time serial number.

When you provide a time that is longer than 24 hours, the time's associated
date advances correspondingly. If you type 25:00:00 into a cell, for
example, it will be read as 1:00 a.m. on January 1, 1900. Because the time
surpasses 24 hours, the day portion of the input increases. Keep in mind that
if a time value is entered without a date, the date is set to January 0, 1900.

In the same way, if you input a date and a time (and the time exceeds 24
hours), the date you entered will be modified. For example, if you type
9/18/2016 25:00:00, it will be translated as 9/19/2016 1:00:00 AM.

The maximum time you may put into an unformatted cell if you merely
enter a time (without an accompanying date) is 9999:59:59. (just less than
10,000 hours). Excel calculates the correct number of days. In this scenario,
9999:59:59 corresponds to 3:59:59 PM on February 19, 1901. When you
input a time that is longer than 10,000 hours, it is treated as a text string
rather than a time.

Manipulating times and dates
There are numerous formatting options available when it comes to cells that
include dates and timings. The cell can be formatted to, for instance, display



just the date portion, just the time portion, or both the date and time
portions.

Dates and timings can be formatted by selecting the cells, then using the
Number tab in the Format Cells dialog box. To open the dialog box, click
the dialog box launcher icon located in the Home tab's Number group, or
click the Number Format control and choose More Number Formats from
the list that appears.

Built-in date formats appear in the Date category, whereas built-in time
formats appear in the Time category. On some forms, the date and time are
both displayed. From the Type drop-down menu, select the necessary
format, then click OK.

Excel may format the formula cell as a date or time by default when you
write a formula that references a cell that includes a date or time.
Sometimes, this automation is advantageous; other times, it is completely
inappropriate and annoying. To return the number formatting to the
standard General format, go to Home > Number > Number Format and
select General from the drop-down box. As an alternative, press Ctrl+Shift+
(tilde).

Challenges with dates

Excel has some problems handling dates. The fact that Excel was developed
so long ago may be the cause of many of these problems. The limited date
and time capabilities of the Lotus 1-2-3 program, which feature a horrible
flaw that was deliberately reproduced in Excel, were effectively imitated by
Excel designers (described next). If Excel were designed from the bottom
up today, I have no doubt that it would be far more flexible when handling
dates. Users are currently forced to use a product with a date selection that
is far from ideal.

The leap year glitch in Excel

There is a leap year, which has an additional day, every four years
(February 29). If a year is equally divisible by 100, it is not a leap year
unless it is also evenly divisible by 400. Despite the fact that 1900 was not a
leap year, Excel treats it as one. In other words, when you enter the date



2/29/1900 into a column, Excel accepts it as a valid date and assigns it a
serial number of 60.

However, if you put 2/29/1901, Excel recognizes it as a typo and does not
convert it to date. Instead, the cell entry is simply converted to a text string.

How can a product utilized by millions of people every day have such a
glaring flaw? The solution is based on history. Lotus 1-2-3 faulted the first
edition that led it to consider 1900 as a leap year. When Excel was
introduced later, the designers were aware of the defect and opted to
replicate it in Excel to keep Lotus 1-2-3 worksheet files compatible.

Why is this problem still present in subsequent Excel versions? According
to Microsoft, the drawbacks of fixing this defect outweigh the benefits.
Millions of existing workbooks would be messed up if the problem was
fixed. Furthermore, resolving this issue may have an impact on Excel's
interoperability with other date-based tools. Because most people don't
utilize dates before March 1, 1900, this defect currently causes relatively
few issues.

Pre-1900 dates

Of course, the world did not begin on January 1, 1900. Excel users who
deal with historical data often need to work with dates before January 1,
1900. Unfortunately, the only option to deal with dates before 1900 is to
type them into a cell. For example, Excel will not object if you type July 4,
1776, into a cell.

If you want to arrange information by dates from the past, start with a four-
digit year, then a two-digit month, and finally a two-digit day—for
example, 1776-07-04. Although you won't be able to use these text strings
as dates, this format will allow for precise sorting.

In certain cases, using text as a date works, but the fundamental issue is that
you can't manipulate a date that's been input as text. For example, you can't
modify the date's numeric formatting, figure out what day of the week it
happened on, or compute the date seven days later.

Dates that are inconsistent



Be careful when entering dates with two digits for the year. Excel offers
several guidelines that specify which century to utilize when doing so.

Dates with two digits from 00 to 29 are regarded as 21st-century ones,
while those with two numerals from 30 to 99 are regarded as 20th-century
ones.

Excel, for instance, will interpret the number 12/15/28 as December 15,
2028. Excel understands 12/15/30 as December 15, 1930, whereas
Windows uses 2029 as the boundary year by default. You can either stick
with the default settings or make changes in the Windows Control Panel. To
access the Customize Format dialog box, click the Additional Settings
button in the Region dialog box. Change the year after selecting the Date
tab.

To prevent any surprises, just input all years with the full four numbers for
the year.

Using Excel's Date and Time Functions

There are many functions in Excel that operate with dates and timings.
Formulas > Function Library > Date & Time is where you'll find these
functions.

Dates and times are nothing more than a numbers system behind the covers,
therefore these functions take use of that. This opens the door to a plethora
of interesting formula-based investigations. You'll go through some of these
fascinating studies in this section. You'll learn a few approaches that will
help you construct your formulae along the road.

Getting the current date and time

You may use one of two Excel functions instead of inputting the current
date and time. The current date is returned by the TODAY function:

=TODAY()

The NOW () method returns the current date and time as follows:

=NOW ()



The TODAY and NOW operations both return date serial numbers that
indicate the system's current date and time. The TODAY method sets the
time to noon, while the NOW function returns the current time.

It's crucial to remember that both of these methods will recalculate each
time you alter or access your worksheet, so don't use them as a recorded
timestamp.

Press Ctrl+; (semicolon) on your keyboard to enter a fixed date that will
not change. In the active cell, a static date will be inserted.

By wrapping the TODAY function in the TEXT function and adding some
date formatting, you may utilize it as part of a text string. This formula will
produce text that displays the current date in Month Day, Year format.

="Today is "&TEXT (TODAY (),"mmmm d, yyyy

Calculating age

Using Excel's DATEDIF function is one of the simplest methods to figure
out how old something is. This utility simplifies the process of computing
date comparisons.

 
You can use the DATEDIF function to compute a person's age by using a
formula like this:

=DATEDIF ("5/16/1972”, TODAY(),"y")

Of course, you may refer to a cell containing a date:

=DATEDIF (B4, TODAY(),"y")



The DATEDIF function determines how many days, months, or years there
are between two dates. Three parameters are required: a start date, an end
date, and a time unit.

You can simply compute the number of years, months, and days between
two dates using these time codes. If someone was born on May 16, 1972,
the following formulae may be used to calculate their age in years, months,
and days:

=DATEDIF("5/16/1972”, TODAY(),"y")

=DATEDIF("5/16/1972”, TODAY(),"m")

=DATEDIF("5/16/1972”, TODAY(),"d")

Calculating the number of days between two dates

Calculating the number of days between two dates is one of the most
frequent date computations in the business sector. It's used by project
managers to monitor performance against a deadline, HR departments to
track time to complete a requisition, and finance departments to track
receivables aging. Fortunately, owing to the DATEDIF function, it's one of
the simplest computations to complete.

=DATEDIF(C4, TODAY(),"d")

The DATEDIF function is used with the time code d in this formula. This
instructs Excel to calculate the number of days based on the start (C4) and
finish (C5) dates (TODAY).

Calculating the number of workdays between two dates



Counting weekends in the final number of days when reporting on the
elapsed number of days between a start date and an end date is not always
suitable. Because operations are often closed on weekends, you should
avoid counting those days.

The NETWORKDAYS function in Excel is used to compute the number
of days between a start and finish date, excluding weekends.

In cell E4, the NETWORKDAYS function is used to determine the number
of workdays between January 1, 2019, and December 31, 2019.

This is a simple formula to follow. The start date and end date are both
mandatory inputs for the NETWORKDAYS function. This formula would
provide the number of workdays (excluding Saturdays and Sundays)

if your start date is in cell B4 and your finish date is in cell C4:

=NETWORKDAYS (B4, C4)

Using NETWORKDAYS.INTL

The NETWORKDAYS function has one disadvantage: it excludes
Saturday and Sunday by default. But what if you work in a location where
Fridays and Saturdays are the weekends? Worse, what if your weekends are
limited to Sundays?

The NETWORKDAYS.INTL function in Excel can help you out. This
method contains an optional third parameter, a weekend code, in addition to
the mandatory start and finishes dates. You can use the weekend code to
designate which days are not considered weekends.

As soon as you input the third parameter in the NETWORKDAYS.INTL
function, Excel shows a menu. Simply press Enter after selecting the proper



weekend code.

Generating a list of business days excluding holidays

It's typically helpful to have a helper table that provides a list of dates that
reflect business days when building dashboards and reports in Excel (that
is, dates that are not weekends or holidays). This kind of assistance table
may aid in calculations such as revenue per business day, unit revenue per
business day, and so on.

The WORKDAY.INTL function is one of the simplest methods to
construct a list of business days. Begin with a spreadsheet that includes the
previous year's end date as well as a list of your company's holidays.

Enter the following formula in the box under the previous year's last
date:

=WORKDAY.INTL(B3,1,1,$D$4:$D$15)

You can now replicate the formula to generate as many business days as
you need. The INTL function generates a workday date depending on the
number of days you provide.



There are two necessary parameters and two optional arguments for this
function:

Commencement Date (required): This is the date from which to
begin.
Number of days (required): This option specifies the number of
days to return from the start date.
Holidays and weekends (optional): The WORKDAY is selected by
default. Saturdays and Sundays are excluded from the INTL
function, but the third option enables you to select which weekdays
should be excluded as weekend days. Excel provides a menu where
you may pick the proper weekend code as soon as you input the
WORKDAY.INTL function.
Vacations (optional): In addition to the weekend days, this
parameter enables you to offer Excel a list of dates to omit.

In this case, we're instructing Excel to begin on December 31, 2012, and
then increment up one day to get the following business day after that. We
state in our optional arguments that Saturdays and Sundays, as well as the
holidays specified in cells $D$4: $D$15, must be excluded.

=WORKDAY.INTL(B3,1,1, $D$4: $D$15)

Make careful to use absolute references to lock down the range for your list
of holidays so that it stays locked when you copy your formula down.

Extracting parts of a date

Although it may seem little, picking out a particular area of a date may be
quite useful. For example, you could need to select all records with order
dates during a certain month or all workers having Saturday time. You'll
need to extract the month and workday number from the formatted dates in
these cases.

To break down dates into their component components, Excel offers a basic
collection of functions. The following are the functions:

YEAR is a function that extracts the year from a given date.
MONTH is a function that extracts the month from a given date.



From a given date, DAY derives the month day number.
For a given date, WEEKDAY returns the weekday number.
For a given date, WEEKNUM returns the week number.

These are rather easy functions.

The YEAR function provides a four-digit value representing the year of a
given date. This calculation yields the year 2015.

=YEAR("5/16/2015")

The MONTH function produces an integer between 1 and 12 representing
the month of a given date. The result of this formula is 5.

=MONTH("5/16/2015")

The DAY function provides a number between 1 and 31 that represents the
month day on a given date. The result of this formula is 16.

=DAY("5/16/2015")

The WEEKDAY function produces a number between 1 and 7 that
indicates the day of the week (Sunday through Saturday) on which the
given date falls. The number 1 is returned if the date occurs on a Sunday.
The number 2 is returned if the date occurs on a Monday, and so on.
Because 5/16/2015 occurs on a Saturday, this calculation yields 7.

=WEEKDAY("5/16/2015")



This method provides an optional return type parameter that allows you to
choose which day of the week is in the first place. Excel offers a menu
where you may pick the proper return type code as soon as you input the
WEEKDAY function.

You can change the algorithm to represent Monday through Sunday with
return values 1 through 7. Because the algorithm returns 6 in this situation,
Saturdays are now designated as the 6th day of the week.

=WEEKDAY("5/16/2015",2)

The WEEKNUM method returns the year's week number for the week that
the supplied date falls inside. Because 5/16/2015 occurs in week 20 of
2015, this algorithm yields 20.

=WEEKNUM("5/16/2015")

This method contains an optional return type parameter that allows you to
choose which day of the week determines the week's start. The
WEEKNUM function sets the start of the week to Sunday by default. Excel
offers a menu where you may choose a different return type code as you
type in the WEEKNUM function.

Calculating the number of years and months between dates

You may be requested to state the difference between two dates in years and
months in certain circumstances. In these circumstances, two DATEDIF
functions may be used to construct a text string.

Two DATEDIF functions are combined in a text string using the ampersand
(&) operator to accomplish this purpose.



The first DATEDIF function uses the year time unit (Y) to compute the
number of years between the start and finish dates:

DATEDIF(A4,B4,"Y")

The second DATEDIF method ignores the year component of the date and
calculates the number of months using the YM time unit:

DATEDIF (A4, B4, "YM")

We combine these two routines with some custom text to inform customers
which number represents years and which month:

=DATEDIF(A4,B4,"Y") & " Years, " & DATEDIF(A4,B4,"YM") & "
Months" =DATEDIF(A4,B4,"YM") & " Months"

Converting dates to Julian date formats

Julian dates are often used as a timestamp and fast reference for batch
numbers in production contexts. Retailers, customers, and service agents
may use date coding to determine when a product was manufactured and
consequently its age. Julian dates are widely utilized in astronomy,
programming, and the military.

Different industries use different Julian dates, but the most popular is made
up of two parts: a two-digit number denoting the year and the number of



days that have passed since the year began. The Julian date for January 1,
1960, for example, would be 601. The Julian date for December 31, 2014,
is 14365.

To convert a standard date to a Julian date, Excel does not provide a built-in
function. This formula is two formulae that have been put together as a text
string using the ampersand (&).

The first formula uses the RIGHT function to retrieve the year's right two
digits. It's worth noting that we're extracting the year component of the date
using the YEAR function.

=RIGHT(YEAR(A4),2)

The second formula is a little more difficult. We must determine how many
days have passed since the start of the year. To do so, we must first deduct
the desired date from the preceding year's last day.

A4-DATE(YEAR(A4),1,0)

You'll see that the DATE function is used. We may create a date on the fly
using the DATE method by passing three arguments: the year, month, and
day. From 1900 to 9999, the year may be any whole number. Any positive
or negative number may be used for the month and date.



This calculation, for example, would provide the December 1, 2013 date
serial number:

DATE= (2013, 12, 1)

It's worth noting that the day argument in our Julian date calculation is zero.
When you provide 0 as the day argument, Excel understands that you want
the day before the first of the month. The day before January 1 in this case
is December 31.

If you type this formula into a blank cell, you'll get the following result:
December 31, 1959:

=DATE (1960,1,0)

The Julian date is formed by joining our two formulae with an
ampersand:

A4-DATE(YEAR(A4),1,0) & =RIGHT(YEAR(A4),2)

Calculating the percent of the year completed and remaining

When creating Excel reports and dashboards, it's helpful to know what
percentage of the year has passed and what percentage remains. These
percentages might be utilized in other computations or as a simple reminder
to your readers.

The start date and end date are all that are required for the YEARFRAC
function. It then calculates the percentage of the year that represents the



number of days between both the start and finish dates once it knows those
two variables.

=YEARFRAC (B3, C3)

Simply remove 1 from the YEARFRAC calculation to obtain the
percent left:

=1-YEARFRAC (B3, C3)

Returning the last date of a given month

When dealing with dates, calculating the last date of a particular month
dynamically is a typical need. The final day of most months is set, but the
last day of February fluctuates depending on whether or not the year is a
leap year.

The DATE method uses three inputs to create a date on the fly: the year,
month, and day. From 1900 to 9999, the year may be any whole number.
Any positive or negative number may be used for the month and date.

This calculation, for example, would provide the December 1, 2013 date
serial number:

DATE= (2013, 12, 1)



You inform Excel and you want the day before the 1st of the month when
you use 0 as the day argument. If you type this formula into a blank cell,
you'll get the following result: February 29, 2000:

=DATE (2000,3,0)

We utilize the YEAR function to obtain the chosen year and the MONTH
function to get the desired month in our example, rather than hard-coding
the year and month. We proceed into the following month by adding one to
the month. When we utilize the number 0 as the day, we receive the final
day of the month we're interested in.

=DATE(YEAR(B3), MONTH(B3) +1,0)

Remember that the method may be used to find the final day of any month,
not simply February.

Using the EOMONTH function

The EOMONTH function is a convenient replacement for the DATE
function. You may retrieve the end date of any future or previous month
using the EOMONTH function. Only two arguments are required: a start
date and the number of months in the future or past.

This formula, for instance, will return the final day of April 2015:

=EOMONTH ("1/1/2015", 3) =EOMONTH ("1/1/2015", 3) =EOMONTH
("1/

A date in the past will be returned if you provide a negative number of
months. On the final day of October 2014, this formula will return:

=EOMONTH ("1/1/2015", -3) =EOMONTH ("1/1/2015", -3)

You can retrieve the final day of the current month by combining the
EOMONTH and TODAY functions.

=EOMONTH (TODAY (),0)

Calculating the calendar quarter for a date



Excel has no built-in function for calculating quarter numbers, believe it or
not. You'll need to construct your formula if you need to figure out which
calendar quarter a given date belongs to.

Simple math is the key to this formula's success. Here, you're dividing the
supplied month's number by three and then rounding it up to the closest
integer. Let's imagine you're trying to figure out which quarter August
belongs to. You might divide 8 by 3 since August is the eighth month of the
year. As a result, the solution is 2.66. You get 3 if you round that number
up. As a result, August falls into the third quarter of the year.

The formula below accomplishes the same goal. The MONTH function is
used to derive the month number from a date, while the ROUNDUP
function is used to force rounding up.

=ROUNDUP(MONTH(B3)/3,0)

Calculating the fiscal quarter for a date

Many of us work for companies that do not begin their fiscal year in
January. Rather, it may begin in October, April, or any other month. Fiscal
quarters cannot be computed in the same manner as calendar quarters in
these companies.

When our fiscal year begins in April, we calculate the fiscal quarters in this
manner. The following is the formula in the Formula bar:

=CHOOSE(MONTH(B3),4,4,4,1,1,1,2,2,2,3,3,3)



Based on a position number, the CHOOSE function delivers an answer
from a list of options. Because Silver is the second choice in your list of
options, you would obtain Silver if you used the formula =CHOOSE (2,
"Gold", "Silver", "Bronze", "Coupon"). A coupon, the fourth option, would
be obtained by replacing the 2 with a 4.

The first input to the CHOOSE function is a mandatory index number. This
parameter is a number between 1 and the number of options listed in the
following set of arguments. Which of the following parameters is returned
is determined by the index number?

The following 254 parameters describe your options and control what is
returned when an index number is supplied (just the first one is necessary).
The first option is returned if the index number is 1. The second option is
returned if the index number is 2.

The goal is to feed date to a list of quarter numbers using the CHOOSE
function:

=CHOOSE(MONTH(B3),4,4,4,1,1,1,2,2,2,3,3,3)

Excel uses the month number for the supplied date and selects a quarter that
matches that number, as seen in column C3. Excel returns the first option in
this situation since the month is January (January is the first month). The
number four is the first option. The fourth fiscal quarter begins in January.



Assume your company's fiscal year begins in October rather than April.
You may easily compensate for this by aligning your list of options with the
start month of your fiscal year.

=CHOOSE(MONTH(B3),2,2,2,3,3,3,4,4,4,1,1,1)

Returning a fiscal month from a date

The operationally recognized months in certain companies do not begin on
January 1st and conclude on December 30th or 31st. Instead, they use
precise dates to designate the start and conclusion of each month. For
example, you may work for a company where each fiscal month begins on
the 21st and finishes on the 20th of the following month. These businesses
must be able to convert a standard date into their fiscal months.

In this case, we're computing the fiscal month, which begins on the 21st of
the month and ends on the 20th of the next month. The following is the
formula in cell C3:

=TEXT(EOMONTH(B3-20,1),"mmm")

In this method, we start with our current date (in B3) and subtract 20 days
to travel back 20 days. Then we use that updated date in the EOMONTH
function to calculate the final day of the next month:

EOMONTH(B3-20,1)



The resultant date is then wrapped in a TEXT function to format it
into a three-letter month name:

TEXT(EOMONTH(B3-20,1),"mmm")

Calculating the date of the Nth weekday of the month

Understanding the dates of certain occurrences is necessary for many
analytical techniques. For instance, if payroll processing takes place on the
second Friday of each month, knowing which days in the year correspond
to the second Friday of each month is helpful.

You can create dynamic date tables that automatically give you the essential
dates you require using the date methods presented so far in this chapter.

For each month indicated in this table, formulae determine the Nth
weekday. Fill in the years and months you want, and then tell it how many
occurrences of each weekday you require. In this case, cell B2 indicates that
we're seeking for each weekday's second occurrence.

The following formula is found in cell C6:

=DATE($A6,$B6,1)+C$4-WEEKDAY(DATE($A6,$B6,1)+($B$2-
(C$4>=WEEKDAY(DATE *7

Given a specified week number and frequency, this method uses simple
algebra to determine which day within the month should be returned.

Simply enter the years and months you want to target in fields A6 and B6 to
utilize the table. Then, in column B2, change the number of occurrences
you need.

Enter a 1 in cell B2 and look in the Monday column if you're searching for
the first Monday of each month. Enter a 3 in cell B2 and look in the
Thursday column to get the third Thursday of each month.

Calculating the date of the last weekday of the month

Simply create a dynamic date table using the techniques discussed so far in
this chapter to automatically supply you with the last occurrence of a
specific weekday.



The following formula is found in cell C4:

WEEKDAY(DATE($A4,$B4+1,C$2) =DATE($A4,$B4+1,1)

Given a year, month, and week number, this method uses simple algebra to
determine which day within the month should be returned.

Simply enter the years and months you want to target in fields A4 and B4 to
utilize the table. The aim is to utilize this table in your Excel models as a
source of dates that you can connect to or just copy from.

Portioning out a time

Isolating a particular time period is usually advantageous. Excel provides a
fundamental set of tools for breaking down time into its component parts.

 

The actions are as follows:

• The HOUR function separates out the hour portion of a time value.

• The MINUTE function separates out the minute portion of a time value.

A function called SECOND can be used to get the second half of a given
time value.

These are quite simple operations. The current hour is represented as a
number between 0 and 23 that is generated by the HOUR function. This
formula yields the number 6.

ONE HOUR ("6:15:27 AM")



The MINUTE function produces a number ranging from 0 to 59 that
represents the minutes of a given time. This formula yields a result of 15.

=ONE MINUTE ("6:15:27 AM")

The SECOND function produces a value between 0 and 59, which
represents the number of seconds in a given time. The result of this formula
is 27.

SECOND = ("6:15:27 AM")

Calculating elapsed time

Calculating the elapsed time, or the number of hours and minutes between a
start and an end time is one of the most typical computations done using
time data.

A list of start and finish timings, as well as computed elapsed times, is
shown in the table. Cell D4 has the following formula:

=IF(C4 B4, 1 + C4 - B4, C4 - B4) =IF(C4 B4, 1 + C4 - B4, C4 - B4)



To calculate the elapsed time between two times, just subtract the start and
finish times. However, there is a catch. If the end time is smaller than the
start time, you must assume the clock has been operating for the whole 24-
hour period, thus looping the clock backward.

In these circumstances, you must double the time by one to reflect on a
complete day. This prevents you from having negative elapsed times.

We utilize a Whether function in our elapsed time calculation to see if the
end time is smaller than the start time. If this is the case, we must add a 1 to
our basic subtraction. If it isn't the case, we may just subtract.

=IF(C4 B4, 1 + C4 - B4, C4 - B4) =IF(C4 B4, 1 + C4 - B4, C4 - B4)

Rounding time values

It's common to need to round time to a certain increment. If you're a
consultant, for example, you may want to round up to the next 15-minute
increment or down to 30-minute increments all the time.



Cell E4 has the following formula:

=ROUNDUP(C4*24/0.25,0)*(0.25/24)

Cell F4 has the following formula:

=ROUNDDOWN(C4*24/0.5,0)*(0.5/24)

By multiplying a time number by 24, sending it through the ROUNDUP
function, and then dividing the result by 24, you may round a time value to
the closest hour.

This formula, for example, would yield 7:00:00 AM:

=ROUNDUP ("6:15:27"*24,0)/24

Simply split 24 by 0.25 to get to 15-minute intervals (a quarter). This
formula would provide the following result at 6:30 a.m.:

=ROUNDUP ("6:15:27"*24/0.25,0) *(0.25/24)

Divide 24 by 0.5 to get to 30-minute intervals (a half). 6:00:00 AM
would be returned by this formula:

=ROUNDDOWN ("6:15:27"*24/0.5,0) *(0.5/24)

Converting decimal hours, minutes, or seconds to a time

It's fairly unusual to get a feed with timings recorded in decimal hours from
an external source. For example, instead of the typical 1:30, you'll see 1.5
for 1 hour and 30 minutes. By dividing the decimal hour by 24 and
presenting the result as a time, you can easily remedy this.



When you divide a decimal hour by 24, you get a decimal that Excel
understands as a time value.

Divide the number by 1440 to convert decimal minutes to time. 1:04
(one hour and four minutes) is the result of this formula:

=64.51/1440

Divide the value by 86400 to convert decimal seconds to the time. 0:06
(six minutes) will be returned by this formula:

=390.45/86400

Adding hours, minutes, or seconds to a time

You can put two-time values together to generate a cumulative time value
since time values are only a decimal extension of the date serial number
system. You may wish to add a certain number of hours and minutes to an
existing time value in various instances. You may utilize the TIME function
in these instances.

We're going to add 5 hours and 30 minutes to all of the timings in this
example.

The TIME function takes three arguments: hour, minute, and second, and
generates a time value on the fly.

This formula, for instance, would produce the time value 2:30:30 PM:

=TIME (14,30,30)



Simply use the TIME function to create a new time value and then add
them together to add a specified number of hours to an existing time value.

This formula adds 30 minutes to the current time, yielding a 3:00 PM
time value:

+ TIME="2:30:00 PM" + TIME="2:30:00 PM" + TIME="2:30:00 PM" (0,
30, 0)

 

 

 

 

 

 



CHAPTER 5
CONDITIONAL ANALYSIS IMPLEMENTING

FORMULAS
Conditional analysis can be carried out using a number of worksheet functions in Excel. Several of
those features will be used in this section. Depending on whether or not a set of criteria is met,
different actions can be taken using conditional analysis.

Conditional Analysis: An Overview
A condition is a value that, when TRUE or FALSE, results in TRUE or FALSE. Depending on how
the condition is evaluated, a formula may branch into two separate calculations. When the condition
evaluates TRUE, only one object or phrase is considered, leaving the other out. With a FALSE
condition, the formula's direction of flow is reversed, and the first value or expression is ignored
while the other is considered.

 Verifying a straightforward condition is met
The table below shows a list of states and six-month gas prices. Say you want to compare each price
to the national average for that month to determine whether it is greater or cheaper. For prices that are
more or lower than average, you should report "High" for higher prices and "Low" for lower prices.
A grid will be used to present the findings beneath the data.

=IF(C3>AVERAGE(C$3:C$11),"High”, “Low")

The IF function in Excel is the most fundamental conditional analysis
function. The condition, what to do if the condition is true, and what to do if
the condition is false are the three arguments.

C3>AVERAGE(C$3:C$11) is the condition parameter in this case.
Condition parameters must be designed to return TRUE or FALSE, which



typically involves using a comparison operation (like as equals or greater-
than). The greater-than sign in the example condition calculates the amount
in C3 to the average of all the values in C3:C11.

The second parameter of the IF function is returned to the cell if our
condition argument returns TRUE. The second argument is High, and
because the number in C3 is higher than the average, the word High appears
in cell C14.

The value in C4 is compared to the average in cell C15. The condition
argument returns FALSE since it is lower, and the third argument is
returned. Low, the third parameter of the IF function, is seen in cell C15.

Multiple conditions are being checked

Simple circumstances can be connected in a chain. They are known as
nesting functions. To the value if true and value if false parameters, simple
conditions may be applied. This enables you to test various assumptions,
each of which depends on the preceding one.

Two ranges of the attributes are displayed underneath the user input fields.
If the user chose a coupe, sedan, truck, or SUV when choosing the kind and
property, we want a formula to show which one they chose.

=IF (E2="Car”, IF(E3="2-door","Coupe","Sedan"),IF(E

The outcome of the first condition leads the second condition to change in
certain conditional analyses. If the first requirement is Car, the second



condition is 2-door or 4-door in this instance. If the first condition is Truck,
however, the second criterion becomes Has Bed or No Bed.

You've seen that the IF function in Excel can be used to do conditional
analysis. When you need to check several conditions, you can nest IF
functions by passing another IF function as a parameter to the first IF
function. The first IF in this example verifies the value of E2. The second
input is an IF formula that verifies the value of cell E3 rather than returning
a value if TRUE. Similarly, the third parameter comprises a third IF
function that evaluates cell E3 in addition to returning a result of FALSE.

Because E2 does not equal Car, the first IF yields FALSE, and the FALSE
argument is processed. E3 is observed to be equal to Has Bed in that
argument, and the TRUE condition (Pickup) is returned. The FALSE
condition (SUV) would have resulted if the user had chosen No Bed.

Confirming conditional data

To fill out the user input fields, data validation lists are employed. The user
may select from a drop-down box instead of entering data. By using an
INDIRECT function to update its list in response to the value in Cell E2,
Cell E3's data validation takes an unusual approach.

Two defined ranges can be found on the spreadsheet. In comparison to the
Truck range, the Car range points to E6:E7, and vice versa. As with the E2
data validation list options, the names are the same. The source is a function
that is INDIRECT when E2 is used as a parameter.



The INDIRECT function takes a text parameter and converts it to a cell
address. Because E2 is Truck in this example, the formula becomes
=INDIRECT ("Truck"). INDIRECT delivers a reference to E10:E11 since
Truck is a named range, and the values in those cells become the options.
INDIRECT would return E6:E7 if E2 contained Car, and those values
would be the options.

When the value in E2 is modified, the value in E3 does not change, which is
an issue with this form of conditional data validation. The options in E3
change, but the user must still choose from the available options or your
calculations will provide incorrect results.

Looking up values

Your formulae grow lengthy and difficult to maintain if you use too many
nested IF functions. The results are inserted into the cells adjacent to their
attributes, rather than being hard-coded in nested IF functions (for example,
Sedan is entered in the cell next to 4-door).



The following is the updated formula:

=IF
(E2="Car",VLOOKUP(E3,E6:F7,2,FALSE),VLOOKUP(E3,E10:F11,2,FA
LSE))

This formula may now be utilized to get the car back to you. The IF
condition remains the same, but a TRUE result now searches up the correct
value in E6:E7, and a FALSE result looks it up in E10:F11.

Determining if both conditions 1 and 2 are satisfied

In addition to nested conditional functions, they can be evaluated
collectively within an AND function. When two or more criteria need to be
evaluated simultaneously, this is crucial for figuring out where the formula
should branch.

In the table below, you can see a list of inventory goods, their prices, and
the discounts that are applied when they are sold. The inventory items have
three divisions, which are separated by hyphens. The item's department is
the first condition, followed by a second condition indicating whether it is a
component, a subassembly, or a finished assembly, and a third condition
being a special four-digit number. A 10% discount will only be applied to
items in Department 202 that are final assembly. Other products are not
subject to any discounts.

=IF(AND(LEFT(B3,3)="202",MID(B3,5,3)="FIN"),10



The IF function gives a 10% return if TRUE and a 0% return if FALSE. If
both the first and second portions of the item number are 202, your
expression for the condition parameter (the first argument) must return
TRUE. Excel's AND function makes this possible. The AND function
accepts comma-separated parameters of up to 255 bits each. Logical
arguments are statements that can only result in TRUE or FALSE. In this
case, there are only two logical arguments employed.

When the first three characters of B3 are equal to 202, the first logical
argument, LEFT(B3,3)="202," returns TRUE. The second logical
argument, MID(B3,5,3)="FIN," returns TRUE if the first three integers are
equal to FIN.

 

functions for text manipulation

The AND function can only return TRUE if all of its logical parameters are
TRUE. Any logical input that returns FALSE causes the AND function to
return FALSE.

Because the first three characters of the item number are 202, the first
logical condition in cell D3 returns TRUE. Because the center portion of the
item number is PRT, not FIN, the second logical condition yields FALSE. A



TRUE and a FALSE condition both yield FALSE, and the outcome is 0%.
In contrast, cell D5 returns TRUE since both logical requirements are true.

Referring to logical conditions in cells

Two logical criteria that evaluate TRUE or FALSE are included in the AND
function. Cells may be referenced in AND arguments as long as they
evaluate to TRUE or FALSE. When using the AND function in a formula,
it's a good idea to separate the logical conditions into their cells. Two more
columns are added to the inventory listing. These columns may be
examined to see whether a certain item is eligible for a discount or not.

The outcome does not change as a consequence of these changes, but the
formula does.

=IF(AND(D3,E3),10%,0%)

Checking if Condition1 OR Condition2 are met

Certain goods received a discount depending on their item number. In this
case, we'd want to increase the number of goods that qualify for the
discount. Only final assembly items will be eligible for the discount, as
previously, but the departments will be enlarged to include both
departments 202 and 203.



=IF(AND(OR(LEFT(B3,3) ="202”, LEFT(B3,3) ="203"),

To cater to the changes in the discount system, we've added a conditional
parameter to the IF function. Because all of the inputs must be TRUE for
AND to return TRUE, it is a restrictive function. The OR function, on the
other hand, is inclusive. If any of the parameters is TRUE OR returns
TRUE for the whole function. We've nested an OR function inside the AND
function and made it one of the parameters in this example.

Cell D9 depicts a previously undiscounted product that now qualifies for
the new scheme's discount. Because one of its arguments returns TRUE, the
OR section, OR(LEFT(B9,3) ="202”, LEFT(B9,3)="203"), returns TRUE.

Making conditional computations

Typically, simple conditional methods like IF only affect one value or cell at
a time. Two conditional methods in Excel that can be used to aggregate data
are summing and average.

You'll discover some of the techniques for performing calculations based on
a set of parameters in this section.

adding up all values that satisfy a particular criterion

The table displays a list of accounts with both positive and negative values.
To ensure that they are equal, we will add up all the negative balances and
compare them to the sum of all the positive balances. To sum numbers
based on a condition, use Excel's SUMIF function.

=SUMIF(C3:C12,"<0")



Each value in C3:C12 is compared to the condition by SUMIF. If the
amount is less than zero, it fulfills the requirement and is added to the total.
The value is disregarded if it is zero or more. Blank cells and text values are
likewise disregarded. Cell C3 is assessed first in this case. It is disregarded
since it is bigger than zero. Cell C4 is then assessed. It gets added to the
total since it fits our requirement of being less than zero. This is repeated
for each cell. Cells C4, C7, C8, C9, and C11 are included in the total after
it's finished, but the rest aren't.

SUMIF's second argument, the condition to be satisfied, is surrounded by
quotations. We need to generate a string to represent the phrase since we're
using a less-than sign in this case.

The sum range is an optional third input to the SUMIF function. We've been
applying the condition to the numbers we've been summing so far. We may
sum a set of numbers but apply our criteria to a separate set of numbers by
utilizing the third parameter. Use the formula =SUMIF to add up the sales
for the East region (B2:B11, "East", C2:C11).

Summing greater than zero

=SUMIF (C3:C12,">0") is the formula for that computation. The
expression string is the sole difference here between the formula and our
example formula. This formula uses ">0" as the second input instead of
"0."



Because we're summing, and zero never modifies a total, we don't need to
include zero in our computation. We couldn't just use "1000" and ">1000"
as our second arguments if we wanted to sum numbers larger or less than
1,000 since we'd never include anything that was precisely 1,000.

Make the greater than a greater than or equal to, such as ">=1000," or the
less than a less than or equal to, such as "=1000," when using more than or
less than a nonzero value in a SUMIF. Instead of using the equal sign for
both, use just one. This ensures that any values that are precisely 1,000 are
included in one of the calculations but not both.

It may be difficult to remember the syntax required to utilize your
comparison operators.

In the second parameter, you may use the TODAY function (to retrieve the
current date) or most other functions. Use the formula
=SUMIF(B3:B11,TODAY(),C3:C11) to sum a range of values that
correspond to today. Concatenate the less-than-or-equal-to sign to the
function, such as =SUMIF(B3:B11,"="&TODAY(),C3:C11), to sum only
those numbers that are today or earlier.

In the condition parameter to SUMIF, you may use one of two wildcard
characters. The asterisk (*) indicates zero, one, or any number of characters,
whereas the question mark (?) represents any single character.
=SUMIF(B2:B11,"?o*", C2:C11) sums all values in C2:C11 that match to
values in B2:B11 where the second letter is a lowercase o. Because both the
North and South contain a lowercase o as the second letter while the East
does not, if we apply that formula to the data, we will receive the total for
sales in both areas.



Adding up all figures that fall under two or more conditions
SUMIF has the limitation that it only functions under one condition. The SUMIFS function can be
used when many conditions are necessary.

The table lists a select group of countries from 2000 to 2009 along with their GDP (GDP). We want
to sum the GDP of Brazil from 2003 to 2006. When two or more requirements must be met, like in
this case, Country and Year, the SUMIFS worksheet function in Excel is used to sum data.

=SUMIFS(D3:D212,B3:B212,G3,C3:C212,">="&G4,C3



The SUMIFS parameters begin with the range containing the value to be
summed. The remaining parameters are in pairs, with criteria range, criteria
as the pattern. SUMIFS will always have an odd number of arguments due
to the way the arguments are written out. The first criterion pair is essential;
SUMIFS would be the same as SUM if it didn't have at least one condition.
The remaining condition pairings, which may total up to 126, are optional.

=SUMIFS(D3:D212,B3:B212,G3,C3:C212,">="&G4,C3:C212,"<="&G5)

Each cell in D3:D212 is added to the total only if the equivalent values in
B3:B212 and C3:C212 fulfill the constraints in this example. The B3:B212
criterion is that it must match whatever is in cell G3. Because we need to
identify the bottom and upper bounds of our year range, we have two-year
conditions. Cell G4 has the lower limit, whereas cell G5 has the upper
bound. The year conditions are created by concatenating the two cells with
more than or equal to and less than or equal to, respectively. The value is
only included in the total if all three requirements are met.

Summing if values fall between a given date range

Adding or subtracting several SUMIF computations is one technique to
utilize SUMIF with two or more criteria. This is a good technique to



employ multiple conditions if the two conditions operate on the same range.
When you wish to test various ranges, the formulae get more complicated
since you must avoid double counting numbers.

The total of the data between June 23 and June 29, inclusive, is what we're
looking for. Cells F4 and F5 will be used to record the start and end dates,
respectively.

=SUMIF(B3:B20,"<="&F5,C3:C20) -SUMIF(B3:B20,"

To reach the required result, this approach subtracts one SUMIF from
another. SUMIF(B3:B20,"="&F5, C3:C20) gives the total of the values less
than or equal to the date in F5, which in this case is June 29. The less-than-
or-equal-to operator is concatenated with the cell reference F5 as the
conditional argument. The result would be 5,962.33 if it was the whole
formula. However, only values greater than or equal to June 23 are
acceptable. That is, we want to exclude our numbers lower than June 23.
This is accomplished in the second SUMIF. To find the total of values
between the two dates, add everything less than or equal to the later date
and remove everything less than the older date.

Using SUMIFS

You could even find SUMIFS easier to use than the subtraction method.
The formula =SUMIFS(C3:C20,B3:B20,"="&F5,B3:B20,">="&F4) adds
the values in C3:C20 that match the criteria pairs to the values in B3:B20.
The first criterion pair, "="&F5, is the same as the first SUMIF criteria. The
second set of criteria restricts dates to those that are larger than or equal to
the commencement date.

Getting a count of values that meet a certain condition

In Excel, aggregation isn't limited to summing values. Excel has methods
for conditionally counting values in a range, similar to SUMIF and
SUMIFS.



From 2000 to 2009, a limited list of nations and their gross domestic
product is available. We're curious how many times the GDP was larger
than or equal to one million dollars. Cell G3 will contain the criteria that
will be used.

=COUNTIF(D3:D212,G3)

The COUNTIF function is comparable to the SUMIF function. The
apparent distinction, as the name implies, is that it counts rather than sums
items that fit the requirements. Another distinction is that, unlike SUMIF,
there is no optional third parameter. You may use SUMIF to sum a range
that isn't the same as the range to which the condition is applied. That
wouldn't work with COUNTIF since counting a different range would
provide the same result.

The criterion argument in this formula is constructed using a slightly
different method. Rather than in the function's second parameter, the string
concatenation happens entirely in cell G3. Instead of merely pointing to G3,
the second argument would look like ">=1000000" or ">="&G3 if we had
done it the same way as SUMIF. It's also worth noting that the formula in
G3, =">="&106, calculates 1 million using the exponent operator, or a caret
(). Using the caret to represent huge numbers may help you avoid problems
caused by miscounting the number of zeros you wrote.



Counting values that satisfy two or more criteria

The SUMIF function has a cousin called COUNTIF. Without
simultaneously developing COUNTIFS for counting them, Microsoft could
not have introduced

 SUMIFS for summing multiple conditions.

Here is a list of the 1972 Winter Olympics Alpine Skiing medal winners.
How many silver medalists' last names begin with the letter ö? Enter the
letter we're looking for in cell I3 and the type of medal in cell I4.

=COUNTIFS(C3:C20,"*"&I3&"*",F3:F20,I4)

Like in SUMIFS, the criteria range and criteria arguments occur in pairs.
COUNTIFS always has an even number of parameters, but SUMIFS always
has an odd number.

The list of athlete names in C3:C20 is the first criteria range parameter. The
"*"&I3&"*" matching criteria argument encircles whatever is in I3 with
asterisks. In COUNTIFS, asterisks are wildcard characters that can
represent zero, one, or more characters of any kind. We're telling Excel to
count all of the names that have that character anywhere in the name by
using an asterisk both before and after the character. That is, we don't mind
whether there are zero, one, or more characters before ö, or if there are zero,
one, or more characters following ö as long as that character appears
somewhere.

In the second criteria range, the criteria argument pair counts the number of
SILVER items in F3:F20 (the value typed into I4). Only rows in which both
the first and second argument pairs match (only rows in which the athlete's
name includes the letter ö and the medal won was silver) are counted. In
this case, Gustav Thöni took silver in the Men's Slalom, while Annemarie
Moser-Pröll finished third in both the Women's Downhill and the Women's
Giant Slalom.

finding unusual characters

The ö was typed into cell I3 by pressing and holding the Alt key while
typing 0246 on the numeric keypad. If you try to type those digits on the



number keys that run across the top of your keyboard, nothing will happen.
The ASCII code 246 is used to represent the letter ö. Every character in this
chapter has an ASCII code.

Cell H8 has a small database of characters and their codes.

I12. =MID($C$8,ROW(),1) obtains the eighth character from the name in
column C8 in cell H8. (The eighth character was randomly chosen.) The
character we were looking for was almost there but not quite.) Until the
character we're seeking for shows up, this method is repeated down a few
rows. We're looking for the person in H10. The anchoring function of the
dollar signs in $C$8 ensures that the cell reference does not change while
the formula is replicated. The ROW() function returns the row of the cells it
is in without taking an argument. As the formula is copied down, ROW()
produces the values 8, 9, and so forth.

The formula =CODE appears in cell I8 (H8). The ASCII code for the letter
supplied is returned by the CODE worksheet function. A capital T is ASCII
code 84, a lowercase I is ASCII code 105, and ö is ASCII code 246 in this
example. With this information, we may hold down the Alt key and input
the code to utilize that character anywhere we wish.

Getting the average of all numbers that meet a certain
condition

After summing and counting, the most common aggregator is taking an
average of a set of numbers. The average is the total of the numbers divided
by the count of the numbers, commonly known as the arithmetic mean.

We only want to look at the average outcome for skiers from Switzerland.
Cell I3 contains the country code, which may be readily changed to another
nation.

=AVERAGEIF(D3:D20,I3,E3:E20)

The AVERAGEIF function in Excel allows us to do exactly what we want.
AVERAGEIF, like its cousin SUMIF, contains a criteria range and a
criterion argument. The range to average is the last argument. In this
example, depending on whether the relevant cell in D3:D20 fits the



requirements, each cell in E3:E20 is either included in or removed from the
average.

The function returns the #DIV/0! error if no rows fit the conditions in
AVERAGEIF.

Getting the average of all numbers that meet two or more conditions

AVERAGEIFS, along with SUMIFS and COUNTIFS, was created by
Microsoft to enable you to average a range of data depending on many
conditions.

The table below provides some results from the 1972 Winter Olympics, as
we continue our research of skiing timings. In this example, we wish to
calculate the average time depending on many factors. Cells I3:I5 are used
to record the nation, gender, and medal. Only the results that match all three
criteria should be averaged.

=AVERAGEIFS (E3:E20,D3:D20,I3,B3:B20,"*"&I4,F3

The structure of the AVERAGEIFS function is identical to that of the
SUMIFS function. The range to average is the first parameter, which is
followed by up to 127 criteria range/criteria arguments.

 The following are the three criterion pairs:

Only the rows with the country code SUI are included in D3:D20, I3.
B3:B20,"*"&I4 only contain rows containing the term Women at the
end of the event name.
Only the rows where the medal is GOLD are included in F3:F20, I5.



The time in the Result column is averaged when all three requirements are
satisfied.

 
 
 
 
 

 

 

 

 

 



CHAPTER 6
APPLICATION OF MATCHING AND

LOOKUPS FORMULAS
This section describes many approaches for looking up a value in a set of
data. LOOKUP, VLOOKUP, and HLOOKUP are three worksheet functions
in Excel that were created specifically for this purpose, but you might find
that they are not enough.

In this section, you'll also look at a variety of lookup scenarios and
alternative approaches that go beyond Excel's built-in lookup features.

Explanation of Lookup Formulas
In order to retrieve a value from a table, a lookup formula searches for a related value. An
appropriate analog is a regular phone book (remember those?). You must first identify the person's
name in order to retrieve their phone number if you want to check up on them.

Nota Bene: A table is any rectangular range of data. The table that results from choosing Insert >
Tables > Table is not need to be a "official" table.

Many Excel functions are useful for creating formulas to look up information in tables.



Using the Lookup Functions in Excel

Excel computations frequently require data to be located in a list or table.
There are various functions in Excel that can be used to search for data
horizontally, vertically, left to right, or right to left. By layering several of
these methods, you may create a formula that looks for the appropriate data
even if your table's layout changes.

Let's find one of the most common ways to use Excel's lookup functions.

Searching for a certain value using the left lookup column

The most crucial information, the material that sets one row apart from
another, is frequently placed in the far-left column in tables. Excel has a
number of lookup functions, but VLOOKUP was made with this exact use
in mind. We wish to use information from this database to fill out a more
straightforward paystub form when an employee's ID is selected.

The user will select an employee ID from a data validation list and enter it
in cell L3. The form of the data will include the name, address, and other
data related to the employee.

In the calculation, the employee's name is retrieved using the VLOOKUP
function. The four inputs of VLOOKUP are lookup value, lookup range,



column, and match. VLOOKUP will look through the first column of the
lookup range until it locates the desired value. Once the lookup value has
been located, VLOOKUP returns the value in the column specified by the
column parameter. In this case, the second input column is where
VLOOKUP pulls the employee's name from.

In this example, FALSE is the final parameter for all VLOOKUP
procedures. Only an exact match will be returned by VLOOKUP if the
match option is set to FALSE, otherwise it will not. If an exact match
cannot be found, VLOOKUP returns N/A#.

Although there are some differences, VLOOKUP is used in the other
formulae as well. Although they use information from a different column,
the address and insurance calculations work in the same way as the method
for the employee's name. In the payment formula, two VLOOKUPs are
employed, and one of them is divided by the other.

The employee's annual salary is taken from the fifth column, and the pay
for one paystub is calculated by dividing it by the frequency from the fourth
column.

The percentage from the eighth column is taken by the retirement
calculation and multiplied by the gross wage to determine the deduction.
The tax formula then divides the gross salary by the tax rate, which is found
using VLOOKUP in the sixth column, after deducting insurance and
retirement from the total.

Of course, payroll calculations are more complicated, but once you know
how VLOOKUP works, you can create more sophisticated models.

Searching for a certain value using any lookup column
It's possible that not all tables will include the value you want to look for in the leftmost column.
Thankfully, Excel offers several options for retrieving values that are to the right of the value you are
looking for.

Our stores are located in the cities and states listed in the table below. We want to return the city and
store number when a user selects a state from a drop-down menu.



=INDEX(B3:D25, MATCH(G4,C3:C25,FALSE),1)

=INDEX(B3:D25,MATCH) =INDEX(B3:D25,MATCH) =INDEX(B3:D
(G4,C3:C25,FALSE),

The INDEX function returns the value of a range's first row and column.
We provide it with our table of stores, a row parameter in the form of a
MATCH function, and a column number in this example. We want the first
column for the City formula, thus the column argument is 1. We want the
third column for the Store formula; thus, the column argument is 3.

The row and column in the spreadsheet will not match the row and column
in the spreadsheet unless the range you choose begins in A1. They only
apply to the range's top-left cell, not the whole spreadsheet. The value in
cell H3 would be returned by a formula like =INDEX(G2:P10,2,2). In the
range G2:P10, cell H3 is in the second row and second column.



The MATCH function's second input can only be a one-row tall or one-
column wide range. MATCH returns the #N/A error if you provide it with a
rectangle-shaped range.

We utilize the MATCH function to find the relevant row. The place in the
list where the lookup value is located is returned by the MATCH function.
It is supported by three reasons.

Lookup value: the value we're looking for.
Lookup array: A single column or row in which to look.
Match type: Set this option to FALSE or 0 for exact matches only.

The state in cell G4 is the value we're searching for in the range C3:C25,
which is our list of states. MATCH searches the whole range for NH.
INDEX uses 12 as the row parameter because it finds it in 12th place.

INDEX now has all it needs to return the correct value, thanks to MATCH.
It moves to the 12th row of the range and extracts the value from either the
first (for City) or third (for Store #) column.

INDEX returns the #REF! error if you supply it with a row number that is
more than the number of rows in the range or a column number that is
greater than the number of columns in the range.

Looking up values horizontally

If your lookup value is in the first row rather than the first column, and you
want to seek data along the rows rather than across the columns, Excel
provides a function just for you.

You'll restore the temperature to the cell right below it once the user selects
a city from a drop-down box.

=HLOOKUP(C5,C2:L3,2,FALSE)

The parameters for the HLOOKUP function are the same as for
VLOOKUP. The letter H in HLOOKUP stands for "horizontal," whereas
the letter V stands for "vertical." HLOOKUP searches across the first row
instead of down the first column for the lookup value parameter. It gives a
value from the second row of the matching column when it detects a match.



Hiding errors returned by lookup functions

At this time, we've used FALSE as the final parameter in our search
routines to ensure that only precise matches are returned. The #N/A error is
returned when we demand a lookup function to deliver an exact match and
it can't locate one.

In Excel models, the #N/A error is beneficial since it warns you when a
match cannot be found. However, you can be reporting on all or part of
your model, and #N/As are unattractive. Excel offers features that may
detect problems and deliver different results.

The other list includes the names of CEOs as well as their compensation.
The two tables are joined using the VLOOKUP function. However, we do
not have pay data for all of the CEOs, and there are several #N/A
inaccuracies.

=VLOOKUP(C3,$F$3:$G$11,2,FALSE)

The first parameter to the IFERROR function is a value or formula, and
the second argument is an alternative return value. When the first argument
fails, the second argument is used instead. When the first argument does not
return an error, the first argument's results are returned.



We've made our alternative return value an empty string in this case. This
maintains the report looking neat. You may, however, return whatever value
you choose, such as "No information" or zero.

Note: #N/A, #DIV/0!, and #VALUE is among the errors that Excel may
produce and the IFERROR function checks for them all. It's worth noting
that you can't choose which faults IFERROR will capture.

There are three more error catching functions in Excel:

If any error is returned by its argument, ISERROR returns TRUE.
If its argument returns any error other than #N/A, ISERR returns
TRUE.
If the input returns #N/A, ISNA returns TRUE; otherwise, including
other failures, it returns FALSE.

All of these error-trapping methods return TRUE or FALSE, and they're
usually used with an IF function.

The process of selecting the closest match from a list of banded
values

The VLOOKUP, HLOOKUP, and MATCH functions allow the data to be
sorted in any direction. Each of them has a final parameter that requires the
function to try for an exact match or, if it is unsuccessful, to return an error.

If you only need a close match, you may also apply these techniques on
sorted data. The withholding table contains bands of values rather than
every possible value that could be. The employee's pay band must first be
determined, then the withholding in column D16 must be calculated using
the information from that row.

=VLOOKUP(D15,B3:E10,3,TRUE)+(D15-

 



To extract three pieces of data from the table, the formula employs three
VLOOKUP functions. Each VLOOKUP formula's last input is set to
TRUE, indicating that we only want a close match.

When using a final parameter of TRUE, the data in the lookup column must
be sorted from lowest to highest to produce the right result. When the next
value is greater than the lookup value, VLOOKUP stops looking down the
first column. It finds the biggest value that isn't greater than the lookup
value in this manner.

A lookup function that finds an approximate match does not locate the
closest match. Rather, if the next highest value is closer to the lookup value,
it finds the greatest match that isn't bigger than the lookup value.

You won't receive an error if the data in the lookup column isn't ordered
lowest to highest, but you'll almost certainly get an inaccurate result. To
discover an approximate match, the lookup routines perform a binary
search.

A binary search begins in the lookup column's midpoint and decides
whether the match will be in the first or second half of the values. Then it
divides that half in half and, depending on the middle value, looks ahead or



backward. This procedure is continued until the desired outcome is
obtained.

Unsorted values may lead the lookup function to pick the incorrect half to
look in and return bad data in a binary search.

Because 1,023 is the greatest number in the list that isn't bigger than our
lookup value of 2,003.89, VLOOKUP stops at row 5.

The formula's three portions function as follows:

The first VLOOKUP returns 69.80, which is the base amount in the
third column.
The second VLOOKUP subtracts the total wages from the "Wages
over" amount.
The fourth-column percentage is returned by the last VLOOKUP.
The result of multiplying this percentage by the "extra wages" is
added to the current amount.

The formula computes as follows when all three VLOOKUP functions
are evaluated:

15.0 percent =69.80 + (2,003.89 – 1,023.90)

The lookup routines employ a significantly quicker way to discover an
approximate match than an exact match. The function must check each
value in the lookup column for an exact match. Setting the last option to
TRUE reduces computation time if you know your data will always be
ordered lowest to highest and will always include an exact match. If an
exact match exists and the data is sorted, an approximate match search will
always discover it.

The INDEX and MATCH functions are used to find the closest
match.

All of our lookup formulas, including the INDEX and MATCH
combination, are interchangeable. Similar to VLOOKUP and HLOOKUP,
MATCH offers a conclusion that is used to identify approximations.
Additionally, data that is ordered from highest to lowest can be used with
MATCH.



The table's VLOOKUP-based calculation yields #N/A, as seen in cell D16.
This is because VLOOKUP only examines the data that is present before
the middle value of the lookup column when it determines that it is greater
than the lookup value. Since our data is ordered ascendingly, the middle
value is the only value that comes before any values lower than the lookup
value.

Cell D18's INDEX and MATCH formula yields the right answer, as
demonstrated here:

=INDEX(B3:E10,MATCH(D15,B3:B10,-1)+1,3)+(D15-
INDEX(B3:E10,MATCH(D15,B3:B10,-1)+1,1))

*INDEX(B3:E10,MATCH
(D15,B3:B10,-1)+1,4)*INDEX(B3:E10,MATCH
(D15,B3:B10,-1)+1,4)*INDEX(B3

MATCH's last argument might be 1, 0, or 1.

For data that is ordered from highest to lowest, 1 is utilized. It
retrieves the lowest number bigger than the lookup value in the
lookup column. There is no VLOOKUP or HLOOKUP comparable
technique.
For unsorted data, 0 is utilized to locate the precise match. It's the
same as putting FALSE as the last parameter of VLOOKUP or
HLOOKUP.
For data that is ranked from lowest to highest, 1 is utilized. It
determines the lookup column's biggest value that is less than the
lookup value. It's the same as setting TRUE as the last parameter of
VLOOKUP or HLOOKUP.

MATCH finds a value that is bigger than the lookup value with a final
parameter of 1, and the formula adds 1 to the result to obtain the correct
row.

Looking up values from multiple tables

Depending on the user's decision, the data you wish to look up may
originate from many tables. A comparable computation is a withholding



calculation. The user may choose whether the employee is a bachelor or
married, which is a significant distinction. If the user selects Single, the
information is retrieved from the single-person database; if the user selects
Married, the information is retrieved from the married table.

To guide our search to the correct table in Excel, we may utilize named
ranges and the INDIRECT function. We need to identify two ranges before
we can create our formula: Married for the married-person table and Single
for the single-person database.

To create the specified ranges, follow these steps:

1. Choose the B4:E11 range.
2. From the Formulas tab on the Ribbon, choose Define Name.
3. Select Married in the Name box.
4. Select OK.
5. Choose the B15:E22 range.
6. On the Ribbon, select Define Name from the Formulas option.
7. Select Single in the Name box.
8. Select OK.

In cell D25, there is a data validation drop-down menu. The phrases
Married and Single, which is similar to the names we just made, are
available in the drop-down box. The value in D25 will be used to identify
which table we should search at, thus the values must be similar.



The following is the new formula for calculating the withholding:

=VLOOKUP(D29,INDIRECT(D25),3,TRUE)+(D29-
VLOOKUP(D29,INDIRECT(D25),1,TRUE)+(D29-
VLOOKUP(D29,INDIRECT(D25),1, TRUE)

*VLOOKUP(D29,INDIRECT(D25),4,TRUE)



This example's formula is surprisingly similar to the previous one. The only
change is that instead of the table's location, an INDIRECT function is
utilized.

The ref text parameter is sent to INDIRECT. A text representation of a cell
reference or a named range is provided by the ref text parameter.
INDIRECT tries to translate this into a cell or range reference. If the ref text
is not a valid range reference, as it is in our situation, INDIRECT looks for
a match in the listed ranges. INDIRECT would have returned the #REF!
error if we hadn't previously defined a range called Single.

INDIRECT has a1 as a second optional parameter. If ref text is in the A1
style of cell references, the a1 argument is TRUE, and if ref text is in the
R1C1 style of cell references, it is FALSE. A1 may be TRUE or FALSE for
specified ranges, and INDIRECT will return the right range.

Ranges from other worksheets or even workbooks may be returned using
INDIRECT. If it refers to another worksheet, however, that workbook has
to be open.

Looking up a value based on a two-way matrix

A rectangular range of cells makes up a two-way matrix. It's a range having
more than one row and more than one column, in other words. We've
utilized the INDEX and MATCH combination as a substitute for some of



the lookup functions in other formulae. INDEX and MATCH, on the other
hand, were designed for two-way matrices.

Each column represents a year, and each row represents an area. The user
should be able to pick an area and a year, and the sales figure should be
returned at the intersection of those two rows and columns.

=INDEX(C4:F9,MATCH(C13,B4:B9,FALSE),MATCH(C14,C3

You've probably heard about INDEX and MATCH by now. Unlike other
formulae, the INDEX function has two MATCH functions. Rather than
hard-coding a column number, the second MATCH method returns the
INDEX column parameter.

Remember that MATCH provides the matched value's position in a list.
Because it's the third item in the list, MATCH returns 3 for the North
region. INDEX takes this as the row parameter. The year 2012 is matched
across the header row, and MATCH returns 2 since 2011 is the second item.
The correct value is then returned by INDEX using the 2 and 3 given by the
MATCH methods.

Making use of default values to match
Our sales search methodology will be modified. By changing the algorithm, the user will be given the
option to select just a region, just a year, or neither. If one of the options is left empty, we'll assume
the user wants the sum. The sum of the table as a whole will be returned if neither option is selected.

=INDEX(C4:G10,IFERROR(MATCH(C13,B4:B10,FALSE),COUNTA(B4:
B10)),IFERROR(MATCH(C14,C3:G3,FALSE),COUNTA(C3:G3)))

The formula's general structure hasn't altered, but a few subtleties have.
Row 10 and column G are now included in the INDEX range. The range of
each MATCH function has also been expanded. Finally, an IFERROR
function surrounds both MATCH functions, returning the Total row or
column.

A COUNTA function may be used as an alternative to IFERROR.
COUNTA counts both numbers and text and, as a result, returns the last row
or column in our range. We could have hard-coded those numbers, but
COUNTA will adapt to always return the last one whenever we enter a row
or column.



MATCH returns #N/A because the column headers have no blanks.
IFERROR sends the control to the value if error argument when it detects
that error, and the last column is sent to INDEX.

Calculating a value based on certain criteria

We need a formula that will output the budget when the user selects a
department and an area. We are unable to use VLOOKUP for this
computation since it only supports a single lookup value. There are many
instances of the regions and departments, so you'll need two values.

To retrieve the row that has both lookup values, use the
SUMPRODUCT function as follows:

=SUMPRODUCT (($B$3:$B$45=H5)*($C$3:$C$45=H6)*($E$3:$E$45))

SUMPRODUCT compares each cell in a range to a value and, based on the
outcome, outputs an array of TRUEs or FALSEs. TRUE becomes 1 when
multiplied by another array, but FALSE becomes 0. Because that range
comprises the value we wish to return, the third parenthetical part of the
SUMPRODUCT function does not contain a comparison.

The sum for that line will be 0 if either the Region comparison or the
Department comparison is FALSE. Anything times zero equals zero,
therefore a FALSE result is turned to zero. Both comparisons yield 1 if both
Region and Department match. The number returned is the result of
multiplying the two 1s with the matching row in column E.

When SUMPRODUCT reaches row 12, it multiplies 1 * 1 * 697,697 in the
example. That number is added to the other rows, which are all zero since at
least one FALSE is present. 697,697 is the value of the SUM as a result.

SUMPRODUCT is used to return text.

SUMPRODUCT works this manner only when we want to return a number.
All text values will be treated as zero if we want to return text, and
SUMPRODUCT will always return zero.

However, by combining SUMPRODUCT with the ROW and INDEX
techniques, we can obtain text. For instance, the following formula could be



used to find the manager's name:

=INDEX(D:D,SUMPRODUCT(($B$3:$B$45=H5)*($C$3:$C$45=H6)*
(ROW($E$3:$E$45))),1)

The ROW function is always included the row numbers in the array instead
of the values from column E. When it comes to row 12, SUMPRODUCT
now computes 1 * 1 * 12. The row parameter in INDEX is then set to 12 for
the full column D: D. INDEX takes the whole column as its range since the
ROW function returns the row in the worksheet rather than the row in our
table.

How to determine a column's latest value

We're searching for the last invoice on the list. It is simple to get the last
item in the column by counting the items in the list and using the INDEX
function to find the last row.

=INDEX(B:B,COUNTA(B:B)+1)

When used on a single column, the INDEX function only requires a row
parameter. The third parameter indicates that the column isn't required.
COUNTA is used to count the cells in column B that are not blank. Because
there is a blank cell in the first row, the count is incremented by one.
Column B's 12th row is returned by the INDEX function.



COUNTA counts anything except blanks, including numbers, text, and
dates. COUNTA will not yield the required result if your data contains
blank rows.

Using LOOKUP, determining the final number

INDEX and COUNTA assist in locating values when there are no empty
cells in the range. If there are blanks along with the values you're searching
for, you can use LOOKUP and a very large number.

D:D =LOOKUP(9.99E+307)

The maximum number that Excel can handle is the lookup value. The result
is returned because LOOKUP defaults to the last value it finds because it
can't find a value this large.

A number such as 9.99E+307 is written in exponential notation. The
number that comes before the letter E has two numbers to its right and one
number to its left. The number that comes after the letter E specifies how
many decimal places need to be dropped in order to write the number
normally. If the number is positive, the decimal should be shifted to the
right; if it is negative, it should be shifted to the left. The equivalent of
0.0432 is a value like 4.32E-02.

The last integer is returned by this LOOKUP function regardless of whether
the range contains text, blank spaces, or errors.

 

 

 

 

 



CHAPTER 7
APPLICATION OF FORMULAS TO

FINANCIAL ANALYSIS
When everything was done by hand using paper and pencil, spreadsheets were initially employed in
the accounting and finance departments. Even though Excel has developed much beyond a simple
computerized ledger sheet, it is still an essential tool for business.

This chapter will teach you about some formulas that are frequently used in accounting, finance, and
other business-related fields.

Making Regular Business Calculations
This section is a collection of some of the more well-known financial and business formulas that you
could be asked to create in Excel while working as a business analyst.

Gross profit margin and gross profit margin percentage
calculations

Gross margin is the amount that remains after revenue is subtracted from
the cost of goods sold. It is the portion of revenue that goes toward covering
overhead and other indirect costs. To calculate the gross margin, subtract
the revenue from the total cost of the goods sold. To calculate the gross
margin percent, divide the revenue by the gross margin. The gross margin is
displayed in cell C5 whereas the gross margin % is displayed in cell D5.

=C3-C4 Gross Margin

=C5/$C$3 Gross Margin Percentage

 



Cell C4 is subtracted from cell C3 in the gross margin calculation. The
gross margin % is calculated by dividing C5 by C3, but keep in mind that
the C3 reference is absolute due to the dollar signs. This enables you to
duplicate the formula to other lines on the income statement to calculate the
percentage of revenue, which is a frequent income statement analysis.

Markup calculation

Despite their frequent confusion, the words "markup" and "gross margin
percent" are not the same. Markup is the portion of costs that are increased
to produce a selling price.

The markup is computed by removing one from the sales price after
dividing it by the cost.

=(C3/C2)-1



You generate a 24 percent gross margin by marking up the product's cost by
32 percent.

Use the following formula to mark up a product to generate a 32 percent
profit margin:

=1/(1-E9)-1

If you want your income statement to display a 32 percent gross margin,
you'll need to mark up this product at 47 percent using this method.

Calculating EBIT and EBITDA

EBIT (earnings before interest and taxes) and EBITDA (earnings before
interest, taxes, depreciation, and amortization) are two typical methods for
assessing a company's performance. Both are calculated by subtracting
specific expenditures from profits, resulting in net profit.



The income statement and the results of the EBIT and EBITDA
computations are shown in the table below.

EBIT

=C18+VLOOKUP("Interest
Expense",$B$2:$C$18,2,FALSE)+VLOOKUP("Income Tax
Expense",$B$2:$C$18,2,FALSE)+VLOOKUP("Income Tax
Expense",$B$2:$C$18,2,FALSE)

EBITDA

=C20+VLOOKUP("Depreciation
Expense",$B$2:$C$18,2,FALSE)+VLOOKUP ("Amortization
Expense",$B$2:$C$18,2,FALSE)+VLOOKUP ("Amortization
Expense",$B$2:$C$18,2,FALSE)

The EBIT calculation begins with a net loss in C18 and utilizes two
VLOOKUP functions to extract the interest and income tax expenses from



the income statement. The formula for EBITDA begins with the outcome of
the EBIT calculation and adds back the depreciation and amortization
expenses using the same VLOOKUP approach.

Utilizing VLOOKUP rather than merely using the cell references to those
expenditures has advantages. The EBIT and EBITDA calculations do not
need to be adjusted if the income statement lines are shifted around.

Making a cost-of-sale calculation

The cost of goods sold is the total cost of everything you sold. It plays a
significant role in the gross computation. If you use a perpetual inventory
system, you calculate the cost of goods sold for each sale that is made. For
simpler systems, you might calculate it using a physical inventory after the
accounting period.

The example below demonstrates how to compute the cost of goods sold
using simply the starting and ending inventory counts, as well as the
amount of all inventory acquired throughout the time.

 

Goods Available for Sale

=SUM(C2:C3)

Cost of Goods Sold

=C4-C5



The commodities for sale include the initial inventory as well as any
acquisitions. It's an intermediate computation that displays how much
inventory you'd have at the end of the day if you didn't sell anything.

The ending inventory is subtracted from the products available for sale in
the cost of goods sold calculation. If you had the products at the beginning
of the time or purchased them throughout the term but don't have them at
the end, they must have been sold.

Calculating the asset return

Return on assets (ROA) is a metric that assesses how effectively a business
generates revenue from its assets. For instance, by using fewer or less
expensive assets, a company with a higher ROA may be able to achieve the
same profit as one with a lower ROA.

To calculate ROA, divide the whole earnings by the average of the starting
and ending total assets. The table below includes a simple balance sheet,
income statement, and the resulting ROA.

=G15/AVERAGE (C12:D12)

The numerator is just the income statement's net profit. The AVERAGE
function is used in the denominator to calculate the average total assets for
the time.

How to calculate return on equity

Another widely used indicator of profitability is return on equity (ROE). An
investor may use ROE to determine whether their investment in the
company is being used effectively. Similar to ROA, ROE is computed by
subtracting net profit from the average of a balance sheet item over the
same time. ROE, on the other hand, makes use of average total equity rather
than average total assets. The ROE calculation formula is as follows:

=G15/AVERAGE (C25:D25)

Calculating break-even

A company could wish to figure out how much sales it needs to have a net
profit of precisely $0. This is referred to as break even. The company will



calculate its fixed expenditures as well as the proportion of each variable
expense. It is possible to convert such figures into a revenue amount that
will result in a break-even point.

Column C displays an F for a fixed expenditure or a percentage for a
variable expense as revenue fluctuates. For instance, research and
development will be funded according to a budget that remains constant
regardless of income fluctuations. If the company pays a commission, on
the other hand, the selling costs will fluctuate with income.

The formulae utilized were as follows:

Margin of Operation

=SUM(D15:D18)

Net of Variable Expenses Margin

=SUM(D10:D13)

Gross Profit Margin

=SUM(D7:D8)



Revenue

=ROUND(D8/(1-SUM(C4:C7)),0)

By multiplying the revenue amount by the percentage, the two variable
expenditures, cost of goods sold and selling expenses, are computed.

The following are the formulas:

Cost of Goods Sold

=ROUND(D3*C4,0)

Expenses for Sale

=ROUND(D3*C7,0)

Follow these steps to create the break-even model:

1. To show a zero net profit, enter 0 in column D18.
2. In column D, write the fixed expenditure amounts next to their

designations in column B.
3. In cell C7, enter the commission percentage paid by the firm (8

percent in this example).
4. In column C4, enter a percentage equal to 1 minus the projected

gross margin. In this case, the corporation anticipates a 60 percent
gross margin, hence 40 percent is recorded in C4.

5. In cell D13, put the operating margin formula given before. The total
interest cost and other revenue and expenditure must equal the
operating margin.

6. In column D8, input the margin net of variable expenditures
calculation from the previous step. The operating margin is added to
the fixed operating expenditures in this computation. It will be used
to calculate revenue.

7. In cell D7, type the formula for selling expenditures that were
previously presented. Because we haven't yet input the revenue
formula, this will be 0 for the time being. However, after revenue is
input, the figure will be shown correctly.

8. In column D4, enter the cost of goods sold formula. This will return
0 until revenue is determined, much as the selling expenditures



formula.
9. Finally, in column D3, put the revenue formula. The margin net of

variable expenditures is divided by 1 minus the total of the variable
percentages in the revenue computation. The two variable
expenditures will account for 48 percent of income (40 percent plus
8%). The revenue is calculated by dividing one minus that amount,
52 percent, by the margin net of variable expenditures.

If this firm has a 60% gross margin, pays 8% commissions, and has
appropriately predicted fixed expenditures, it will need to sell $16,935 to
break even.

Estimating customer churn

Customer churn is the term used to describe how many customers you lose
at one time. It's an essential metric for firms that rely on subscriptions, but it
may be applied to other revenue models as well. If you are gaining new
clients faster than you are losing them, this means that your clientele is
growing. If not, you're losing customers more quickly than you're acquiring
them, so something needs to happen.

Both the overall number of clients and the number of new customers at the
beginning and the end of the month are necessary to know.

Subscribers Lost

=C2+C3-C4

Rate of churn



=C6/C2

The number of new customers is added to the number of customers at the
beginning of the month to calculate the number of consumers lost
throughout the month. The sum is then deducted from the number of clients
at the end of the month. Finally, the churn rate is calculated by dividing the
number of customers lost throughout the month by the number of customers
at the start of the month.

In this case, the company's turnover rate is 9.21 percent. Because it is
gaining more consumers than it is losing, churn may not be considered an
issue. If the turnover rate is greater than intended, the organization may
want to look into why customers are leaving and adjust the price, product
features, or other aspects of the business.

Computing the churn rate annually
If a business receives recurring revenue every month, customers sign up
and pay for one month at a time. For these companies, it makes logical to
compute the turnover rate each month. Any new clients obtained throughout
the month won't churn the next month because they've already paid for the
month.

In contrast, a typical magazine asks subscribers to join up for an annual
membership. For them, a useful churn rate estimate would be the annual
rate. The technique alters somewhat if a company needs to calculate a churn
rate for a period longer than its repetitive revenue model, such as yearly
churn for a company with monthly customers. By the quantity of lost
subscribers, the average of beginning and ending subscribers is calculated.
Because the churn rate is different from the recurring revenue period, some
of the 7,415 new members cancelled their memberships within the year,
albeit in a different month than when they first signed up.

The average client lifetime value calculation

Customer lifetime value (CLV) is a metric that measures a customer's
contribution to gross margin over the course of the relationship. The
computed churn rate is one factor that goes into CLV.



How to calculate CLV using the previously identified churn rate is
demonstrated in the example below. As a first step, figure out the average
gross margin per customer.

Gross Profit Margin

=F2-F3

Customer Margin on Average

=F4/AVERAGE(C4,C10)

Customer Value Over Time

=F6/C7

Follow these procedures to compute CLV:

1. Determine the gross profit margin.
2. Divide the gross margin by the average number of clients for the

month to get the average customer margin. Because the gross margin
was obtained over a month, you must divide by the average number
of customers rather than the total number of customers.

3. Divide the average customer margin by the turnover rate to get the
CLV.

In this case, each client will contribute $828.97 throughout their lifetime.

Calculating employee turnover

Employee turnover is a metric for how successfully a company hires and
retains employees. A high turnover rate suggests that the business is not



recruiting or keeping the proper personnel, potentially due to insufficient
perks or poor compensation. Both voluntary and involuntary terminations
are prevalent in separations.

The graph below depicts an organization's employment changes over 12
months. To achieve the ending employee, count, new hires are added and
separations are removed from the number of workers at the beginning of the
month.

Monthly Employment Average

=AVERAGE(F3:F14)

Separations

=SUM(E3:E14)

Employee Attrition

=F17/F16

The ratio of separations to average monthly employment is known as
employee turnover. The AVERAGE function is used to compute the



average monthly ending count of workers. SUM is used to add the
separations, which are then divided by the average monthly employment.

The outcome may be compared to industry averages or similar firms.
Because the turnover rates in various sectors vary, comparing them might
lead to incorrect conclusions. Although you are not required to measure
turnover over 12 months, doing so eliminates seasonal employment changes
that might bias findings.

Leveraging Excel's Financial Functions

It's a reasonable assumption that the most prevalent use of Excel is to do
financial computations. Hundreds of thousands of financial choices are
made every day based on statistics generated on a spreadsheet. These
choices vary from straightforward ("Can I afford a new car?") to more
complicated ("Will buying XYZ Corporation result in positive cash flow
in the next 18 months?").

Converting interest rates



The nominal rate and the effective rate are two typical approaches for
quoting interest rates.

Nominal Interest Rate: This is the stated rate, which is frequently
accompanied by a compounding term, such as 3.75 percent APR
compounded monthly, for example. The nominal rate in this example
is 3.75 percent, APR stands for annual percentage rate (which means
the rate is applied on an annual basis), and the compounding period
is one month.
Rate of Return on Investment: This is the rate that was paid. If the
nominal rate period and the compounding period are the same, the
nominal and effective rates are the same. When interest accumulates
over a shorter time than the nominal rate period, the effective rate is
greater than the nominal rate, as is generally the case.

During a 30-year loan, 12 compounding periods are shown below. The
initial loan amount was $165,000, with a nominal annual percentage rate of



3.75 percent compounded monthly and 30 yearly installments of $9,169.68
each.

The debt increases by the amount of interest for each month in which
interest accumulates but no payment is made. When you make a payment, a
portion of it goes toward the previous month's interest and the rest goes
toward the principle.

To get the effective rate, add all of the interest accumulated during the year
in cell F17 and divide it by the starting amount in cell F18. To convert
interest rates, we don't need to build a whole amortization schedule. To do
this, Excel includes the EFFECT and NOMINAL worksheet functions.

Rate of Return on Investment

=EFFECT(F20,12)

Nominal Interest Rate

=NOMINAL(F23,12)

The rate to be converted and the napery parameter is both sent to EFFECT
and NOMINAL. The effective rate for NOMINAL and the nominal rate for
EFFECT are the rates to be converted. Because the word APR was used, the
nominal rate, in this case, is yearly. Because there are 12 months in a year,
our nominal rate has 12 compounding periods. If you had a debt with a
daily compounded APR, for example, the napery argument would be 365.

Using FV to compute the effective rate

The effective rate can also be determined using the FV function. When you
have a useful function like EFFECT, there is no need to utilize FV, but
knowing how they are related might be helpful.

=FV(3.75% /12,12,0,-1) =FV(3.75% /12,12,0,-1) =FV(3.75% /12,-1

This method subtracts the initial $1 from the future value of a $1 loan
compounded monthly at 3.75 percent for a year. If you took out this loan,
you would have to repay $1.03815 at the end of the year. This implies you'd
owe an extra $0.03815 on top of what you borrowed, or 3.815 percent in
total.



The development of a loan payment calculator

Your monthly loan payment is determined using Excel's PMT worksheet
function. The parameters of the function can be hard-coded with values like
the loan amount and interest rate, but by putting the values in cells and
using the cells as arguments, you can easily change the values to see how
the payment changes.

In C6, the following formula is used to calculate the payment: The user
enters values in the range C2:C4.

=PMT(C3/12,C4*12,C2,0,0)

Three mandatories parameter and one optional argument are sent to
the PMT function:

Calculate your score (required): The annual nominal interest rate
divided by the number of compounding periods in a year is the rate
argument. Because interest accumulates monthly in this case, the
interest rate in C3 is divided by 12.
Napery (required): The napper input specifies the number of
payments to be paid throughout the loan's duration. The number of
years in C4 is increased by 12 since our user input asks for years and
our payments are made monthly.
Photovoltaic (required): The amount being borrowed is represented
by the pv parameter or present value. The loan functions in Excel,
including PMT, operate on a cash flow basis. It's simpler to
comprehend when present value and payments should be positive or
negative when you conceive of them as cash inflows and outflows.
In this case, the bank is lending us $215,000, which is a positive cash
inflow. Because the payments will represent cash outflows, the PMT
function returns a negative result.



Change the PV parameter to a negative integer if you want the PMT
function to produce a positive result. It's the same as calculating the
payment from the bank's point of view: The loan represents a financial
outflow, while the payments represent a cash inflow.

NOTE: A mismatch between compounding periods and payment frequency
is the most prevalent error in financial calculations. The rate is divided by
12 to get a monthly rate, and the napery is multiplied by 12 to get a monthly
payment in this case. Both arguments are converted to monthly, ensuring
that the results are valid.

If we forget to divide our rate by 12, Excel will interpret it as a monthly
rate, resulting in a payment that is much too large. Similarly, if we typed
years for our napper and a monthly rate, Excel assumed we only paid once a
year.

Excel has no idea if you're entering months, years, or days. It just matters
whether the rate and napery are the same.

Creating an amortization schedule

We may design an amortization schedule using the payment amount to
illustrate how much of each payment is principle and interest, as well as
what the loan balance will be after each payment.

The following are the columns from the amortization schedule:

Message No. The amount of the payment that is being made. In D11,
a 1 is inserted. D12 has the formula =D11+1, which is duplicated



down to D370 (our amortization schedule can handle 360 payments).
Pmt Amount. The PMT calculation amount is rounded to the closest
cent. We can only write a check for dollars and cents, even though
Excel can compute to many decimal places. This implies that after
the loan, there will be a tiny balance. In E11, the formula =-
ROUND($C$6,2) is inserted and filled down to E370.
Principal. The loan debt is reduced by the amount of each payment.
In F11, the formula =E11-G11 is input and filled down to F370.
Interest. The interest component of each payment. The interest rate
divided by 12 is multiplied by the balance after the previous
payment. The amount has been rounded to the nearest two decimal
places. G11 has the formula =ROUND(H10*$C$3/12,2), which is
filled down to G370.
Balance. The remaining amount of the loan after the payment has
been made. In H10, the formula =C2 is used to express the loan's
initial amount. The formula =H10-F11 decreases the amount by the
principal component of the payment starting in C3 and continuing
down to C370.

The number of years was put as 15, rather than 30, in the example. The
amount of the payment rises when the period of the loan is reduced.



The last step is to hide rows that are longer than the loan duration. This is
accomplished via conditional formatting, which turns the font color white.
The data is successfully hidden by a white font color on a white backdrop.

 The conditional formatting formula is as follows:

The payment number in column D is compared to the number of years in
column C4 multiplied by 12. The formula returns TRUE when the payment
amount is greater, and the white font color formatting is applied. No
conditional formatting is used when the payment number is less than or
equal to the total number of payments.

Creating a variable-rate mortgage amortization schedule

We produced an amortization plan for a loan with a fixed interest rate in the
table. There are other loans with variable interest rates that alter over time.
The interest rate on these loans is often linked to a public index, such as the
London Interbank Offered Rate (LIBOR), plus a predetermined percentage.
For example, "LIBOR plus 3%" is a common expression for these interest
rates.



An amortization plan for a loan with a variable interest rate is shown below.
The amortization schedule now includes a Rate column to make it clear
when changes occur. When the rate changes, it is recorded in a separate
table.

The following formula is used in the Rate column to choose the appropriate
rate from the rate table:

=VLOOKUP(D11,$K$11:$L$23,2,TRUE)

The calculation for the Interest column now uses the rate in column G
rather than the rate in column C3:

=ROUND(I10*G11/12,2)

A VLOOKUP with the fourth parameter of TRUE is used in the Rate
column. The rate table must be sorted in ascending order according to the
fourth parameter of TRUE. The payment number is then looked up in the
rate table via VLOOKUP. It doesn't have to be an exact match, but it will
return the row where the next payment number exceeds the search value.
Because the payment number in the following row, 98, is bigger than the
lookup value, VLOOKUP returns the second row of the rate table when the
lookup value is 16.

The interest rate column formula is identical to the one in the example, but
a reference to column G replaces the absolute reference to $C$3 (G11 for
the formula in row 11).

Using dates instead of payment numbers

The payment number is used to identify each payment in the two
amortization schedules for this part and the preceding one. Those payments
will be due on the same day of the month in reality. This makes it possible
to utilize the amortization plan for loans that begin on any date.

Follow these procedures to change the schedule to display the dates:

1. In cell D11, write the initial payment date.
2. Fill in the blanks in D12 using the following formula:

=DATE(YEAR(D11),MONTH(D11)+1,DAY(D11))



3. In the rate table column, adjust the Pmt No column to the date the
rate changed.

4. Replace the conditional formatting formula with the following
formula:
=$D12>=DATE(YEAR($D$11),MONTH($D$11)+
($C$4*12),DAY($D$11))

Depreciation calculation

Some of the depreciation-related Excel spreadsheet functions are DB, DDB, SLN, and SYD. In this
section, we'll examine the formulas for calculating straight line (SLN) and variable-declining balance
(VDB) depreciation.

An asset often depreciates differently in the beginning and end years compared to the middle year. To
avoid taking a full year's worth of depreciation in the first year, a convention is utilized. Midyear,
midmonth, and mid-quarter are typical intervals. According to the half-year convention, the asset is
considered to have been acquired at the halfway point of the year, and one-half of a typical year's
depreciation is recorded for that year.

The following user-entered data is found in columns B through E:

Asset number: Each object has its unique identification. It isn't
required for the timetable, but it is useful for asset management.
Cost: The cost of putting the asset into service. This comprises the
asset's purchase price, any applicable taxes, the cost of shipping the
item to its location of service, and any expenses connected with
installing the asset so that it's ready to use. This is also known as the
cost basis or basis.
Year of Purchase: The year in which the asset went into service.
This might be different from the year in which the asset was
purchased. It establishes the onset of depreciation.
Long Service Life: The estimated number of years the object will be
useful.

The formula in F3:N7 is as follows:

=IF(OR(YEAR(F$2)
<$D3,YEAR(F$2)>$D3+$E3),0,SLN($C3,0,$E3))*IF(OR(YEAR
(F$2)=$D3+$E3,YEAR(F$2)=$D3),0.5,1)IF(OR(YEAR (F$2)=$D3),0.5,1)
IF(OR(YEAR (F$2)=$D3),0.5,1) IF



SLN($C3,0,$E3) is the most important portion of this formula. The SLN
spreadsheet function calculates one-period straight-line depreciation. There
are three points to consider: cost, salvage, and life. The salvage value is set
to zero in this example for simplicity, implying that the asset's cost will be
depreciated at the end of its useful life.

The SLN function is straightforward. However, since this is a depreciation
schedule, there is still more work to be done. The first IF function
determines if the column is within the useful life of the asset. If the year of
the date in F2 is less than the year of acquisition, the asset has not yet been
put into service, and depreciation is zero.

If F2 exceeds the year of acquisition plus the useful life, the asset is
completely depreciated and the depreciation is zero. Both of these
conditionals are wrapped in an OR function, which means that if one of
them is true, the whole expression returns TRUE. However, if both are
FALSE, the SLN function is returned.

The formula's second portion is likewise an IF and OR combination. These
conditional expressions decide whether or not the year in F2 is the first or
final year of depreciation. If one of these conditions is met, the straight-line
result is multiplied by 0.5, which represents the half-year convention used
in this case.

This formula's cell references are all anchored so that the formula may be
copied down and to the right without the cell references changing. Row 2
references are anchored on the row such that the date in row 2 is always
evaluated. Cost, Year Acquired, and Useful Life remain the same when the
formula is copied because references to columns C: E are anchored on the
columns.

Making an accelerated depreciation calculation

The straight-line method equalizes an item's depreciation across the course
of its useful life. Some businesses use an accelerated depreciation method,
which depreciates assets more quickly in the beginning and more slowly at
the end of their useful life. The idea is that an asset loses value more
quickly during its first year of use than during its final year.



Excel contains a DDB function for accelerated depreciation (double-
declining balance). DDB uses the straight-line method to determine the
value of the remaining assets and doubles it. The problem with DDB is that
it only depreciates an asset partially over the course of its useful life. The
asset's useful life is up before the amount of depreciation approaches zero,
albeit it does decline over time.

Starting with a diminishing balance approach and switching to a straight-
line strategy if the depreciation falls below the straight-line amount is the
most usual application of accelerated depreciation. Thankfully, Excel offers
a VDB function that incorporates that reasoning.

This formula is a bit more sophisticated than the SLN formula from the last
example, as you may have observed.

Don't worry, we'll go through everything step by step so you understand
everything:

=IF(OR(YEAR(F$2) <$D3, YEAR(F$2)>$D3+$E3),0, VDB(...)

The initial component of the formula is the same as the SLN formula
previously stated. Depreciation is zero if the date in row 2 is not within the
useful life. If that's the case, the VDB function is used:

VDB ($C3,0, $E3*2, starting period, ending period)

The first three parameters in VDB are identical to the first three arguments
in SLN: cost, salvage value, and life. We don't have to tell SLN which
period to compute since it delivers the same result for every period.
However, depending on the period, VDB returns a varying amount. VDB's
last two parameters tell it which period to calculate. In E3, life is doubled,
as detailed in the next section.

Starting period

•IF(YEAR(F$2)=$D3,0,IF(YEAR(F$2)=$D3+$E3,$E3*2-1,
(YEAR(F$2)-$D3)*2-1))

The convention is ignored by none of Excel's depreciation tools. That is,
Excel calculates depreciation as though all of your assets were purchased on



January 1st of each year. That isn't a very practical solution. We'll use a
half-year pattern in this section, so only half of the depreciation is taken in
the first and final years. To do so using VDB, we must convince Excel that
the asset has a useful life of twice as long as it does.

The period for the first year moves from 0 to 1 for an item having a five-
year useful life. The periods for the second year are 1–3. Periods 3–5 make
up the third year. This pattern continues until the last year, which spans 9–
10 months (10 is double the five-year life).

The formula's initial period is calculated as follows:

Make the beginning period 0 if the year to calculate is the acquisition
year.
If the year to be computed is the previous year, double the useful life
by 2 and deduct 1.
Remove the acquisition year from the year to calculate, multiply by
2, and subtract 1 for all other years.

The formula's ending period part is comparable to the beginning period
section. It terminates at period 1 during the first year. It finishes at the
useful life times 2 for the past year. It conducts the same computation for
the intermediate years, but instead of removing one, it adds one.

We can integrate the half-year convention into a declining balance function
like VDB by doubling the usable life, say from 7 to 14 periods for a 7-year
asset.

The present value calculation

The temporal value of money (TVM) is a key idea in accounting and
finance. According to the argument, a dollar today isn't worth as much as
one tomorrow. The amount of money you can make with that dollar is
represented by the difference between the two numbers. The source of
income could be the interest from a savings account or the profit from an
investment.

The PV function in Excel, which determines present value, is one of the
many tools available for working with TVM. In its simplest form, PV



determines the present value by applying a discount rate to a future value
amount. If I told you I'd give you $10,000 in a year, how much would you
take instead of waiting?

The table shows that you should accept $9,434 now rather than $10,000 a
year from now, according to the present value calculator. If you took the
$9,434 and earned 6% over the following year, you'd wind up with $10,000
at the end of the year.

There are five parameters to the PV function:

Rate: The rate argument, sometimes known as the discount rate, is
the expected return on your money over the charge fees. It is the
most important aspect in establishing the current value, as well as the
most difficult to determine. If you're a cautious person, you can
choose a lesser rate—one that you're certain you can meet. The
discount rate would be straightforward to calculate if the money was
used to pay down a fixed-rate loan.
Nper: The nper is the time interval over which the future value is
discounted. The nper is 1 year in this case, and it is recorded in cell
C3. The rate must be expressed in the same units as the period. That
instance, nper must be given in years if you provide an annual rate. If
you're using a monthly rate, you'll need to write nper in months.
Pmt: The recurring payments received during the discount period
are the pmt argument. When just one payment is made, as in this
case, the amount paid is the future value, and the payment amount is
zero. The pmt and nper arguments must both be the same. PV thinks
that if your nper is 10 and you input pmt, you'll get that payment



amount 10 times throughout the discount term. A present value
computation with payments is shown in the following example.
FV: The amount you will get after the discount term is the future
value amount. The financial functions in Excel operate on a cash
flow basis. That is, the current value and the future value have polar
opposite signs. The future value was made negative in this example
so that the formula result would produce a positive number.
Type: If the payments are received at the end of the period, the type
argument may be 0; if the payments are received at the beginning of
the period, it can be 1. Because our payment amount is 0 in this case,
this argument has no impact. If the type argument is missing, the
value is presumed to be 0.

Making a present-value calculation for future payments

The present value of a series of equal future payments can also be
calculated using PV. You can use PV to determine how much you'd be
prepared to pay to break the lease if, for instance, you owe $5,000 in rent
over the next ten years.

If your landlord thought he could make 3% on the money, he might be
willing to accept $43,930 rather than ten $5,000 payments over the
following ten years. The type parameter is set to 1 because rent is often paid
at the beginning of the semester.



When used for payments, the PV function calculates the present value of
each payment separately and adds the totals. Because the first payment is
due now, its present value is the same as the payment amount. Year 2
payment is due in one year, and it is decreased to $4,854. The last payment,
which is due in nine years, is lowered to $3,832. All of the estimates for
present value are totaled. Fortunately, PV takes care of the tough lifting.

Calculating the net present value

If all the cash flows are the same, the PV function may compute the present
value of future cash flows. But this isn't always the case. Excel's NPV (net
present value) tool calculates the present value of unbalanced future cash
flows.

Assume you were asked to invest $30,000 in a new firm. You would get an
annual dividend for the following seven years in return for your investment.
The schedule shows the projected amounts of such dividends. Assume you
want to make an 8% return on your investment.



You can use the NPV formula to calculate the net present value of an
investment to see whether it's worth your time:

=NPV (C2, C5:C11)

NPV, like PV value, discounts each cash flow individually depending on the
rate. NPV, on the other hand, accepts a range of future cash flows rather
than a fixed payment amount, unlike PV. Because the number of values in
the range influences the number of future cash flows, NPV does not have a
nper argument.

Even if the payments are for different amounts, they are expected to be
made at regular periods (one year in this example). The rate period, like the
other TVM functions in this chapter, must match the payment period. The
8% return you want is an annual return in this case, and the payments are
also yearly, so they match. You'd have to change the rate to a quarterly
return if you were collecting a quarterly dividend.

The net present value (NPV) of these cash flows is $33,068. These would
be favorable investments since the needed investment to generate those
cash flows, $30,000, is less than the NPV (provided the figures are true).
The data indicates that you would earn more than the 8% return you
desired.

The calculation of both positive and negative cash flows

In the previous scenario, you were advised to make a sizable initial
commitment in order to receive future cash flows. You can use NPV if you
make smaller payments at the beginning of the financing period with the
expectation of additional payments at the end.

Instead of making a single $30,000 commitment, think about making
investments of $15,000 the first year, $10,000 the second year, and $5,000
the third year. The amount you must invest goes down as the company
grows and may use its income to expand. By year four, there won't be any
more investment required, and the business should be successful enough to
start paying dividends.



The payment schedule shown in the chart below entails paying for the first
three years and receiving a return for the next four. The inputs only differ
from the last iteration of the NPV calculation.

=NPV (C2, C5:C11)

The amount invested was not taken into account in the first NPV case. We
simply compared the NPV function's outcome to the amount of money
invested. Because a part of the investment is in the future in this example,
the invested amounts are displayed as negatives (cash outflows), but the
forthcoming dividends are shown as positives (cash inflows).

This NPV computation is compared to zero instead of an initial investment
amount. If the NPV is larger than zero, the sequence of cash flows will
provide a return of more than 8%. The return is less than 8% if it is less
than zero.

Internal rate of return calculation

In the scenario before, we calculated the net present value of the anticipated
future cash flows and contrasted it with the sum of our initial investment.
Since the net present value exceeded the initial investment, we were aware
that the rate of return would be higher than what we had anticipated. But
what is the actual rate of return?

The IRR function in Excel can be used to calculate the internal rate of
return of future cash flows. NPV and IRR are indissolubly related. IRR
determines the rate of return at which those identical cash flows have a
negative net present value.



We need to change the way we organize our data for IRR. In the values
range, there must be at least one positive and one negative cash flow. If all
of your values are positive, you've invested nothing and received nothing in
return. That would be a fantastic investment, but it isn't feasible. Cash
withdrawals usually occur at the start of the investment term, while cash
inflows occur at the conclusion. However, as long as there is at least one of
each, this isn't necessarily the case.

It is important to note that for IRR to operate, we must include the original
investment. The first row was inserted to indicate the original investment of
$30,000.

The investment return is 10.53 percent, according to the following IRR
formula:

=IRR (C3:C10,0.08)

The range of cash flows is the first justification for IRR. The second point is
an educated estimation of the internal rate of return. If you don't provide an
estimate, Excel guesses 10%. The present value of each cash flow is
calculated using the predicted rate in IRR. If the total is more than zero, the
pace is reduced and the process is repeated. Excel repeats the process of
accumulating current values and iterating through rates until the total is
zero. It returns that rate once the current numbers add up to zero.



Future non-periodic cash flows calculation

For both the NPV and IRR functions, it is assumed that the future cash
flows will occur at regular intervals. This might not always be the case,
though. Excel's XIRR function is helpful for cash flows that happen at
unpredictable times.

In contrast to IRR, XIRR requires an additional justification: dates. The
IRR does not require the dates because it is anticipated that the cash flows
will occur at equal intervals. IRR doesn't care if there is a day or a year
between them. It will yield a return proportional to the cash flows. If the
cash flows are yearly, the rate will be an annual rate. If the cash flows are
quarterly, the rate will be quarterly as well.

Note: XIRR provides a function named XNPV that calculates the net
present value of non-periodic cash flows. XNPV, like XIRR, needs a
matching set of dates.

The investment loses money sometimes, necessitating a cash infusion. On
other days, the investment is profitable and pays the investor a profit. The
investor earns an annual return of 10.14 percent on all cash flows.

The return is calculated using XIRR in the following formula:

=XIRR(C3:C17,B3:B17,0.08)

Internally, XIRR functions similarly to IRR. It evaluates the present value
of each cash flow separately, iterating over rate estimates until the total
present value is zero. The number of days between the current cash flow
and the one before it in chronological order is used to calculate the present
value. The rate of return is then annualized.

Performing financial forecasting

Forecasting is the process of projecting future values based on previous
ones. Start with historical, time-based data, such as monthly sales, to
construct a prediction. Monthly sales statistics from 2012 to 2015 may be
found in Column B. We also generated a graph that demonstrates that sales
are cyclical, with fewer sales during the summer months. The purpose is to
anticipate revenues for the following two years monthly.



Begin by choosing the data. We choose the range A1:B49 for this example.
Excel shows the Create Forecast Worksheet dialog box when you choose
Data Forecast Sheet. (Clicking Options brings up a list of other settings.)
The dialog box displays a graphic that shows the historical data, predicted
data, and forecast confidence bounds.

The confidence interval (shown in the graphic as thinner lines) sets the
prediction's "plus or minus" values and reflects the degree of confidence in
the forecast. A larger prediction range is achieved with a bigger confidence
interval. As you alter the parameters, the chart in the dialog box updates.

When you click Create, Excel creates a new worksheet with a table and a
chart. The projected values, as well as the lower and upper confidence
ranges, are shown in the table. The new FORECAST.ETS and
FORECAST.ETS.CONFINT functions are used to create these values.
Excel handles all of the work since these are very sophisticated functions.

 

 

 

 

 

 



CHAPTER 8
APPLICATION OF FORMULAS IN

STATISTICAL ANALYSIS
Because it has so many statistical capabilities, Excel is a great tool for
conducting statistical analysis. You'll learn how to use formulae to conduct
statistical studies like moving averages, descriptive statistics, and frequency
distributions in this section.

Working with Weighted Averages

When each value has a different impact on the total set of values, a
weighted average is used to average the data. For each fund in the portfolio,
the investment's total amount as well as its return are displayed. We are
looking for the portfolio's overall return. A simple average will not do
because each investment raises the total portfolio's value, so it is
insufficient.

The weighted average is calculated by multiplying the proportion that each
investment contributes to the overall value of the portfolio by the rate of
return on that investment. The SUMPRODUCT function is appropriate for
multiplying and summing two sets of data. SUMPRODUCT accepts up to
255 parameters separated by commas, however, this formula only requires
two.



=SUMPRODUCT((C3:C7/$C$8),D3:D7)

The first parameter divides the total value by the value of each investment.
As a consequence, each investment's weight is represented by five
percentages. The weight for the Roboto Bond Fund is 17 percent, which is
calculated by dividing 72,021.35 by 423,655.02. The rate of return is the
second parameter.

SUMPRODUCT multiplies each of the first argument's elements by the
second argument's corresponding element. The elements C3/C8 and C4/C8
are multiplied by D3, C4/C8 is multiplied by D4, and so on.
SUMPRODUCT adds together the results of multiplying all five
components.

The basic average of the results would be 5.906 percent if we used
AVERAGE to find it. Because assets like the Sparkle Growth and Income
Fund have a greater return than average and make up a bigger share of the
portfolio, this is lower than our weighted average.

Instead, all of the work that SUMPRODUCT undertakes to get the
weighted average might be done in neighboring cells using simpler
functions.

Data Smoothing Using Moving Averages

Data is smoothed using a moving average so that the overall trend of the
data may be seen more clearly. It performs admirably when the independent
variables are erratic. Any player who has participated in the game is aware
of how variable the results can be from round to round. It's challenging to
understand how this golfer's game is developing given the chart's abrupt
peaks and valleys.



We want to make a graph that smooths out the highs and lows to illustrate
how the scores are moving. We may achieve this by calculating the moving
average of the scores and plotting the results on the graph.

=IF(ROW()<12,NA(),AVERAGE(OFFSET(D3,-9,0,10,1)))

This formula accomplishes our goal by using a variety of Excel functions.
For the first few scores, an IF function is utilized to return the #N/A error.
With no arguments, the ROW method returns the current cell's row. The
formula returns #N/A for the first nine rows since we don't want to start our
moving average computation until we have adequate data.

 

Note: #N/A mistakes are not shown in Excel charts. For values that you
don't want to display on your charts, utilize the NA function.



The AVERAGE function is used to return the arithmetic mean of the
previous 10 scores for the later scores. Because our numbers are in a
contiguous range, we only need to submit one parameter to AVERAGE.

The OFFSET function returns a range of values that are offset from the
beginning point.

The following are the justifications to OFFSET:

Reference: The OFFSET function begins in this cell.
Rows: The number of rows in the returned range begins from the
beginning cell. Negative values add to the spreadsheet's total,
whereas positive ones subtract from it.
Cols: The number of columns beginning from the first cell. Positive
numbers count from left to right, whereas negative numbers count
from left to right.
Height: How many rows should the returned range have?
Width: How many columns should the returned range have?

NOTE: OFFSET's height and width inputs must be positive integers.

If we make cell D12 the reference argument, OFFSET will begin counting
there. OFFSET will count up to nine rows to D3 if the rows parameter is set
to -9. The cols input of 0 (zero) indicates that OFFSET remains in the same
column. OFFSET has calculated that the start of the returned range will be
D3 after the first two parameters.

Because the height option is set to 10, our range will be ten rows tall, or
D3:D12. The width parameter of 1 maintains a one-column range. The
range D3:D12 is the outcome of OFFSET and what is sent into AVERAGE.
The previous 10 scores are averaged as the formula is copied down.

Depending on the data, the number of values to include in a moving
average varies. You may display the preceding 12 months, 5 years, or any
other quantity that makes sense given your data. The average of the
previous ten scores gives a better idea of where this golfer's game is going.



Exponential smoothing applied to volatile data

A good tool for data smoothing is the moving average. Moving averages
have the drawback of assigning the same weight to each data point in the
collection. In a six-week moving average, for instance, each week's value is
given 1/6 of the total weight. In some data sets, more recent data points
should be given more weight.

The Demand column displays the actual product that was sold. In an effort
to gauge demand, the Moving Average column employs a straightforward
six-week moving average. Exponential smoothing is used in the final
column to give the most recent weeks more weight than earlier weeks.

=(C8*$H$2)+(E8*(1-$H$2))

The alpha value in cell H2 is the weight assigned to the most recent data
item, which in this case is 30%. The remaining 70% of the data items are
given a 70 percent weighting. The second most recent is weighted at 30%
of the remaining 70% (21%); the third most recent is weighted at 30% of
70% of 70% (14.7%), and so on.



The value from the previous week is multiplied by the alpha value, which is
then added to the remaining percentage multiplied by the previous
projection. All of the preceding computations are already integrated into the
previous projection.

The exponential smoothing prediction is less affected by demand values
that are farther away. In other words, the figure from last week is more
significant than the number from the week before. Take note of how the
exponential prediction reacts to demand variations faster than the moving
average.

How to Produce Descriptive Statistics Using Functions

You can present data in concise, quantitative summaries using descriptive
statistics. Data are accumulated, counted, and averaged to produce
descriptive statistics. In this section, we'll take a look at some of the
comparison and profiling tools that can be used to prepare data sets for
further analysis.

Obtaining either the biggest or least value

The monthly low temperatures for Marietta, Georgia are shown in the table
below. The highest and lowest monthly average temperatures are what we're
looking for. The first formula will be used to calculate the highest average
low temperature.

=MAX(C3:C14)

The month that corresponds to the temperature determined in the
preceding calculation will be returned using the following formula:

=INDEX(B3:B14,MATCH(E5,C3:C14,FALSE),1)

MAX and MIN are two Excel functions for determining the greatest and
lowest values in a range. Both formulae have a maximum of 255
parameters. Our data is in the range C3:C14, which is what MAX and MIN
are looking for. The biggest number in the range, 70, is returned by MAX,
whereas the least is returned by MIN.



The INDEX function is used to identify which months certain temperatures
correspond to. The list of months in B3:B14 is the range supplied into
INDEX. The MATCH function, which returns the location of the lookup
item in a list, is the second parameter to INDEX. MATCH returns 7 when
we match 70 to our list of temps since 70 is the seventh item on the list.
INDEX returns the seventh row of the month listings, or JUL, using that 7.
MIN returns JAN, the month with the least value, using the same structure.

Both MAX and MIN disregard any text in the range, but they will return an
error if the range contains errors. MAX and MIN return 0 if all of the errors
are text.

Obtaining the Nth biggest or least value             

The MIN and MAX algorithms make it simple to determine the largest and
smallest numbers. However, there may be times when you need to figure
out the fifth- or second-smallest value. It's tough to tell who the winners are
because the bowlers are organized alphabetically by last name. The bowlers
who finished first through third, along with their scores, are needed.

The third-largest number from the list of scores is returned by this
formula:

=LARGE($C$3:$C$14,ROW(A3))



To get the Nth greatest and smallest values in a list, use the LARGE and
SMALL functions. We send a range of numbers to LARGE, just as we do
with MAX. LARGE, on the other hand, has a different explanation for the
N in the Nth greatest number.

LARGE and SMALL return the same value for the Nth value and the Nth
+ 1 value if two entries in the list have the same value.
=LARGE($C$3:$C$14,1) and =LARGE($C$3:$C$14,2) would both yield
588 if two competitors had a score of 588.

To get N in cell F3, we utilize ROW(A1). In this scenario, the ROW
function returns row 1 for the cell supplied to it. We could just send 1 to the
LARGE function, but we can replicate this calculation down to increase the
row by using ROW(A1). The A1 reference is relative; thus the formula
becomes ROW when transferred to cell F4 (A2). The LARGE function in
F4 then returns the second largest number, which is 2.

Because larger bowling scores are preferable, the LARGE function is
suitable here. If we had a list of race timings instead, we'd use the SMALL
function since lower times are desirable.

The RANK function is another approach to getting the Nth greatest or
lowest integer. The RANK function accepts three arguments: the number to



rank, a list of all numbers, and the sort order. It also has a column for
ranking each result, and the formula is as follows:

=RANK(C3,$C$3:$C$14,1)

We pass the time in C3, the total list of times in C3:C14, and the order into
RANK to obtain Gianna Ruiz's rank. In this case, the order is 1, since we
want the lowest number to be ranked first. The last argument would be 0 if
we want the greatest number to be listed first.

Note: When two or more values are tied, RANK returns the same result for
all of them. RANK would return 1 for both racers with a time of 20:35. The
next-lowest time would be ranked at number three. Because the linked
values take up both the 1 and 2 rankings, none of the values would rank 2.

RANK.AVG and RANK.EQ are two new functions in Excel 2010 for
dealing with ties in ranking. The RANK.EQ function replicates the RANK
findings from previous versions. That is, if you use the same value, you'll
get the same result. The RANK.AVG function operates uniquely. It gives
the average rating for all matching values.

Assume the data revealed four runners with the second-lowest time of
21:38. RANK. AVG would yield 1 for the best time and 3.5 for four
second-place times that were all the same. Those four occasions are ranked
2, 3, 4, and 5 respectively. These four ranks have a combined average of
3.5.

RANK returns the position of the item in the list if the list was sorted
according to the last parameter, unlike LARGE and SMALL, which return
the actual values. In the same way that we used INDEX and MATCH to
acquire the names, we'll need to utilize INDEX and MATCH to retrieve the
actual values.

The formula for returning the time of the first-place contender in cell
G3 is as follows:

=INDEX($C$3:$C$14,MATCH(ROW(A1),$D$3:$D$14,FALS

Calculating mean, median, and mode



When someone says "average," they typically mean the arithmetic mean,
which is the total of the values divided by the number of values. The
median and mode are two more averages that Excel may compute.

We want to look at the grades and make inferences from them by
calculating the mean, median, and mode.

=AVERAGE (C3:C22)

=MEDIAN (C3:C22)

=MODE (C3:C22)

The mean is 85.1, the median is 90.5, and the mode is 93.0, as you can see.
The AVERAGE function adds all of the values in the range and divides by
the number of values to get the mean. The median and mode's relationship
to the average may provide some information about the data.

The MEDIAN function is used to calculate the median. MEDIAN delivers
the value that is exactly in the center if all the grades are provided in
sequence. There is no precise midway value since we have an even number



of grades. MEDIAN returns the mean of the two numbers closest to the
center in this situation.

A significant disparity between AVERAGE and MEDIAN suggests that
grades are not distributed equally throughout the population. There seems to
be a significant disparity between the higher-scoring pupils and the lower-
scoring students in our scenario. In other circumstances, one extremely big
or tiny number may affect the AVERAGE but not the MEDIAN.

The MODE function is used to determine the mode. The grade that occurs
the most often is returned by MODE. A count of each grade is shown next
to the grade. You can see that 93 appears four times, which is the most of
any grade. MODE returns #N/A if all of the values occur the same number
of times.

Data allocation into percentiles

To examine how each number relates to the whole, data can be separated
into buckets or bins. The individuals who process a product are listed in
part in the table below, along with the number of errors the quality
assurance department discovered per 1,000 goods. In order to identify top
performers and employees who can benefit from additional training, we
want to divide this information into four groups. The demarcation line
between each quartile can be calculated using Excel's QUARTILE function.
A data bucket called a quartile holds 25% of the data.

=QUARTILE($C$3:$C$32,5-ROW(A1))

The demarcation lines are provided by the QUARTILE function. The
MATCH formula in cell D3 determines which quartile the value in cell C3
belongs to. The formula is then duplicated for each value.

=MATCH(C3,$G$3:$G$6,-1)

The QUARTILE function accepts a set of numbers and an integer that
indicates which quartile should be returned (the quart argument). 0
represents the lowest value, 1 represents the 25th percentile, 2 represents
the 50th percentile, 3 represents the 75th percentile, and 4 represents the
highest value. QUARTILE gives an error if the quart argument is not in the



range 0–4. The value of the quart parameter is trimmed if it contains a
decimal, and only the integer part is utilized.

The 5-ROW expression is used in the quart parameter of our QUARTILE
function (A1). As the formula is duplicated down, the quart argument
decreases by one. The equation yields 4 for the largest value in the range for
cell G3. The A1 reference changes to A2 when the formula is transferred
down to G4, and the equation yields 5-2 or 3 for the 75th percentile.

To discover the two values that surround the demarcation line, the
QUARTILE function applies a percentage to one less than the count of
values. The result is then calculated by interpolating between those two
variables.

QUARTILE calculates the 75th percentile by multiplying the 30 numbers
by.75*(30-1) to obtain 21.75. The data is then sorted from lowest to highest,
and the lowest value is counted down 21 rows. It interpolates between the
two numbers since the first calculation's result isn't a whole integer. In this
scenario, the number 43 is obtained by counting down 21 rows, and the
following value is obtained by counting down 45 rows. The interpolation
utilizes the decimal component of 21.75 to get the number that is 75% of
the way between 43 and 45, or 43+((45-43)*.75), which is 44.5.

QUARTILE computes.5*(30-1) for the 50th percentile, yielding 14.5. The
50th percentile is between Alex Cox and Katelyn Howard, counting down
from the lowest numbers. Because both numbers are the same, interpolation
is simple and yields 31.

The MATCH function is used in the range of QUARTILE computations to
determine which quartile each number belongs to. The final parameter of
MATCH is -1— Greater than since our quartile data is in decreasing order.
When the next value is less than the lookup value, MATCH returns the
place in the list where the value was located, but it pauses when the next
value is greater. MATCH notices that the second value (44.5) is smaller
than the lookup value and stops at the first location while trying to match
the value 47.

 



Interquartile Range for Statistical Outlier Identification

In the previous calculation, data were bucketed using the QUARTILE
function. Although it narrows the gap between the upper and lower
quartiles, the QUARTILE function is only beneficial when you need
roughly symmetrical quartiles (making it more difficult to identify true
statistical outliers).

Another helpful tool is Excel's QUARTILE function.

EXC removes the median (middle number) from the population. The
quartiles are further away from the entire's center as a result of this
function. This offers a more exact picture of which numbers should be
classified as outliers as well as a more accurate estimate of the true
population.

This data collection has a wider range of values. Finding the employees
who deviate from the norm and require further investigation is our goal.

Use a strategy called a leveraged interquartile range to find outliers. The
data in the center half of the interquartile range is called an interquartile
range (between the 75th percentile and the 25th percentile). The



"leveraged" component refers to the fact that we increase the center range
by a factor and set up fences. Any data that falls beyond the fence is
regarded as an anomaly.

Here are the formulae that were used:

=QUARTILE.EXC($C$3:$C$22,3) =QUARTILE.EXC($C$3:$C$22,3)
=QUARTILE.EXC($C$3:$C$

=QUARTILE.EXC($C$3:$C$22,1) =QUARTILE.EXC($C$3:$C$22,1)
=QUARTILE.EXC($C$3:$C$

=G4-G5 Interquartile Range

1.5 Fence Factor

=G4+(G6*G8) Upper Fence

=G5-(G6*G8) =G5-(G6*G8) =G5-(G6*G8)=G5

=IF(C3$G$10,"Low,"IF(C3>$G$9,"High","")) outliers

The 75th percentile and 25th percentile are calculated using the
QUARTILE.EXC function with inputs of 3 and 1, respectively. The
difference between these two is the interquartile range.

You would simply remove the interquartile range from the 25th percentile
to create a lower fence and add it to the 75th percentile to achieve a higher
fence in a non-leveraged interquartile range. This strategy may produce an
excessive number of outliers. We enlarge the gates to isolate the genuinely
extreme values by doubling the interquartile range by a factor (1.5 in this
example). The table provides the same data sorted by faults, as well as the
quartile, interquartile range, and upper and lower fence demarcation lines.

We multiply the fence factor by the interquartile range and add the result to
the 75th percentile to get the upper fence. The lower barrier is established
by subtracting the same result from the 25th percentile.

You can notice that a fence factor of 1.5 excludes or includes results that
you deem outliers or typical. 1.5 is not a magical number. If the factor
doesn't suit your data, just increase or decrease it.



After we've created our fences, we utilize a nested Whether formula to see
if each number is larger than or less than the upper or lower fence. The
nested IF formula returns the text "High" or "Low" for the outliers, and an
empty string ("") for those who are within the gates.
Creating a Frequency Distribution

Because quartiles are a common technique to divide data into bins, Excel
offers a dedicated QUARTILE function. However, you might wish to divide
your data into defined bins on occasion. We want to know how often
transactions between $1 and $100, $101 and $200, and so on are for our
consumers.

The FREQUENCY function in Excel will count all invoices that fall within
the defined buckets.

=FREQUENCY(C3:C52,F3:F12)

The function FREQUENCY is an array function. This implies that instead
of hitting Enter, you must use Ctrl+Shift+Enter to commit the calculation.



Excel will wrap the formula in curly brackets () to indicate that it has been
array-entered.

FREQUENCY requires two arguments: a set of data to be binned and a set
of integers to indicate the maximum quantity in each bin. To begin, fill in
the bin values in column F. The bottom limit of each bin is shown in
Column E, which has no bearing on the formula.

To write FREQUENCY in column G, choose the range G3:G12 first, then
input the formula. While you'll just be typing the formula into G3, pressing
Ctrl+Shift+Enter will populate the formula throughout the whole range
you've picked.

The FREQUENCY calculation reveals that a high percentage of clients
spend between $200 and $300 every visit.

A replacement for the FREQUENCY function

If you attempt to delete a cell from the FREQUENCY formula section,
Excel will inform you that "You cannot change part of an array." Excel
treats FREQUENCY and all array functions as a single entity. Individual
array cells cannot be modified, only the entire array. If you want to change
the bins, you must exit and re-enter the array.

The COUNTIFS function can also be used to generate a frequency
distribution. COUNTIFS is not an array formula, making it much easier to
alter the bins or alter the range. Here is an example of the COUNTIFS
function for the following data:

=COUNTIFS($C$3:$C$52,">"&E3,$C$3:$C$52,">="&



COUNTIFS, unlike FREQUENCY, requires the bin's lower limit (column
E). It adds up all the numbers that are higher than the lower limit but less
than or equal to the upper bound. This formula is just copied down for as
many bins as we've specified, rather than using an array.



CHAPTER 9
TABLES AND CONDITIONAL FORMATTING

IN FORMULAS
The term "conditional formatting" refers to an Excel function that enables
you to change the formatting of a value, cell, or range of cells based on a
number of predefined conditions. With conditional formatting, you may
quickly and solely based on formatting identify which values are "good"
and which are "poor" in your Excel reports.

In this chapter, we'll demonstrate how to use Excel's conditional formatting
tool along with formulas to add a layer of visuals to your investigation.

Cells That Meet Specific Criteria Are Highlighted

One of the most basic conditional formatting rules you may create
highlights cells that meet specific business requirements. This first
illustration illustrates how to format cells that have values lower than the
hard-coded threshold of 4000.

Follow these steps to create this simple formatting rule:

1. In your target range, choose the data cells you want to work with.



2. Select Conditional Formatting > New Rule > New Rule from the
Home tab of the Excel Ribbon.

3. Select Use a formula to select which cells to format from the list box
at the top of the dialog box.

4. NB: This option calculates values using a formula that you define.
The conditional formatting is applied to a cell if a given value
evaluates to true.

5. Type the formula indicated below into the formula input box. It's
worth noting that we're just referring to the first cell in our target
range. It is not necessary to refer to the complete spectrum.
=C3<4000

Note: The absolute reference dollar symbols ($) for the target cell are not
included in the calculation (C3). Excel will instantly make your cell
reference absolute if you click cell C3 with your mouse rather than putting
it in. Because you require Excel to apply this formatting rule based on each
cell's value, you mustn't use the absolute reference dollar symbols in your
target cell.

6. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.

7. When you've finished selecting your formatting choices, click OK.
8. Return to the New Formatting Rule dialog box and double-click the

OK button to finalize your formatting rule.



If you need to change your conditional formatting rule, just set your cursor
in any of the data cells in your formatted range, then click Conditional
Formatting Manage Rules from the Home tab. The Conditional
Formatting Rules Manager dialog box will appear. Then, on the Edit
Rule button, choose the rule you wish to change.

Cells can be highlighted dependent on another cell's value.
In many cases, how the values of your cells compare to one another will dictate the formatting rules
that apply to that cell. Conditionally highlighted cells are those whose values are less than the Prior
Year Average value indicated in cell B3.

 

Follow these steps to create this simple formatting rule:

1. In your target range, choose the data cells you want to work with
(cells E3:E14 in this example).

2. Select Conditional Formatting > New Rule from the Home tab of
the Excel Ribbon.

3. Select Use a formula to select which cells to format from the list box
at the top of the dialog box. This option calculates values using a
formula that you define. The conditional formatting is applied to a
cell if a given value evaluates to true.



4. Type the formula indicated below into the formula input box. It's
worth noting that we're just comparing the value in our target cell
(E3) to the value in the comparison cell ($B$3). You'll need to utilize
absolute references, just as in conventional formulae, to guarantee
that each value in your range gets compared to the proper
comparison cell. =E3<$B$3

5. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.

6. When you've finished selecting your formatting choices, click OK.
7. Return to the New Formatting Rule dialog box and double-click the

OK button to finalize your formatting rule.

Highlighting Values That Exist in List1 but Not List2

You'll often be asked to compare two lists and identify the values that are
present in one but not in the other. The use of conditional formatting to
display your results is excellent. The table shows a conditional formatting
exercise that compares clients from 2018 and 2019, emphasizing those who
are new customers in 2019, i.e. those who did not exist in 2018.



Follow these steps to create this simple formatting rule:

1. In your target range, choose the data cells you want to work with
(cells E4:E28 in this example).

2. Select Conditional Formatting > New Rule from the Home tab of
the Excel Ribbon.

3. Select Use a formula to select which cells to format from the list box
at the top of the dialog box. This option calculates values using a
formula that you define. The conditional formatting is applied to a
cell if a given value evaluates to true.

4. Type the formula indicated below into the formula input box. Note
that we're evaluating if the value in the target cell (E4) is found in
our comparison range ($B$4:$B$21) using the COUNTIF function.
The COUNTIF function will return a 0 if the value is not found,
activating the conditional formatting. You'll need to utilize absolute
references, just as in conventional formulae, to guarantee that each
value in your range gets compared to the proper comparison cell.
=COUNTIF($B$4:$B$21,E4)=0

5. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.

6. When you've finished selecting your formatting choices, click OK.
7. Return to the New Formatting Rule dialog box and double-click the

OK button to finalize your formatting rule.

Highlighting Values That Exist in List1 and List2

You may need to compare two lists and choose just the values that appear in
both lists on occasion. Conditional formatting is an excellent technique to
display your results once again. The table is a conditional formatting
exercise that compares customers from 2018 and 2019, emphasizing those
in both lists in 2019.



 

 

Follow these steps to create this simple formatting rule:

1. In your target range, choose the data cells you want to work with
(cells E4:E28 in this example).

2. Select Conditional Formatting > New Rule from the Home tab of
the Excel Ribbon.

3. Select Use a formula to select which cells to format from the list
box at the top of the dialog box. This option calculates values using a
formula that you define. The conditional formatting is applied to a
cell if a given value evaluates to true.

4. Type the formula indicated below into the formula input box. Note
that we're evaluating if the value in the target cell (E4) is found in
our comparison range ($B$4:$B$21) using the COUNTIF function.
The COUNTIF function will return a number larger than 0 if the
value is discovered, activating the conditional formatting. You'll
need to utilize absolute references, just as in conventional formulae,



to guarantee that each value in your range gets compared to the
proper comparison cell. =COUNTIF($B$4:$B$21,E4)>0

5. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.

6. When you've finished selecting your formatting choices, click OK.
7. Return to the New Formatting Rule dialog box and double-click

the OK button to finalize your formatting rule.

Highlighting Based on Dates

You might find it handy to graphically highlight when particular dates set
off a certain scenario. When dealing with timecards and scheduling, for
example, it's typically helpful to be able to quickly identify any days that
occur on weekends.



Follow these steps to create this simple formatting rule:

1. In your target range, choose the data cells you want to work with
(cells B3:B18 in this example)

2. Select Conditional Formatting > New Rule from the Home tab of
the Excel Ribbon.

3. Select Use a formula to select which cells to format from the list box
at the top of the dialog box. This option calculates values using a
formula that you define. The conditional formatting is applied to a
cell if a given value evaluates to true.

4. Type the formula indicated below into the formula input box. Note
that we're evaluating the target cell's weekday number using the
WEEKDAY function (B3). If weekday 1 or 7 is returned in the target
cell, the date in B3 is a weekend date. The conditional formatting
will be used in this scenario. =OR(WEEKDAY(B3)=1,
WEEKDAY(B3)=7)

5. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.

6. When you've finished selecting your formatting choices, click OK.
7. Return to the New Formatting Rule dialog box and double-click

the OK button to finalize your formatting rule.

Highlighting days between two dates

Some analyses need the selection of dates that fall inside a certain time
frame. The table below shows how conditional formatting may be used to
highlight dates depending on a start and end date. The conditional
formatting adapts when the start and end dates are changed.



Follow these steps to create this simple formatting rule:

1. Click the Home tab of the Excel Ribbon, then Conditional
Formatting > New Rule, and then pick the data cells in your desired
range (cells E3:E18 in this example).

2. Select Use a formula to select which cells to format from the list box
at the top of the dialog box. This option calculates values using a
formula that you define. The conditional formatting is applied to a
cell if a given value evaluates to true.

3. Type the formula indicated below into the formula input box. Note
that we're comparing the date in our target cell (E3) to the start and
end dates in cells $B$3 and $C$3, respectively, using the AND
function. The formula will evaluate to TRUE if the target cell is
between the start and finish dates, activating conditional formatting.
=AND(E3>=$B$3,E3<=$C$3)

4. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.



5. When you've finished selecting your formatting choices, click OK.
6. Return to the New Formatting Rule dialog box and double-click

the OK button to finalize your formatting rule.

Using a due date to highlight dates

The example demonstrates how to conditionally format dates that are
overdue by a specific amount of days. The dates in this scenario that are
more than 90 days past due are highlighted in red.

 

 

 

Follow these steps to create this simple formatting rule:

1. Select the Home tab of the Excel Ribbon, then Conditional
Formatting > New Rule, and then pick the data cells in your desired
range.

2. Select Use a formula to select which cells to format from the list box
that appears in the dialog box. This option calculates values using a
formula that you define. The conditional formatting is applied to a
cell if a given value evaluates to true.

3. Type the formula indicated below into the formula input box. We're
determining if today's date is more than 90 days beyond the date in
our target cell using this formula (C4). The conditional formatting
will be applied if this is the case. =TODAY()-C4>90

4. Select your preferred formatting by clicking the Format option. This
will open the Format Cells dialog box, where you may format the
font, border, and fill for your target cell using a variety of settings.

5. When you've finished selecting your formatting choices, click OK.
6. Return to the New Formatting Rule dialog box and double-click

the OK button to finalize your formatting rule.

 

 



 

 

 

 

 



CHAPTER 10
COMPREHENSION AND USE OF ARRAY

FORMULAS
One of the most intriguing (and useful) features of Excel is its ability to
work with arrays in equations. Once you understand this idea, you'll be able
to create stunning formulas that appear to perform magical spreadsheet
tricks.

Anyone interested in mastering Excel formulas must read this part, which
introduces the concept of arrays.

Knowing how to use array formulas

If you've ever done any computer programming, you've probably
encountered the idea of an array. A group of items that can be handled
jointly or individually make up an array. In Excel, an array can have one or
two dimensions. These dimensions correspond to rows and columns. An
example of a one-dimensional array would be one that has either one row
(horizontal array) or one column (vertical array) (a vertical array). A two-
dimensional array may fit into a rectangle range of cells. In Excel, three-
dimensional arrays are not supported (but its VBA programming language
does).

You'll learn that arrays don't necessarily have to be stored in cells. You can
also work with arrays that are stored exclusively in Excel's memory. After
that, you can modify the data using an array formula and then output the
changes.

There are two kinds of array formulae in Excel:

Formulas for single-cell arrays: Work with arrays that are stored in
ranges or memory to create a single-cell output.
Formulas for multicell arrays: Work with arrays that are stored in
ranges or memory to create an array. A multicell array formula is an
input into a range of cells since each cell can only contain one value.



This section contains two array formula examples, one of which fills many
cells and the other of which only occupies one cell.

An array with several cells

The table below displays a simple spreadsheet for determining product
sales. In a typical scenario, you would use a formula similar to this one to
find the value in column D and then repeat it along the column.

=B2*C2

The spreadsheet now has six formulae in column D after you replicate the
formula.

An alternate technique calculates all six values in D2:D7 using a single
formula. This single formula takes up six cells and yields a six-value array.

Follow these steps to generate a multicell array formula to execute the
calculations:

1. Choose a range in which to store the findings. The range is D2:D7 in
this example. Because a single cell cannot show more than one
value, you must choose six cells to make this array function.

2. Fill in the blanks using the following formula:
=B2:B7*C2:C7

3. To input the formula, press Ctrl+Shift+Enter. To input a formula,
you normally hit Enter. However, since this is an array formula, hit
Ctrl+Shift+Enter instead.



Note: A multicell array formula cannot be inserted into a range that has
been defined as a table (by selecting Insert Tables > Table). A table cannot
be created from a range that has a multicell array formula.

The formula is input into each of the six cells that have been chosen. When
you look at the Formula bar, you'll see the following:

{=B2:B7*C2:C7}

Excel wraps the formula in curly brackets to show that it's an array formula.

This formula works out the numbers and produces a six-item array. The
array formula is used in conjunction with two additional arrays, both of
which are kept in ranges. The first array's values are saved in B2:B7,
whereas the second array's values are kept in C2:C7.

The values returned by this multicell array formula are the same as the
values returned by these six standards formulae placed into individual cells
in D2:D7:

=B2*C2
=B3*C3
=B4*C4
=B5*C5
=B6*C6
=B7*C7

There are a few benefits to using a multicell array formula rather than
separate formulas:

It's a handy technique to make sure that every formula in a range is
the same.
Using a multicell array formula reduces the chances of mistakenly
overwriting a formula. In a multicell array formula, you can't edit or
remove only one cell. If you try to do so, Excel will give you an
error warning.
Using a multicell array formula almost eliminates the possibility of
beginners messing with your formulae.



There are various drawbacks to using a multicell array formula as
mentioned in the previous list:

It is difficult to add a new row to the range. In other circumstances,
though, the inability to introduce a row is a benefit. You may not
want users to add rows to a worksheet because it will influence other
areas of the worksheet.
If you want to add fresh data at the bottom of the range, you'll need
to change the array formula.

A single-cell array formula

It is the right time to look at a formula for a single-cell array. The formulae
in column D, on the other hand, have been removed. The purpose is to add
up all of the product sales without having to use the individual
computations from column D.

In cell C9, write the following array formula:

{=SUM(B2:B7*C2:C7)}

Make sure you hit Ctrl+Shift+Input to enter this formula (and don't worry
about the curly brackets; Excel will add them for you).



This formula uses two arrays, one of which is kept in a cell and the other in
a table. The first array is kept in B2:B7, whereas the second is kept in
C2:C7. The formula multiplies the values in these two arrays and generates
a new one (that exists only in memory). The new array has six values,
which are expressed as follows (the rationale for the semicolons is
explained later):

{150;1000;100;90;180;200}

The SUM function is then used in this new array, and the sum of its values
is returned.

In this situation, you may get the same answer without utilizing an array
formula by using the SUMPRODUCT function:

=SUMPRODUCT (B2:B7, C2:C7)

However, as you can see, array formulae enable a wide range of
computations that would otherwise be impossible.

How to Create an Array Constant

In the examples in the preceding section, arrays that were saved in
worksheet ranges were used. The examples in this section demonstrate a
key idea: an array need not be stored as a collection of cells. A type of array
that is stored in memory is referred to as a "array constant."

Write a list of the items and enclose it in curly brackets to create an array
constant. An illustration of a horizontal array constant with five entries is
given below:

{1,0,1,0,1}

The SUM function is used in the following formula, using the previous
array constant as its parameter. The total of the items in the array (which is
3) is returned using the formula:

=SUM({1,0,1,0,1})

Although this formula makes use of an array, it is not an array formula in
and of itself. As a result, you don't need to use Ctrl+Shift+Enter to enter



the formula; nonetheless, entering it as an array formula will have the same
effect.

You must include the curly brackets around the array items when specifying
an array directly (as seen earlier). The curly brackets, on the other hand, are
not required when using an array formula.

You probably don't see any benefit in utilizing an array constant at this time.
For example, the following formula yields the same outcome as the
preceding formula. The benefits, on the other hand, will become apparent:

=SUM(1,0,1,0,1)

Here's an example of a formula that makes use of two array constants:

=SUM({1,2,3,4}*{5,6,7,8})

The formula builds a new array (in memory) that is the product of the
two arrays' corresponding items. The new array looks like this:

{5,12,21,32}

The SUM function is then called with this new array as a parameter, and the
result is returned (70).

The following formula, which does not employ arrays, is identical to the
previous one:

=SUM (1*5,2*6,3*7,4*8)

On the other hand, the SUMPRODUCT function may be used. Although
the following formula is not an array formula, it does employ two array
constants as arguments:

=SUMPRODUCT({1,2,3,4},{5,6,7,8})

Both an array constant and an array stored in a range may be used in a
formula.

The sum of the values in A1:D1 multiplied by the corresponding element in
the array constant, for example, is returned using the following formula:

=SUM ((A1:D1*{1,2,3,4})



 

The following is the corresponding formula:

=SUM(A1*1,B1*2,C1*3,D1*4)

Numbers, text, logical values (TRUE or FALSE), and even error values like
#N/A may be stored in an array constant. Integer, decimal, and scientific
numbers are all acceptable. Double quotation marks must be used to
enclose content. In the same array constant, you may utilize several sorts of
values, like in this example:

{1,2,3,TRUE,FALSE, TRUE,"Moe","Larry","Curly"}

Formulas, functions, or other arrays cannot be included in an array constant.
Dollar signs, commas, parenthesis, and percent signs are not allowed in
numerical numbers.

The following is an example of an incorrect array constant:

SQRT (32), $56.32,12.5% SQRT (32), $56.32,12.5%

Identifying an Array's Dimensions

As was already said, an array can be either one or two dimensions. A one-
dimensional array can be vertical or horizontal, which corresponds to many
rows or one row respectively (corresponding to a single column).

Horizontal arrays in one dimension

One-dimensional horizontal array members are separated by commas and
can be displayed as a row of cells. A semicolon can be used as a list
separator if you're using Excel in a language other than English.

A one-dimensional horizontal array constant is shown below:

{1,2,3,4,5}

This array must be shown in a range of five cells in a row. Select a range of
cells with one row and five columns to input this array into a range.

Then press Ctrl+Shift+Input to enter the following formula:



={1,2,3,4,5}

If you put this array into a horizontal range with more than five cells, the
excess cells will be filled with #N/A. (which denotes unavailable values).
Only the first item (1) will display in each cell if you insert this array into a
vertical range of cells.

Another horizontal array, with seven entries and made out of text
strings, is seen below:

{"Sun","Mon","Tue","Wed","Thu","Fri","Sat"}

Select seven cells in a row and write the following (and then press
Ctrl+Shift+Enter) to enter this array:

={"Sun","Mon","Tue","Wed","Thu","Fri","Sat"}

One-dimensional vertical arrays

Semicolons separate the items of a one-dimensional vertical array, which
may be shown in a column of cells.

A six-element vertical array constant is as follows:

{10;20;30;40;50;60}

Six cells in a column are required to display this array in a range. Select a
range of cells with six rows and one column to input this array into a range.

 

Then press Ctrl+Shift+Input and enter the following formula:

= {10;20;30;40;50;60}

Another example of a vertical array with four components is as follows:

{"Widgets";"Sprockets";"Doodads";"Thingamajigs"}

Two-dimensional arrays

A two-dimensional array uses the horizontal and vertical members of a two-
dimensional array are separated by commas and semicolons, respectively. If
you're using Excel in a language other than English, the item-separator



character might be a semicolon (for horizontal items) or a backslash (for
vertical elements) (for vertical elements).

If you're not sure, look at the two-dimensional array in the section's
example file. The item-separator characters are converted to your language
version automatically.

A 3 4 array constant is shown in the following example:

{1,2,3,4;5,6,7,8;9,10,11,12}

This array needs 12 cells to display in a range. Select a range of cells with
three rows and four columns to input this array into a range.

 Then hit Ctrl+Shift+Enter and input the following formula:



= {1,2,3,4;5,6,7,8;9,10,11,12}

Excel shows #N/A in the additional cells when you input an array into a
range with more cells than array elements.

A two-dimensional array must have the same number of elements in each
row.

The following array, for example, is invalid since the third row only
includes three items:

{1,2,3,4;5,6,7,8;9,10,11}

Excel won't let you insert a formula with an incorrect array in it.

Naming Array Constants

You can create an array constant, name it, and then utilize it in a calculation.
A named array is a named formula in technical terms.

The array's name is DayNames, and it relates to the array constant
DayNames:

{"Sun","Mon","Tue","Wed","Thu","Fri","Sat"}

The array is specified (in the Refers To field) in the New Name dialog box
with a leading equal sign (=). The array is regarded as a text string rather



than an array without this equal sign. When creating a named array
constant, you must type the curly brackets yourself; Excel does not do it for
you.

You can use this named array in a formula once you've created it.

The following is the formula:

{=DayNames}

Select seven cells in a row, type =DayNames, and press Ctrl+Shift+Enter
to enter the formula.

The array has a horizontal orientation since the array items are separated by
commas. Create a vertical array using semicolons, or insert a horizontal
array into a vertical range of cells with the Excel TRANSPOSE function.

The TRANSPOSE function is used in the following array formula,
which is inserted into a seven-cell vertical range:

{=TRANSPOSE(DayNames)}

/The Excel INDEX function may also be used to retrieve specific items
from the array.

For example, the following formula yields Wed, the fourth entry in the
DayNames array:

=INDEX(DayNames,4)

Working with Array Formulas

This section covers how to select cells that contain arrays, as well as how to
input and amend array formulae. Working with regular ranges and formulae
differs somewhat from these approaches.

Entering an array formula

When you input an array formula into a cell or range, you must use a
unique process to tell Excel that you want an array formula instead of a
regular formula. By hitting Insert, you may enter a standard formula into a



cell. By using Ctrl+Shift+Input, you can enter an array formula into one or
more cells.

When you write an array formula, Excel automatically adds the curly
brackets. If an array formula returns more than one value, you must first
select all of the cells in the results range before entering the formula. If you
don't, you'll just get the first element of the result.

You may use the regular cell selection processes to manually choose the
cells that contain a multicell array formula, or you can use one of the
following methods:

Select any cell in the array formula range to activate. Choose
Editing Find & Select Go To from the Home menu, or just press
F5. The dialog box "Go-To" displays. Click the Special button in
the Go To dialog box, then the Current Array option. To exit the
dialog box, click OK.
Select the cells that make up the array by pressing Ctrl+/ (forward
slash) on any cell in the array formula range.

Choosing a formula range for an array

If an array formula covers more than one cell, you must alter the entire
range as if it were a single cell. It's crucial to realize that you cannot simply
change one component of a multicell array formula.

To change an array formula, select every cell in the array range and use the
Formula bar as usual. (Click it or press F2.) Excel removes the curly
brackets while editing the calculation. After modifying the formula, hit
Ctrl+Shift+Enter to apply the changes. The array's cells have all been
updated to reflect your changes (and the curly brackets reappear).

The formulas for multicell arrays must adhere to the following guidelines.

If you attempt to perform any of these things, Excel warns you:

The contents of any individual cell in an array formula cannot be
changed.
Cells that are part of an array formula cannot be moved (but you can
move an entire array formula).



It's impossible to remove cells that are included in an array formula.
In an array range, you can't add additional cells. This rule allows you
to add additional cells to an array range by adding rows or columns.
You can't utilize multicell array formulae in a table generated using
the Insert Tables Table option. Similarly, if a range has a multicell
array formula, it cannot be converted to a table.

If you hit Ctrl+Enter (rather than Ctrl+Shift+Enter) after altering an array
formula, the formula will be put into each chosen cell, but it will no again
be an array formula and will most likely yield an inaccurate result. Simply
click this button once again, press F2, then Ctrl+Shift+Enter.

Although you can't modify the contents of every individual cell in a
multicell array formula, you may apply formatting to the whole array or just
sections of it.

Expanding or contracting a multicell array formula

You might need to enlarge or decrease a multicell array formula regularly
(to include fewer cells).

To do so, you'll need to do the following steps:

1. Select the full range in which the array formula is included.
2. To enter Edit mode, press F2.
3. Press Ctrl+Enter on your keyboard. This phase fills each chosen

cell with an identical (non-array) formula.
4. Adjust your range selection to include more or fewer cells, but make

sure the active cell is one of the original array's cells.
5. To return to Edit mode, press F2.
6. Press Ctrl+Shift+Enter on your keyboard.

THE CONTRARY OF ARRAY FORMULAS

You are already aware of certain advantages of using array formulas if you
have read this far. The main advantage is that array formulas let you
perform calculations that would be otherwise impossible. However, you
will find several limitations as you gain more experience utilizing arrays.



One of Excel's most misunderstood features is array formulas. Because of
this, it's generally advised to stay away from using array formulae when
sharing a worksheet with someone who might need to make modifications.
It could be confusing if you don't know what an array formula is.

You could easily forget to enter an array formula while using
Ctrl+Shift+Input. (When changing an existing array, keep in mind to press
these keys to complete the edits. Aside from logical issues, this is likely the
most common problem with array formulas. If you mistakenly press Enter
after making changes to an array formula, simply press F2 to restore to Edit
mode, then press Ctrl+Shift+Enter.

Another issue with array formulae is that they may slow down the
recalculation of your worksheet, particularly if you employ extremely big
arrays. This speed difference may not be an issue with a faster system.
Utilizing an array formula, on the other hand, is usually always quicker than
using a bespoke VBA function.

Using Multicell Array Formulas

This section offers examples that show how to use multicell array formulae
in new ways (array formulas that are entered into a range of cells). Arrays
can be created from values, operations can be performed, functions can be
used, arrays may be transposed, and consecutive integers can be generated.

Creating an array from values in a range

The array formula below produces an array from a set of cells. A single
array formula may be found in the range D8:F11:

{=A1:C4}

The range A1:C4 is connected to the array in D8:F11. Any modification
you make in A1:C4 is reflected in the appropriate cell in D8:F11. Of course,
it's a one-way street. In D8:F11, you can't modify any of the values.

Creating an array constant from values in a range

The array formula in D8:F11 in the previous example effectively built a
connection between the cells in A1:C4. It's possible to break this connection



and make an array constant from the values in A1:C4:

1. Find the cells that have the array formula in them (the range D8:F11,
in this example).

2. To change the array formula, press F2.
3. To convert cell references to values, press F9.
4. To re-enter the array formula, press Ctrl+Shift+Enter (which now

uses an array constant).

The following is the array constant:

{1,"dog",3;4,5,"cat";7,False,9;"monkey",8,12}

Performing operations on an array

The majority of this chapter's examples have simply inserted arrays into
ranges. The array formula below builds a rectangular array by multiplying
each array element by two:

{={1,2,3,4;5,6,7,8;9,10,11,12}*2}



Each array element is multiplied by itself using the following array
formula:

{={1,2,3,4;5,6,7,8;9,10,11,12}*{1,2,3,4;5,6,7,8;9,10,11,12}}

An easier approach to get the same result is to use the array formula below.

The array formula yields the square of each value in the range if the array is
stored in a range (such as B8:E10):

{=B8:E10^2}

Using functions with an array

You can utilize worksheet functions with an array, as you would think.

The square root of each array element in the array constant is calculated
using the following array formula, which you may insert into a ten-cell
vertical range:

{=SQRT ({1;2;3;4;5;6;7;8;9;10})}

A multicell array formula, like the one below, yields the square root of
each value in the range if the array is stored in a range:

{=SQRT (A1:A10)}

Transposing an array



You effectively transform rows to columns and columns to rows when you
transpose an array. In other words, a horizontal array can be converted to a
vertical array (and vice versa). To transpose an array, use the TRANSPOSE
function.

Consider the following constant for a one-dimensional horizontal
array:

{1,2,3,4,5}

The TRANSPOSE function may be used to input this array into a vertical
range of cells. To do so, choose a five-cell range that spans five rows and
one column. Then press Ctrl+Shift+Input to enter the following formula:

=TRANSPOSE({1,2,3,4,5})

The array items appear in the vertical range after the horizontal array has
been transposed.

Similarly, transposing a two-dimensional array works. The table below
illustrates a two-dimensional array that has been input into a range both
manually and through the TRANSPOSE function.

In A1:D3, the formula is as follows:

{={1,2,3,4;5,6,7,8;9,10,11,12}}

In A6:C9, the formula is as follows:

{=TRANSPOSE ({1,2,3,4;5,6,7,8;9,10,11,12})}

To transpose an array stored in a range, you may, of course, use the
TRANSPOSE function. For example, in the calculation below, an array
stored in A1:D3 is used (three rows, four columns).

This array formula may be entered into a three-row; four-column
range as follows:

{=TRANSPOSE (A1:C4)}

Making an array of sequential integers



It is typical to require the creation of an array of sequential numbers for use
in a challenging array formula.

Here is where the ROW method, which yields a row number, is useful.
Consider the array formula below, which was entered into a vertical 12-cell
range:

{=ROW (1:12)}

With numbers ranging from 1 to 12, this formula creates a 12-element array.
Create a range with 12 rows and 1 column to serve as an example before
adding the array formula. You'll notice that the range has 12 numbers that
follow one another.

A formula like the one presented above is good—but not perfect—for
generating an array of consecutive numbers. Insert a new row above the
range containing the array formula to observe the issue.

Excel changes the row references to make the array formula look like
this:

{=ROW (2:13)}

The method that previously produced numbers ranging from 1 to 12 now
produces integers ranging from 2 to 13.

Use this formula for a better result:

{=ROW (INDIRECT ("1:12"))}

The INDIRECT function, which accepts a text string as a parameter, is used
in this formula. The references in the INDIRECT function's parameter are
not adjusted by Excel. As a result, integers from 1 to 12 are always returned
by this array formula.

Worksheet Functions That Return an Array

Arrays are used by many Excel worksheet functions; you must input a
formula that employs one of these functions as an array formula into several
cells. FORECAST, FREQUENCY, GROWTH, LINEST, LONGEST,



MINVERSE, MMULT, and TREND are some of the functions available.
For further information, go to the Excel Help system.

Using Single-Cell Array Formulas

The previous section's examples all employed a multicell array formula,
which is a single array formula that is inserted into a set of cells. When you
employ single-cell array formulae, the true power of arrays is shown. This
section includes instances of array formulae that only take up one cell.

Counting characters in a range

Assume you have a set of cells with text entries in them. The
"conventional" approach of getting a count of the total number of
characters in that range includes developing a formula like the one below
and copying it along the column:

=LEN(A1)

The total of the values produced by these intermediary formulae is then
calculated using a SUM formula.



Without requiring any intermediary formulae, the following array
formula accomplishes the task:

{=SUM (LEN (A1:A14))}

The LEN function is used in the array formula to construct a new array (in
memory) with the number of characters in each cell in the range.

The new array in this example is as follows:

{10,9,8,5,6,5,5,10,11,14,6,8,8,7}

After that, the array formula is simplified to:

=SUM({10,9,8,5,6,5,5,10,11,14,6,8,8,7})

The sum of the array items is given using the formula: 112.

Summing the three smallest values in a range

If you have values in a Data range, you can use the SMALL function to get
the smallest value:

=SMALL(Data,1)

Using the following formulae, you may get the second and third smallest
values:

=SMALL(Data,2)

=SMALL(Data,3)

You can use a formula like this to sum the three lowest values:

=SUM(SMALL(Data,1), SMALL(Data,2), SMALL(Data,3))

Although this technique works, an array formula is more efficient. The
array formula below produces the sum of the three lowest values in the
Data: range.

{=SUM (SMALL (Data, {1,2,3}))}

The SMALL function is called with an array constant as the second
parameter. This creates a new array that contains the range's three smallest



values. The SUM function is then supplied to this array, and it returns the
sum of the items in the new array.

In the table below, the range A1:A10 is labeled Data as an example. The
SMALL function is evaluated three times, with each second input being
different. The SMALL function has a second parameter of 1 the first time
it is used, and it returns –5.

The second time, the SMALL function's second parameter is 2, and it
returns 0. (The second smallest value in the range). The SMALL function
has a second input of 3 for the third time, and it returns the third lowest
value of 2.

As a result, the array provided to the SUM method looks like this:

{-5,0,2)

The formula yields the array's sum (–3).

Counting text cells in a range

Consider the situation in which you need to count the number of text cells
in a range. The COUNTIF function seems to be appropriate for this
purpose, however, it isn't. COUNTIF is only helpful if you want to count
data in a range that fits a certain set of criteria (for example, values greater
than 12).

An array formula is required to count the number of text cells in a range.
The IF function is used in the following array formula to inspect each cell
in a range. It then constructs a new array of 1s and 0s (of the same size and
dimensions as the original range) based on whether the cell contains the
text. The SUM function is then supplied to this new array, which returns the
sum of the array's components.

The amount of text cells in the range is counted as follows:

{=SUM(IF(ISTEXT(A1:D5),1,0))}

This formula produces the following array:

{0,1,1,1;1,0,0,0;1,0,0,0;1,0,0,0;1,0,0,0}



It's worth noting that this array has five rows of four items (the same
dimensions as the range).

This formula may be tweaked to make it significantly more efficient:

{=SUM (ISTEXT (A1:D5) *1)}

This method obviates the requirement for the IF function by using the fact
that

1 * TRUE = 1 and 1 * FALSE = 0

The removal of intermediate formulas

The ability to routinely delete intermediate formulas from your worksheet,
making it more compact and removing the need to display computations
that aren't necessary, is one of the array formula's key benefits. The table
below displays a worksheet with students' pre- and post-test scores. The
variations between the pre-test and post-test scores are calculated in
Column D.



You may get rid of column D by using an array formula.

  The average of the modifications may be calculated using the array
formulae below, which do not need the calculations in column D:

{=AVERAGE (C2:C15-B2:B15)}

What is the mechanism behind it? The formula makes use of two arrays,
whose values are kept in two different ranges (B2:B15 and C2:C15). The
formula generates a new array that contains the differences between each of
the other arrays' corresponding elements. This new array is not saved in a
range, but rather in Excel's memory. The result is returned by the
AVERAGE function, which takes this new array as an input.

The following items make up the new array, which was created by
combining the two ranges:

{11,15,-6,1,19,2,0,7,15,1,8,23,21,-11}



As a result, the formula is equal to:

=AVERAGE ({11,15,-6,1,19,2,0,7,15,1,8,23,21,-11})

7.57 is the result of Excel evaluating the function and displaying the results.

Other measurements for the data in this example may be calculated using
other array formulae. The following array formula, for example, yields the
biggest change (that is, the greatest improvement). The result of this
calculation is 23, which corresponds to Linda's test results.

{=MAX (C2:C15-B2:B15)}

The following array formula produces the Change column's lowest value.

This formula yields –11, which corresponds to Nancy's test results:

{=MIN(C2:C15-B2:B15)}

Replacing a range reference with an array

You might be able to use an array constant in place of a range reference if
that is what the formula's function requires. This is advantageous when
there is no change in the values of the referred range.

One notable exception to using an array constant instead of a range
reference in a function is the database functions, which demand a reference
to a criterion range (for example, DSUM). Unfortunately, it is not possible
to use an array constant in place of a reference to a criterion range.

In the lookup table in D1:E10, searching for the number 9 produces the
result 9, for instance. The formula for cell C1 is:

=VLOOKUP (B1, D1:E10,2, FALSE)

Instead of the lookup range, you may use a two-dimensional array. The
following formula gives the same answer as the previous one, except it
doesn't use the D1:E10 lookup range.

=VLOOKUP (B1,{1,"One";2,"Two";3,"Three";4,"Four"

 



 

 

 

 

 

 

 

 

 

 

 



CHAPTER 11
IMPROVE THE RELIABILITY OF YOUR

FORMULAS
It should come as no surprise that you want your Excel spreadsheets to
produce accurate results. Unfortunately, it's not always easy to be confident
that the results are accurate, especially when working with large, complex
workbooks. The methods and tools for identifying, fixing, and preventing
problems are described in this section.

Detecting and fixing formula errors

Even a minor change to a worksheet could have a cascading effect and lead
to errors in nearby cells. For instance, it's far too easy to enter a value into a
cell that once contained a formula. If you notice this small error at all, it
might not have a significant impact on other computations until after the
modification has been implemented.

Formula mistakes usually fall into one of the following categories:

Mistakes in syntax: You're having trouble with a formula's syntax.
A formula, for example, might contain mismatched parenthesis, or a
function could have an incorrect amount of parameters.
Errors in logic: A formula does not yield an error, but it does have a
logical fault that leads to an inaccurate result.
Incorrect reference mistakes: Although the formula's reasoning is
accurate, it utilizes an improper cell reference. The range reference
in a Total calculation, for example, may not cover all of the data you
wish to sum.
Semantic blunders: A poorly spelled function name is an example.
The #NAME? the error will appear if Excel tries to interpret it as a
name.
References in a circle: A circular reference arises when a formula,
either directly or indirectly, refers to its cell. Circular references are
beneficial in a few situations, but they almost always signal a
problem.



Invalid array formula entry: Entering (or modifying) an array
formula requires pressing Ctrl+Shift+Enter. If you don't, Excel
won't recognize the formula as an array formula, resulting in an error
or inaccurate results.
Calculation mistakes: The formulae are just not completely
computed. Ctrl+Alt+Shift+F9 will verify that your formulae are
completely computed.

Syntax mistakes are generally the most straightforward to see and remedy.
In most circumstances, you'll be able to tell whether your formula has a
syntactic issue. Excel, for example, won't let you input a formula that has
misaligned parenthesis. Other syntax problems frequently result in the cell
displaying an error message.

Erroneous parentheses

A right parenthesis must come after every left parenthesis in a formula. In
most cases, Excel won't allow you to insert a formula with incorrect
parenthesis. Using a function in a straightforward formula is an exception to
this rule. Excel accepts the following formula and adds the missing
parenthesis when you input it:

=SUM (A1:A500

 



Even though a formula has the same amount of left and right parenthesis,
the parentheses may not be correctly aligned. Consider the following
formula, which changes a text string to uppercase for the first letter and
lowercase for the remaining characters. There are five pairs of parentheses
in this formula, and they all match:

=UPPER(LEFT(A1)) &RIGHT(LOWER(A1), LEN(A1)-1)

There are five pairs of parentheses in the following formula, however, they
are misaligned.

The result shows a syntactically accurate formula that yields the
incorrect outcome:

=UPPER(LEFT(A1) &RIGHT(LOWER(A1), LEN(A1)-1))

A syntax error, which is generally a warning telling you that you provided
too many or too few parameters for a function, is often caused by
parenthesis in the incorrect place.

 

Note: When it comes to a misaligned parenthesis, Excel can assist. When
you move the cursor over a parenthesis in a calculation, Excel highlights it
(and its corresponding parenthesis) in bold for roughly a half-second.
Furthermore, when revising a calculation, Excel color-codes pairs of nested
parentheses.

USING FORMULA AUTOCORRECT

When you input formula with a syntax mistake, Excel tries to figure out
what's wrong and suggests a solution.

When accepting Excel's adjustments for your formulae, keep in mind that it
doesn't always predict properly.

Let's say you typed in the following formula (which has misaligned
parentheses):

=AVERAGE (SUM (A1:A12, SUM (B1:B12))

Excel then suggests the following formula correction:



=AVERAGE (SUM (A1:A12, SUM (B1:B12)))

You can be inclined to accept the proposal without even thinking about it.
The recommended formula is syntactically accurate in this circumstance,
but it is not what you wanted.

Here's how to use the right formula:

=AVERAGE (SUM (A1:A12), SUM (B1:B12))

 

 

Cells are filled with hash marks

A succession of hash marks (#) is used to fill a cell for one of two
reasons:

The width of the column is insufficient to fit the formatted numeric
value. You may make the column broader or use a different number
format to fix it.
A formula in the cell yields an incorrect date or time. Excel, for
example, does not allow for dates before 1900 or the usage of
negative time values. A cell filled with hash marks is the outcome of
a formula that produces one of these values. It won't be fixed by
widening the column.

No cell is completely empty.

A common observation among Excel users is that pressing the spacebar
appears to empty a cell's contents. The spacebar does not really delete the
cell; instead, it inserts an invisible space character.



The following formula, for example, yields the number of nonempty cells in
the range A1:A10.

If you use the spacebar to "erase" any of these cells, they are included
in the count, and the formula yields an inaccurate result:

=COUNTA (A1:A10)

If your formula fails to disregard blank cells as it should, double-check that
the blank cells are indeed blank.

Here's how to look for cells that only have blank letters in them:

1. Press Ctrl+F on your keyboard.
2. To enlarge the dialog box and see other choices, click the Options

button.
3. Type * * in the Find What box. That's an asterisk, then a space, and

then another asterisk.
4. Select Match Entire Cell Contents from the drop-down menu.
5. Select "Find All." Excel provides the cell address at the bottom of

the Find and Replace dialog box if any cells contain just space
characters.

Characters with extra space



Make sure your text doesn't contain any extra space characters if you have
formulas or processes that rely on text comparison. It's extremely common
to include a space character when importing data from another source.

However, trailing spaces in text entries are not immediately removed by
Excel when you enter numbers. It's difficult to tell from the surface of a cell
if one or more trailing space characters are present.

The TRIM function can be used to locate values that contain leading,
trailing, or numerous spaces within a text string. This formula will return
FALSE if the text in cell A1 contains any leading, trailing, or multiple
spaces.

=TRIM(A1) =A1

Formulas returning an error

Any of the following error values may be returned by a formula:

#DIV/0!
#N/A
#NAME?
#NULL!
#NUM!
#REF!
#VALUE!

The sections that follow go through some of the issues that might be
causing these errors.

You can select how error data are displayed in Excel. Display the Page
Setup dialog box and pick the Sheet tab to use this functionality. You may
select to publish incorrect values as blank cells, dashes, or #N/A instead of
as presented (the default). To open the Page Setup dialog box, click the
Page Layout > Page Setup group's dialog box launcher.

TRACING ERROR VALUES

A mistake in one cell is often the consequence of a mistake in a preceding
cell. Activate the cell that contains the problem and then choose Formulas



> Formula Auditing > Error Checking > Trace Error for assistance in
locating the cell that is causing the error value to display. Excel uses arrows
to show which cell is causing the problem.

To remove the arrow display, go to Formulas Formula Auditing Remove
Arrows once you've identified the issue.

#DIV/0! errors

It is not possible to divide by zero. When you try to divide by zero in a
calculation, Excel shows the familiar #DIV/0! error value.

Because Excel considers a blank cell to be zero, if your formula divides by
a missing value, you'll see this error.

To prevent the error message, check for a blank cell using an IF function.

If cell B4 is blank or contains 0, for example, this formula will show an
empty text; otherwise, it will display the computed value:

=IF (B4=0,"“, C4/B4)

Another option is to check for any error conditions using an IFERROR
function.

If any sort of mistake occurs, the following formula, for example,
produces an empty string:

=IFERROR(C4/B4,"")

Excel 2007 introduces the IFERROR function. Use this formula for
compatibility with prior Excel versions:

=IF(ISERROR(C4/B4),"“, C4/B4)

#N/A errors

If any cell referenced by a formula shows #N/A, the #N/A error occurs.

For missing data, some users prefer to use =NA () or #N/A directly. This
strategy makes it quite evident that the data isn't accessible and wasn't
unintentionally removed.



When a LOOKUP function (HLOOKUP, LOOKUP, MATCH, or
VLOOKUP) can't discover a match, the #N/A error appears.

If you want to replace #N/A with an empty string, use the IFNA
function in a calculation like this:

=IFNA (VLOOKUP (A1, C1:F50,4, FALSE),"")

Excel 2013 introduces the IFNA function. Use the following formula for
compatibility with prior versions:

==IF(ISNA(VLOOKUP(A1,
C1:F50,4,FALSE)),"",VLOOKUP(A1,C1:F50,4,FALSE))
IF(ISNA(VLOOKUP(A1,C1:F50,4,FALSE)),"“,
VLOOKUP(A1,C1:F50,4,FALSE))

#NAME? errors

The #NAME? an error occurs when the following criteria are met:

There is an undefined range or cell name in the formula.
Excel reads the text in the formula as an undefined name. A
#NAME? error, for example, is caused by a misspelled function
name.
There is material in the formula that isn't surrounded by quotation
marks.
A range reference in the calculation omits the colon between the cell
addresses.
The formula utilizes a worksheet function specified in an add-in that
isn't installed, and the add-in isn't installed.

Range names are a bit of a stumbling block in Excel. If you remove a name
for a cell or a range, but the name is still used in a formula, the formula uses
the name even if it is no longer defined. As a consequence,, #NAME?
appears in the formula. Excel should transform the names to their
appropriate cell references automatically, however, this does not happen.

#NULL! Errors



When a formula tries to utilize an intersection of two ranges that don't truly
intersect, a #NULL! error occurs. The intersection operator in Excel is a
space.

Because the two ranges do not cross, the following calculation produces
#NULL:

=TOTAL (B5:B14 A16:F16)

The formula below does not yield #NULL! However, the contents of cell
B9, which represents the junction of the two ranges, are displayed:

=TOTAL (B5:B14 A9:F9)

If you forget to include an operator in a formula, you'll get a #NULL! error.

This formula, for example, is lacking the second operator:

= A1+A2+A3+A4+A5+A6+A7+A

#NUM! errors
 

 

 

If any of the following happens in a formula, it will yield a #NUM!
error:

When a number parameter is anticipated, you supply a non-numeric
argument to a function (for example, $1,000 instead of 1000).
You try to compute the square root of a negative value by passing an
incorrect parameter to a function. #NUM! is the result of this
formula: =SQRT(-12)
A function that employs iteration is incapable of calculating a result.
IRR and RATE are two functions that employ iteration.
A formula produces a result that is either too big or too tiny. Excel
accepts values ranging from –1E-307 to 1E+307.

#REF! errors



When a formula employs an improper cell reference, a #REF! error occurs.
The following scenarios may lead to this error:

You remove the row-column of a cell that the formula refers to. If
row 1, column A, or column B are removed, the following
calculation produces a #REF! error: =A1/B1
You remove the worksheet of a cell that the formula refers to. If
Sheet2 is removed, for example, the following calculation returns a
#REF! error: =Sheet2!A1
You copy a formula to a position where the related cell references are
no longer valid. If you duplicate the following formula from cell A2
to cell A1, for example, the formula returns #REF! because it tries to
refer to a cell that doesn't exist: =A1-1
You clip a cell and then paste it into a formula-referenced cell.
#REF! will be displayed by the formula.

#VALUE! Errors

VALUE FOR MONEY! Error is a frequent occurrence that may occur
under the following circumstances:

A function parameter is of the wrong data type, or the formula tries
to execute an operation with invalid data. A formula that adds a
value to a text string, for example, yields the #VALUE! error.
The parameter to a function is a range when it should be a single
value.
There is no calculation for a bespoke worksheet function. To force a
recalculation, use Ctrl+Alt+F9.
A custom worksheet function tries to do something that isn't
possible. Custom functions, for example, cannot affect the Excel
environment or make modifications to other cells.
When inputting an Array formula, you neglect to use
Ctrl+Shift+Enter.

BE AWARE OF THE COLORS.

When you change a cell using a formula in Excel, the cell and range
references are color-coded. Similar colors are also used by Excel to



highlight the columns and ranges that were used in the calculation. As a
result, you can quickly identify the cells that are used in the formula.

By adjusting the color outline, you can easily change the cell or range
reference. To change the references used in a computation, drag the border
or fill handle of the outline (at the lower right of the outline). In many cases,
this approach is more practical than changing the formula.

issues with operator precedence

As was already indicated, Excel offers some straightforward guidelines for
carrying out mathematical operations in the proper order.

When in doubt (or merely to explain your intentions), use parenthesis to
guarantee that actions are carried out in the right sequence. The following
formula, for example, multiplies A1 by A2 and then adds 1 to the result.
Because it has a greater order of precedence, the multiplication is done
first:

=1+A1*A2

This formula is explained in more detail below. The parenthesis isn't
required, although the sequence of operations is evident in this case:

=1+(A1*A2)

The symbol for the negation operator is the same as the symbol for the
subtraction operator.

As you may think, this might lead to some uncertainty. Take a look at these
two formulas:

=-3^2

=0-3^2

The first formula yields 9, as predicted. The second formula, on the other
hand, yields –9. How can Excel return the –9 result when squaring a
number always yields a positive result?

The negative sign is a negation operator in the first formula, and it has the
greatest precedence. The negative sign, on the other hand, is a subtraction



operator in the second formula, which has lower precedence than the
exponentiation operator. As a consequence, the number 3 is squared and
then subtracted from 0 (zero), resulting in a negative result.

When you use parenthesis in a calculation like this, Excel interprets the
operator as a minus sign rather than a negation operator. –9 is the result of
this formula:

=-(3^2)

There is no calculation of formulas

If you use specially created spreadsheet functions written in VBA, you'll
see that the equations that depend on them don't recalculate, giving
erroneous results. Let's say you created a VBA code that, for instance,
returns the number format of a referenced cell. If you alter the number
format, the function will continue to display the old format. This is due to
the fact that changing a number's format does not necessitate a new
calculation.

Select the cell, press F2, and then press Enter to compel a single formula
to be computed. Ctrl+Alt+F9 will require a recalculation of all formulae.

Problems with decimal precision

Computers, by their very nature, do not have unlimited accuracy. Excel uses
8 bytes to store integers in binary format, which can handle values with a
15-digit precision. Because certain numbers cannot be stated properly with
8 bytes, they are saved as an approximation.

Enter the following calculation in cell A1 to see how this lack of accuracy
might create issues:

= (5.1-5.2) +1

The final score should be 0.9. If you style the cell to show 15 decimal
places, you'll see that Excel calculates the formula as 0.899999999999999.
Because the action in parentheses is done first, and the intermediate result is
stored in binary code using an approximation, this outcome happens. The



formula then multiplies this number by one, propagating the approximation
mistake to the final result.

In most circumstances, this sort of inaccuracy isn't a major issue. However,
if you need to verify the formula's outcome using a logical operator, this
might be an issue. The following formula, for example, yields FALSE
(assuming the preceding formula is in cell A1):

=A1=.9

Using the ROUND function as a remedy to this sort of issue is one option.

Because the comparison is conducted using the value in A1 adjusted to
one decimal point, the following calculation yields TRUE:

=ROUND(A1,1) =0.9

Another example of a "precision" issue may be found here.

Try putting the following formula into your calculator:

= (1.333-1.233) -(1.334-1.234)

This formula should give you 0 but instead gives you -2.22045E-16 (a
number very close to zero).

If cell A1 has that formula, the following formula yields Not Zero:

=IF(A1=0,"Zero","Not Zero")=IF(A1=0,"Zero","Not Zero")=IF(A1=0

A formula like this may be used to deal with these "extremely near to
zero" rounding errors:

=IF(ABS(A1)1E-6,"Zero","Not Zero") =IF(ABS(A1)1E-6,"Zero","Not
Zero")

The less-than operator () is used in this formula to compare the absolute
value of a number to a very tiny number. The result of this formula is zero.

“Phantom link” errors

When you open a workbook, you could see a prompt asking whether you
want to update the workbook's links. Even if a worksheet includes no



related formulae, this notice may occur. These phantom connections are
often produced when you duplicate a worksheet with names.

To open the Edit Links to Files dialog box, go to File > Info > Edit Links
to Files. Then, for each connection, pick it and click Break Link. If it
doesn't work, the phantom link might be created by an incorrect name.
Select Formulas > Defined Names > Name Manager and navigate
through the Name Manager dialog box's list of names. If you come across
a name that contains the word #REF!, remove it. The Filter button in the
Name Manager dialog box allows you to filter the names. You may, for
example, filter the lists to show just the names that have mistakes.

Using Excel Auditing Tools

Excel comes with a variety of features that might assist you in locating
formula problems. The auditing tools integrated into Excel are described in
this section.

Identifying cells of a particular type

The Go to Special dialog box is a useful tool for quickly finding cells of a
certain kind. Choose Home > Editing > Find & Select > Go to Special to
open this dialog box.

The command only works inside the chosen cells if you pick a multicell
range before showing the Go to Special dialog box. When just one cell is
chosen, the command is applied to the whole worksheet.

The Go to Special dialog box can be used to select cells of a certain kind,
which can help you find mistakes. When you pick the Formulas option, for
example, Excel selects all of the cells that contain a formula. You can also
get a good feel of the worksheet's arrangement by zooming it out to a tiny
size.

Use the zoom controls on the right side of the status bar or press Ctrl while
using your mouse's scroll wheel to magnify a worksheet.

Selecting the formula cells can also help you catch a typical mistake, such
as a formula that has been changed by a value by accident. If a cell in a



group of chosen formula cells isn't selected, it's likely that the cell formerly
had a formula that has been replaced with a value.

Viewing formulas

By presenting the formulae rather than the outcomes of the formulas, you
may get comfortable with an unfamiliar worksheet. Choose Formulas >
Formula Auditing > Show Formulas to alter the presentation of formulas.

Before running this command, you may wish to open a second window for
the workbook. You can view the formulae in one window and the formula
results in the other window in this manner. To launch a new window,
choose View > Window > New Window.

Note: Toggle between Formula and Normal views, hit Ctrl+' (the accent
grave key, normally situated above the Tab key).

Tracing cell relationships

You should be acquainted with the following two principles before learning
how to trace cell relationships:

Precedents in the cell: A formula cell's antecedents are all of the
cells that contribute to the formula's outcome and are only applicable
to cells that include a formula. A direct precedent is a cell that
appears in the formula directly. A cell that isn't utilized directly in
the formula but is referenced in the formula is known as an indirect
precedent.
Cell dependents: These formula cells are dependent on a certain
cell. The dependents of a cell are all formula cells that utilize it. The
formula cell might be a direct or indirect dependent once again.

Consider the following formula, which was placed into cell A4:

=SUM(A1:A3)

Three antecedent cells (A1, A2, and A3) are all direct precedents in cell A4.
At least one dependent cell exists in each of the A1, A2, and A3 cells (cell
A4).



Finding cell precedents for a formula cell may frequently reveal why the
formula isn't operating properly. Knowing which formula cells are
dependent on a certain cell, on the other hand, is useful. Whether you're
going to remove the formula, for example, you may want to see if it has any
dependencies.

Identifying precedents

There are many approaches to identifying cells in the active cell that are
utilized by a formula:

Press the F2 key. The cells that the formula uses directly are
highlighted in color, and the color matches the cell reference in the
formula. This method can only be used to find cells on the same
sheet as the formula.
Select Home > Editing > Find & Select from the drop-down menu.
To open the Go to Special dialog box, choose Go to Special. Select
Precedents, then Direct Only (for direct precedents only) or All
Levels (for all levels of precedents) (for direct and indirect
precedents). Excel picks the preceding cells for the calculation when
you click OK. This method can only be used to find cells on the
same sheet as the formula.
Hold down Ctrl+[. On the active sheet, this picks all direct precedent
cells.
Hold down Ctrl+Shift+. This picks all immediate and indirect
previous cells on the current sheet.
Formula Auditing > Trace Precedents > Choose Formulas Excel
will generate arrows to show the predecessors of the cell. To view
further tiers of precedents, click this icon many times.
To conceal the arrows, choose Formulas > Formula Auditing >
Remove Arrows.
 

Identifying dependents

There are many approaches to discovering formula cells that employ a
certain cell:



Select Home > Editing > Find & Select from the drop-down menu.
To open the Go to Special dialog box, choose Go to Special. Select
Dependents, then Direct Only (for direct dependents only) or All
Levels (for all dependents) (for direct and indirect dependents).
Click the OK button. The cells that are dependent on the active cell
are selected by Excel. This method can only be used to identify cells
on the active sheet.
Hold down the [Ctrl+] key. On the active sheet, this picks all direct
dependent cells.
Hold down Ctrl+Shift+. This picks all direct and indirect dependent
cells on the active sheet.
Formula Auditing > Trace Dependents > Choose Formulas To
identify the cell's dependencies, Excel will create arrows. To show
more layers of dependents, click this icon many times. To conceal
the arrows, go to Formulas Formula Auditing Remove Arrows.

Tracing error values

If a calculation returns an erroneous value, Excel can assist you in
determining which cell is producing the issue. A mistake in one cell is often
the consequence of a mistake in a preceding cell. Select Formulas >
Formula Auditing > Erroneous Checking > Trace Error after activating
a cell that has an error value. The mistake cause is shown by arrows in
Excel.

Fixing circular reference errors

If you generate a circular reference formula by mistake, Excel shows a
warning message—Circular Reference—in the status bar, along with the
cell address. It also creates arrows on the spreadsheet to aid in the
identification of the issue. Choose Formulas > Formula Auditing > Error
Checking > Circular References if you can't figure out where the issue is
coming from. This command generates a list of all the cells implicated in
the circular references. Begin by picking the top cell on the list and working
your way down until you find the issue.

Using the background error-checking feature



Making use of Excel's automated error-checking tool may be beneficial to
certain individuals. The Activate Background Error Checking check box
on the Formulas tab of the Excel Options dialog box can be used to enable
or disable this capability. You can also select which sorts of problems to
check using the checkboxes in the Error Checking Rules section.

When error checking is enabled, Excel examines the formulae in your
worksheet regularly. If a possible mistake is found, Excel displays a tiny
triangle in the cell's upper-left corner. A drop-down control displays when
the cell is triggered. This drop-down control gives you alternatives when
you click it. Depending on the kind of problem, several choices are
available.

In most circumstances, choosing the Disregard Error option will allow
you to ignore an error. When you choose this option, the cell is no longer
checked for errors. All previously ignored errors, on the other hand, maybe
reset such that they surface again. (On the Formulas tab of the Excel
Options dialog box, click the Reset Ignored Errors option.)

You can use Formulas > Formula Auditing > Error Checking to bring up
a dialog box that lists each possible error cell in order, similar to how a
spell-checking function works.

The error-checking function isn't flawless. It isn't even close to being ideal.
In other words, just because Excel doesn't detect possible mistakes doesn't
mean your spreadsheet is error-free! Also, keep in mind that this error-
checking tool will not capture a typical mistake, such as overwriting a
formula cell with a value.



Using Formula Evaluator

The Formula Evaluator displays the different elements of a nested formula
in the sequence in which they are computed. To utilize Formula Evaluator,
pick the formula cell and then choose Formulas > Formula Auditing >
Evaluate Formula from the Formulas Auditing Evaluate Formula
dialog box.

To see the outcome of computing the expressions inside the formula, click
the Evaluate button. Each button press initiates a new computation. This
feature may seem confusing at first, but after spending some time with it,
you'll realize how it works and how valuable it is.

Another technique to assess a component of a calculation in
Excel is to:

1. Find the cell with the formula in it.
2. To enter Cell Edit mode, press F2.
3. Highlight the piece of the formula you wish to examine using your

mouse, or press Shift and utilize the navigation keys.
4. Press the F9 key.

The computed result is shown in the highlighted area of the formula. You
can assess additional portions of the formula or cancel it and restore it to its
former state by pressing Esc.

When you use this approach, be aware that if you hit Enter instead of Esc,
the formula will be changed to utilize the computed numbers.

Searching and Replacement

Excel's search and replace feature makes it simple to look for data within a
worksheet or across several worksheets in a file. Text can also be searched
for and substituted with anything else.

In the Find and Replace dialog box, start by selecting the range you want to
search for. If you choose a single cell, Excel does a sheet-wide search. The
Home > Editing menu's Find & Select Find option can also be chosen by
pressing Ctrl+F.



Select the Find tab if you're only searching for anything in the worksheet.
The Replace tab may be used to replace current text with fresh content.
Also, the Choices button may be used to show (or conceal) additional
options.

Searching for information

In the Find What text box, type the information you want to look for, and
then choose one of the following options:

Within the drop-down menu Indicate the location of the search 
A drop-down menu for searching Indicates the direction.
Look in the drop-down menu Choose which cell components to look
for.
Tick the "Match Case" box If you want the search to be case
sensitive, check this box.
Tick the box that says "Match Entire Cell Contents" Specify
whether or not the complete contents of the cell must be matched.
The option to format Click to find cells that have certain formatting.

Find Next to find the corresponding cells one by one, or Find All to find all
matches at once. The Find and Replace dialog box expands when you click
the Find All button, displaying the addresses of all matching cells in a list.
When you choose an item from this list, Excel scrolls the worksheet to
show you how it fits into the larger picture.

After you've used Find All, hit Ctrl+A to select all of the worksheet's
discovered cells.

You can access the worksheet and make adjustments without having to
dismiss the Find and Replace dialog box since it is modeless.

Information replacement

In the Find and Replace dialog box, select the Replace tab to replace text
with different text. Enter the text to be changed in the Find What box, and
then enter the new text in the Replace With field. As noted in the section
before, more choices may be made.



The first item that matches is found by clicking Find Next, and then it is
replaced by clicking Replace. Excel searches for the following item that
meets your criteria when you click the Replace button. To override the
substitution, click Find Next. Click Change All to make all changes without
checking them beforehand. Use Ctrl+Z or the Undo button on the Quick
Access toolbar if the replacement didn't turn out as planned.

Fill in the Find What box with the text you want to erase, but keep the
Replace With area blank.

Searching for formatting

You can also use the Find and Replace dialog box to find cells that have a
certain style of formatting. You have the option of replacing that formatting
with a different kind of formatting. Consider the following scenario: you
want to find all cells that are formatted as bold and then alter the formatting
to bold and italic.

Take the following steps:

1. Press Ctrl+H or go to Home > Editing > Find & Select Replace.
2. Check that the Replace tab is visible. To enlarge the dialog box,

click the Options button if required.
3. Delete the contents of the Find What and Replace With fields if

they are not empty.
4. Select Format from the drop-down menu at the top of the page. The

dialog window for finding a format appears. This dialog box looks
similar to the Format Cells dialog box.

5. Go to the Font tab.
6. Click OK after selecting Bold from the Font Style option.
7. Select the Format option at the bottom of the page. A dialog

window called Replace Format opens.
8. Go to the Font tab.
9. Click OK after selecting Bold Italic from the Font Style option.

10.                    Click Replace All in the Find and Replace dialog box. Excel
searches for all cells with bold formatting and converts them to bold
italic.



You may also search for formatting based on a certain cell. Pick the Choose
Format from Cell button in the Find Format dialog box, then click the
cell that has the formatting you're searching for.

Note: The Find and Replace dialog box is unable to locate background
color formatting in tables that have been applied using table styles or
conditional formatting.

Spell-checking your worksheets

If you use a word processor, you almost certainly use the spell-checking
option. When spelling errors arise in a spreadsheet, they may be just as
humiliating. Fortunately, Excel comes with a spell-checker from Microsoft.

Choose Review > Proofing > Spelling or press F7 to go to the spell-
checker. Before you launch the spell-checker, pick the range you want to
verify the spelling in.

Cell contents, text in graphical objects and charts, and page headers and
footers are all checked by the spell-checker. The content of concealed rows
and columns is also examined.

The Spelling dialog box functions in a similar way to other spell-checkers
you may be acquainted with. Excel provides a list of recommendations if it
comes across a term that isn't in the current dictionary or is misspelled.

Click one of the following buttons to respond:



Ignore Once: The term and go on with the spell-check.
Ignore everything: Ignore the term and any further instances of it.
Dictionary entry: Make a note of the term in the dictionary.
Change: Change the term in the Suggestions list to the one you
want.
Replace everything: Change the word to the Suggestions list's
chosen term, and all future instances of it will be changed without
prompting.
AutoCorrect: Add the misspelled word to the AutoCorrect list,
along with its proper spelling (which you may choose from a list).

Using AutoCorrect

AutoCorrect is a useful function that corrects frequent typing errors
automatically. You may also add words to the list of terms that Excel will
automatically fix. Choose File > Options to get to this functionality. Select
the Proofing tab in the Excel Options dialog box, then click the
AutoCorrect Options button.



There are various possibilities in this dialog box:

TWO INitial CApitals must be correct: Words with two initial
capital letters are automatically corrected. Budget, for example, is
transformed from Budget. This is a frequent blunder made by quick
typists. You can define a list of exceptions to this rule by clicking the
Exceptions button.
The first letter of each sentence should be capitalized: The initial
letter of a sentence is capitalized. The rest of the letters remain the
same.
Capitalize Days' Names: The days of the week are capitalized.
When you type Monday, Excel automatically converts it to Monday.
Correcting the use of the CAPS LOCK key by accident: Errors
caused by mistakenly pressing the CapsLock key while typing are
corrected.



As You Type, Replace Text: As you write, AutoCorrect
automatically corrects your mistakes.

For often misspelled terms, Excel has a lengthy list of AutoCorrect entries.
It also includes AutoCorrect entries for several symbols. (c) is replaced with
®, and (r) is replaced with ®, for example. Additionally, create your
AutoCorrect items. If you routinely misspell the word January as January,
for example, you may create an AutoCorrect entry to have it corrected
automatically. Enter the misspelled word in the Replace box and the
properly spelled term in the With field to make a new AutoCorrect entry.
You may also get rid of entries that you don't require.

Create shortcuts for frequently used words or phrases using the
AutoCorrect tool. If you work at Consolidated Data Processing
Corporation, for example, you may create an AutoCorrect entry for an
abbreviation like cdp. Excel will then transform cdp to Consolidated Data
Processing Corporation anytime you input it. Just make sure you don't
employ a character combination that would ordinarily occur in your text but
would be changed incorrectly.

Note: You may wish to override the AutoCorrect function in certain
instances. For example, instead of a copyright sign, you may need to write
(c). Simply hit Ctrl+Z or click the Undo button on the Quick Access
toolbar.

Also, you can alter a few more automatic settings in Excel by using the
AutoFormat as You Type tab of the AutoCorrect dialog box.

For specific sorts of data in your workbooks, the Actions tab allows what
were formerly known as Smart Tags. Excel detects several sorts of activities
based on the software you have installed on your computer. If you activate
the Financial Symbol action, for example, you can right-click a cell
containing a financial symbol (such as MSFT for Microsoft) and choose
Additional Cell Actions to get a list of possibilities. You may, for example,
include a stock price that is updated regularly in your spreadsheet.

Conclusion



Every Excel formula and function has a specific use in the workplace. You
must be vigilant and careful while entering formulas and functions in Excel
(as described in this guide) to avoid confusing one for another.

Users will learn about manually inputting formulae, entering formulas into
worksheets, altering reference types, utilizing formulas in tables, formulas
that return errors, making formulas error-free, comprehending the
dimensions of an array, generating an array constant, and much more in this
guide.

The ideal manual for anyone wishing to enter various formulas and
functions into their spreadsheets and workbooks without running into any
issues is Microsoft 2023 Formulas and Functions.
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replacement, 102, 272
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standard, 12, 74, 80, 98, 105, 134, 222, 232
statement, 155, 156, 157, 158, 159
statistic, 45, 165
statistics, 167, 188, 190, 195
status bar, 13, 30, 264, 268
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